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LUNA Application
The First Recording Platform with Deep Apollo
Integration
LUNA gives Apollo owners the fastest recording environment for music production, editing, and mixing. In addition to
its seamless hardware-software integration with Thunderbolt-equipped Apollo and Arrow interfaces, LUNA Recording
System allows capturing audio through DSP-powered UAD plug-ins with no discernible latency, as well as offering new
Accelerated Realtime Monitoring™ — which provides analog-style tracking and overdubbing workflows using Apollo’s
onboard DSP acceleration.

LUNA Technology — Work the Way you Want
Using an all-new audio architecture built from the ground up over four years, LUNA brings audio recording into a new
era. Intelligent workflow and compatibility features let you capture inspiration the moment it strikes.

Accelerated Realtime Monitoring™
No more toggling between Apollo's Console app and your DAW, or messing with buffer settings. Accelerated Realtime
Monitoring uses Apollo’s onboard DSP to give you deterministic, sub-2ms recording latency — from input to output —
for fast analog-style tracking and overdubbing workflows with UAD plug-ins and LUNA Instruments.

Realtime UAD Processing
Track, overdub, and mix with UAD plug-ins in real time, including Unison mic preamp plug-ins from Neve, Manley, API,
Avalon, and more, while enjoying seamless transitions between tracking, overdubbing, and playback.

Much, much more
• Unlimited Track Count – Record and playback as many tracks as your Thunderbolt-equipped Mac can handle.
• Contextual Editing & Browsing – LUNA intelligently switches tools and viewing modes for less menu diving
during the creative process.
• Run Audio Units Plug-Ins and VIs – Easily use your favorite AU plug-ins and AU virtual instruments inside LUNA.
• Session Autosave – LUNA is constantly saving, so you'll never lose your work again, no matter what happens.
• AAF Imports – Seamlessly integrate with other DAWs and easily import sessions using the industry-standard
Advanced Authoring Format (AAF).
• Persistent Undo – Harness undo/redo even after closing and re-opening sessions.
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LUNA Concepts
LUNA Recording System is the new music production system from Universal Audio. LUNA transforms Apollo interfaces
into the most inspiring and fully‑integrated Mac‑based recording systems on the planet. LUNA integrates with your
Thunderbolt-equipped UA Audio Interface on macOS and provides a complete environment for recording, MIDI
creation, editing, arranging, and mixing – all with an intuitive and contextual user interface.

A Natural Analog Workflow
LUNA is based on a powerful hardware-software integration, giving Apollo interface owners the fastest, most natural
recording system for music creation, editing, and mixing on your Mac. No more toggling between Apollo's Console app
and your DAW to track through UAD plug-ins in real time, or messing with buffer settings.
Instead, LUNA's Accelerated Realtime Monitoring™ lets you record through UAD plug-ins with no discernible latency,
and eliminates hassles in creating monitor mixes, cue mixes, setting up Unison plug-ins, and so much more.

Apollo Integration
LUNA is integrated directly with Universal Audio interface hardware. You must have a Thunderbolt-equipped Apollo
connected and powered on to start LUNA. Tight integration with UA hardware means that much of the complexity of
audio interface configuration is removed with LUNA. All of your available hardware inputs and outputs are
automatically configured and available in LUNA. In addition, all preamp channel features and Unison inserts are
automatically available in LUNA, and most routing features of the hardware, including Cues and routing matrix features,
are available.

Accelerated Realtime Monitoring
Accelerated Realtime Monitoring™ (ARM) is a deep hardware, DSP, and software integration feature inside LUNA that
allows you to achieve the lowest possible latency while recording with UAD plug-ins in real time.
For those familiar with UA’s Console software, ARM eliminates the need to use the Apollo Console app altogether, while
providing all of the same features and benefits (low latency plug-ins, input routing, cue mixing, and others). Unlike
Console, LUNA and ARM automatically take care of the muting and unmuting of input channels, based on the transport
state of the software: Apollo channels that are record-enabled or input-enabled are unmuted, and all other Apollo
channels are muted.
For a detailed description of Accelerated Realtime Monitoring, see “Accelerated Realtime Monitoring.”
Accelerated Realtime Monitoring™ (ARM) eliminates the need to use the Apollo Console app to track and input monitor
through UAD plug-ins at the lowest possible latency. Accelerated Realtime Monitoring offers you the ability to
effortlessly achieve the lowest possible latency while recording with Apollo. Accelerated Realtime Monitoring
seamlessly handles channel input states, allowing for the use of UAD plug-ins on channel inserts for Realtime UAD
Processing, without having to leave the LUNA workspace. ARM offers UAD plug-in processing at undetectable latencies
while monitoring and/or recording multiple inputs and tracks.
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LUNA takes care of the muting of input channels, based on what is in use in the session. Apollo channels that are recordenabled have their inputs unmuted, and all other channels have their inputs muted. Apollo integration automatically
controls the muting of inputs and recorded material on disk according to the record enable or input enable and
transport state.
Note: Tracks are not “muted” in LUNA. However, Apollo inputs are automatically muted and unmuted as required to
record, monitor, and play back tracks.
You can turn Accelerated Realtime Monitoring on or off globally. Use this setting to achieve the lowest possible input
monitoring latency when monitoring input signals through monitor, headphone, and cue outputs.

Recording Features
LUNA’s recording engine is fast and highly capable. LUNA records 24-bit audio at the current hardware sample rate, on
as many tracks as your computer can support. With LUNA, you can switch the transport in and out of Record while
playing audio. You can also enable and disable recording on tracks while the transport is running, so you can punch in
manually on one or more tracks while playing back a session. All audio and MIDI tracks, buses, the main output, and
hardware outputs are delay-compensated on playback, so everything stays tightly synced.

Plug-In Processing
Previously, with the Console App, you had to choose whether or not to record insert effects on input channels. In LUNA,
as with the Console App, Unison insert processing is always recorded to disk. However, unlike the Console App, each
input channel has four available Record FX slots in addition to eight standard inserts (used for any combination of Audio
Unit or UAD plug-ins). These inserts allow you to record through up to four UAD plug-ins on any available input channel
(depending on available UAD DSP resources). In addition, UAD and non-UAD plug-ins can be assigned to standard
Inserts (not recorded to disk) for monitoring while you record, without being recorded to disk.
Notes on LUNA plug-in processing:
• Only UAD plug-ins can be monitored on a record-enabled track when Accelerated Realtime Monitoring is
enabled. When you enable ARM, any Audio Unit plug-ins on a record or input-enabled track are disabled.
• When you add an Audio Unit plug-in to a record or input-enabled track when ARM is enabled, the plug-in is
added in an inactive state, and LUNA displays a notification that the plug-in is disabled.

• When a track is record or input-enabled in ARM mode, the last four standard inserts are disabled.

LUNA and Console
You never need to use Apollo’s Console app when you are using LUNA. LUNA replaces almost all functions for which you
previously used Console. LUNA also includes a number of features that Console does not.
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For example, a LUNA session includes persistent Inputs. When you configure a LUNA track with an input, all settings,
including Unison plug-ins, Record FX plug-ins, and Insert effect plug-ins, are retained on that track. You can reuse the
same input on your Apollo on multiple tracks, and each track in the session will continue to retain the settings that were
last used for it, even after you close and reopen the session. This differs from Console, where the last-used set of Unison
and Record FX plug-ins persist on an Apollo channel, but those plug-ins and settings do not automatically change when
you use that channel on a different track in another DAW.
If you use Console, the settings and plug-ins you configure for an Apollo input channel in Console are retained until you
reconfigure that input in LUNA. Your Console channel settings are restored when you close the LUNA session.
Note: The Isolate and Flex Routing features are configured in Console.

Console Isolate feature
Isolate retains current channel settings when different Console and LUNA sessions are loaded. Isolated channels are
also not controlled by LUNA. Isolate allows you to seamlessly monitor live hardware inputs with Realtime UAD
Processing, even when changing Console and LUNA sessions. You can use this to prevent a Console channel’s state from
changing across LUNA sessions. When a channel or channel pair is Isolated the plug-ins on that channel cannot be
changed in LUNA, and the channel input pair is not automatically muted and unmuted by the LUNA mixer—the channel
or channel pair is always live.
The only exception to this is that an Isolated input or input pair is muted when a track that uses that input is Recordenabled and LUNA is playing back audio from that track.

Console Tracking Mode
Console Tracking mode allows you to use Console for live channel inputs, and prevents LUNA from automatically
muting and unmuting Console channels when recording. Essentially, all inputs remain live, and Console works as it
previously did, while LUNA is running.
In Console Tracking Mode, UAD plug‑ins do not persist in LUNA inputs as they normally do. Instead, when you recordenable a track in Console Tracking mode, the plug-ins assigned to the track in Console are loaded into the LUNA
channel. However, unlike with Isolated Console channels, in Console Tracking Mode, you can change the plug-ins
assigned to the track in LUNA, and those changes will carry over to Console. Console channels then return to their
previous states after you quit LUNA.
For more information about Console Tracking Mode, see “Using Console Tracking Mode.”

LUNA Extensions
LUNA Extensions are UA add-ons that run exclusively inside LUNA. LUNA includes the free Oxide Tape LUNA Extension.
The optional Studer A800 and Neve Summing LUNA Extensions are available for purchase from within LUNA. The
included free ARP LUNA Extension provides arpeggiation effects on Instrument tracks.
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Integrated Multitrack Tape
LUNA's Multitrack Tape sounds, courtesy of the included Oxide LUNA Extension and optional Studer A800 Extension,
give you the rich warmth, punch, and texture of magnetic tape on any audio or instrument track. Simply adjust the pertrack Saturation control to dial up the desired amount of harmonics and tape character on your sources.
You can even mix-and-match up to four tape machines total, harnessing different tape formulas, tape speeds, and pertrack controls for Bias, Repro, and Tone. It's a tape-head's delight — perfect for gluing together your mixes.

Built-In Neve® Summing
A major ingredient behind thousands of influential, chart-topping records, Neve 80 series consoles are without equal.
These classic analog desks from the '60s and early '70s — made famous in the Sound City documentary — deliver threedimensional nonlinearities and analog heft that infuses your mixes with vibrancy and color.
Developed in partnership with AMS Neve exclusively for LUNA Recording System, the Neve Summing Extension
emulates the entire summing circuit of an iconic Neve 80 series console — including its coveted 1272 bus amplifiers —
giving your LUNA mixes all the color of Neve's most cherished analog desk.
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About LUNA Extensions Documentation
• Learn how to use the LUNA Tape Extension at “Using Tape.”
• Learn how to use Neve Summing Extension at “Using Neve Summing.”
• Learn how to operate individual LUNA Extension controls in the separate “LUNA Extensions” section.

LUNA Instruments
LUNA Instruments bring Universal Audio's expertise in electrical and acoustic modeling, sampling, synthesis, and signal
processing to instruments for the first time ever.
LUNA Recording System comes with a curated bundle of inspiring sounds, delivering a new level of realism for softwarebased instruments.
LUNA Instruments are exclusive to LUNA Recording System.

Moog® Minimoog
Developed in partnership with Moog Music, the Minimoog LUNA Instrument is an incredibly accurate and inspiring
emulation of Bob Moog's pioneering synthesizer.
By perfectly capturing every nuance of the classic Moog oscillators and ladder filters and harnessing discrete transistor
VCA modeling, the Minimoog LUNA Instrument faithfully captures every detail of this classic instrument used by
everyone from Parliament-Funkadelic, to Kraftwerk, Dr. Dre, and more.
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Ravel™ Grand Piano
UA's first acoustic instrument model, Ravel is a breathtaking emulation of a Steinway Model B* grand piano based on
UA's exclusive sampling, physical modeling, and new Ultra‑Resonance™ technology, giving you all the sonic nuance of
this studio classic.
Captured at Ocean Way Studios, Ravel gives you an immaculately recorded studio piano that’s album-ready, with
easy‑to‑use Tone, Dynamics, and Microphone controls, as well as an innovative Reverse feature for startlingly creative
sounds and textures.
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Shape
A comprehensive creative toolkit included free with LUNA, Shape is a painstakingly curated LUNA Instrument featuring
a collection of the best vintage keys, drums/percussion, guitar/bass, orchestral content, and real time synthesis courtesy of Universal Audio, Spitfire Audio, Orange Tree Samples, Loops de la Creme, and more. You can expand Shape
with more content and sample packs.
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About LUNA Instruments Documentation
• Learn how to insert, play, and record LUNA Instruments in “Playing a Virtual Instrument and Recording MIDI.”
• Learn how to operate individual LUNA Instrument controls in the separate “LUNA Instruments” section.

Non-Destructive Audio
When you record audio in LUNA, that audio is stored in the session file. You can edit the audio by copying, cutting,
trimming, and deleting, while not actually changing the underlying audio file. Similarly, when you record multiple audio
“takes” while loop recording (recording with a loop selected and Loop Playback/Record enabled), or you record audio
over an existing audio file or file section, the previous audio files are retained. You can access all of the whole audio files
recorded with loop recording using the Track Versions feature.

How do I Save?
With LUNA, all changes are saved automatically. LUNA writes changes to a database file that is embedded within the
LUNA session file. This database is updated with every change and keeps a constant record of your LUNA session. There
is no traditional Save function in LUNA, as all edits and modifications are automatically saved, and all audio is
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embedded in the LUNA session file. You can undo and redo changes (except when recording) even after closing and
reopening a session. You can also save a copy of a session.
LUNA automatically autosaves versions to which you can revert, based on the Autosave Interval in LUNA settings.

Undo and Redo
You can undo and redo changes in an open session at any time, except during recording. You can even undo and redo
changes after a session has been closed and reopened.

Supported Plug-In Formats
LUNA supports UAD Powered Plug-Ins, LUNA Extensions, LUNA Instruments, and Audio Units (AU) plug-ins. LUNA
Extensions include Tape Machines and Neve Summing. Extensions are incorporated into the LUNA workflow.
Instruments appear in a separate plug-ins list from insert effect plug-ins.

Track Follows Modes: Time and Tempo
Audio tracks can be in one of two Track Follows Modes: Time or Tempo.
• A track in Track Follows Time mode maintains its original playback time, regardless of changes in the tempo of
the session. All audio clips on the track, and elements associated with those clips, maintain their original time
duration, including start and end points, edits, fades, and automation.
• A track in Track Follows Tempo mode adjusts to the tempo of the session and any session tempo changes. An
audio clip that is configured in Track Follows Tempo mode will automatically become shorter or longer if the
session tempo is adjusted. All audio clips on the track, and elements associated with those clips, scale to the
new tempo. Clip start and end points, duration, edits, fades, and automation all scale to the new tempo.

Sample Rates, Imported Audio, and Imported Sessions
LUNA sessions are not locked to a specific sample rate. You can change the sample rate of a LUNA session after you
create or import it, without changing the sound or playback speed of the session.
LUNA always records audio as 24-bit files at the current hardware sample rate. All internal files, exports, and mix
operations employ a 32-bit floating point architecture. You can import audio of any sample rate, or play back an audio
session at any supported hardware sample rate, and LUNA intelligently renders and manages the audio to play it back
correctly. Audio that you import into LUNA is saved in the session file with the same bit depth and sample rate at which
it was imported.

Focus Browsers Overview
In LUNA, many operations open a Focus Browser at the left of the screen. For example, when you click the Preset button
on a plug-in, a list of available presets appears at the left side of the screen. This methodology is much more conducive
to fast workflows instead of burying functions within menus and submenus.
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With a Focus Browser, you typically make a choice. For example, you choose an input to use for a track, or a preset to
use with a plug-in.

Track Focus Browser
Expanding and collapsing folders in the Focus Browser
To expand or collapse a folder in a Focus Browser, click the folder name. For example, click the Universal Audio folder in
the Inserts Focus Browser to open or close the list of Universal Audio plug-ins. To expand or collapse all folders in a
Focus Browser, Option+Click on any folder name.
Note: The Expand and Collapse settings for a Focus Browser are saved globally across all sessions in LUNA.
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Workflows
Workflows provide common editing, arranging, and navigation commands on a toolbar that you can open under the
main LUNA control bar.

For more information about workflows, see “Using Workflows.”

Keyboard Shortcuts and Menu Reference
LUNA includes many convenient keyboard shortcuts for menu items and workflows so you can operate the system
quickly. A complete list of all Keyboard Shortcuts and a full Menu Reference are available.

LUNA Key Commands mapped to macOS Shortcuts
Some key commands are mapped to shortcuts in macOS by default. These key commands must be disabled or
remapped in order to use the LUNA key commands. These key commands and remapping instructions are listed here.
• Command+Spacebar (Toggle Record): By default, this key command is mapped to the macOS Spotlight search
feature. You must disable or remap this feature to use this key command. To disable or remap this command, in
System Preferences > Spotlight > Keyboard Shortcuts uncheck the key commands, or map them to different key
commands. Refer to your macOS documentation for more information.
• Control+↑ (Increase selected track heights): By default, this key command is mapped to the macOS command
for Mission Control. You must disable or remap this feature to use this key command. To disable or remap this
command, in System Preferences > Keyboard, click Shortcuts and disable this key command, or map it to a
different key command. Refer to your macOS documentation for more information.
• Control+↓ (Decrease selected track heights): By default, this key command is mapped to the macOS command
for Application Windows. You must disable or remap this feature to use this key command. To disable or remap
this command, in System Preferences > Keyboard, click Shortcuts and disable this key command, or map it to a
different key command. Refer to your macOS documentation for more information.
• MIDI Keyboard Mode: MIDI keyboard Mode overrides some keys that are used as shortcuts.
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Getting Started with LUNA
Installing and Authorizing LUNA
To install and authorize LUNA, you’ll need to follow the six main steps below. Detailed instructions are provided later in
this section.
1. Download and unzip LUNA, and open the LUNA .dmg.
2. Drag LUNA to the Applications folder.

3.
4.
5.
6.

Start LUNA from the Applications folder or Launchpad.
Log in with your Universal Audio account.
Either create and link an iLok account automatically, or link to an existing iLok account.
Complete the install.

After the install completes, LUNA starts and the Shape LUNA Instrument downloads and installs automatically.

About uaudio.com and iLok accounts
LUNA uses two different accounts.
• Your uaudio.com account connects LUNA with the Universal Audio cloud, so you can purchase, download, and
manage updates to LUNA, LUNA Instruments, and LUNA Extensions. You can also buy UAD plug-ins and access
LUNA educational and informational resources with your uaudio.com account.
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• Your iLok account (iLok USB hardware and/or iLok Cloud) authorizes the LUNA app, LUNA Instruments, and
LUNA Extensions. You can either use an existing iLok.com account, or create one automatically and link it to
LUNA during the installation process.

Using an iLok hardware key or iLok Cloud
LUNA includes two authorizations for the LUNA app, and two licenses for each authorized Extension and Instrument.
You can move iLok authorizations to physical iLok USB hardware keys to use your authorizations with multiple macOS
systems, or you can use one iLok Cloud session.
iLok Cloud allows you to authorize LUNA, LUNA Extensions, and LUNA Instruments on a macOS system that is
connected to the internet. iLok Cloud requires a constant connection to the internet, as the licenses are checked
periodically. With iLok Cloud, you can authorize one LUNA instance at a time. If you start a second iLok Cloud session,
the existing iLok Cloud session is logged out. If you need to log in to a second machine while an iLok Cloud session is
running, you’ll need to use a physical iLok key with a license installed.
If your system is not continuously connected to the internet, or is only connected periodically, use a physical iLok key
with a license installed. You can install a LUNA license on your physical iLok hardware key by manually dragging and
dropping the LUNA license into the key from within the iLok License Manager application.
Note: iLok License Manager is automatically installed the first time you start LUNA.

Installing LUNA and creating an iLok account
Note: Use this workflow when you do not have an existing iLok account and you want to automatically create an iLok
account and link it to your uaudio.com account to authorize your software.
1. Download the LUNA zip file from the Universal Audio downloads page and unzip the LUNA.dmg file.
2. Open the LUNA .dmg file.
3. When prompted, drag the LUNA app to the Applications folder.
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4. Open LUNA from Applications.
5. When prompted “LUNA is trying to install a new helper tool,” provide your macOS account password, and click
Install Helper. This allows LUNA to install iLok License Manager.

6. The login screen appears. Type your Universal Audio (uaudio.com) account and password and click Log In.
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7. The Link iLok Account screen opens. Click Create to create a new iLok account.

Getting Started with LUNA – 36

LUNA User Documentation v200731

8. Click Create again to confirm that you want to create a new iLok account. To read the terms of the iLok License
agreement, click View Terms.

9. The iLok account is created and linked, and licenses are deposited, then LUNA checks for the license. This might
take some time.
10. When you are prompted to allow access to the Microphone, click OK.
Note: You must allow LUNA to access the Microphone in order to record audio.
11. When you are prompted to allow LUNA to access files in your Documents folder, click OK. LUNA stores sessions
and other data in this area.
LUNA now starts, and shows the Create Session screen. Note that the first time you run LUNA, LUNA downloads the
LUNA Instrument “Shape” in the background.

Installing LUNA and linking an existing iLok account
Note: Use this workflow when you have an existing iLok account, and you want to link it to your uaudio.com account to
authorize your software.
1. Download the LUNA zip file from the Universal Audio downloads page and unzip the LUNA.dmg file.
2. Open the LUNA .dmg file.
3. When prompted, drag the drag the LUNA app to the Applications folder.
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4. Open LUNA from Applications.
5. When prompted “LUNA is trying to install a new helper tool,” provide your macOS account password, and click
Install Helper. This allows LUNA to install iLok License Manager.

6. The login screen appears. Type your Universal Audio (uaudio.com) account and password and click Log In.
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7. The Link iLok Account screen opens. Click Link Existing to link to an existing iLok account.
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8. Type your iLok password, and click Authorize. The licenses are create and deposited, and LUNA checks for your
license. This might take some time.
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9. When you are prompted to allow access to the Microphone, click OK.
Note: You must allow LUNA to access the Microphone in order to record audio.
10. When you are prompted to allow LUNA to access files in your Documents folder, click OK. LUNA stores sessions
and other data in this area.
LUNA now starts, and shows the Create Session screen. Note that the first time you run LUNA, LUNA downloads the
LUNA Instrument “Shape” in the background.
Login tips
• If you forget your password, click Log In, and the Forgot Password link appears. Click Forgot Password to receive
password reset instructions.
• To stay logged in, click Remember Me.
• You can skip the login screen by clicking Skip. If you skip the login, you can use LUNA and licensed Extensions
and Instruments with the licenses on your iLok hardware key or licenses from the iLok Cloud. However, you
cannot update software, make purchases, or download from the Manage screen until you log in.

Starting LUNA
1. From Launchpad or the macOS Dock, start LUNA.
2. Log in with your Universal Audio account information. LUNA opens, and shows the Create Session page.
When you are logged in, lists of your installed products and other account details appear in LUNA’s Manage panel.

Managing LUNA Instruments and Extensions
You can manage LUNA Instruments and Extensions with the LUNA Sidebar.
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To download and install LUNA Instruments and Extensions:
1. Open the LUNA Sidebar by clicking the UA diamond logo on the left of the screen, and click Manage, or choose
LUNA > Preferences from the app menu, and choose Manage.
2. If updates are available, a red dot appears to the right of the Manage button in the LUNA Sidebar. Click the
Manage button to see the updates.
3. Click the Download button to download any available downloads.
4. Click the Update button to update any Instruments or Extensions that have more recent versions than what is
installed.
LUNA installs and updates the Instruments and Extensions. You will see a notification as each Instrument or Extension is
installed or updated.
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Extension and Instrument options
Click the ••• options menu to the right of an Extension or Instrument to see the available options for that Extension or
Instrument.
• More Info - opens LUNA’s Discover panel with more information about the Instrument or Extension.
• Move - Lets you choose a drive to which you can move Instrument content. Note that this drive must be an SSD,
formatted with APFS. Sample content is moved to the additional drive, however the Instrument itself is stored
on a local volume.
• Delete - Deletes the Instrument or Extension. Items can be downloaded again whenever you have an internet
connection.
• Download Settings - Specifies the Volume on which local Extensions and Instruments are installed.

Tape licenses
LUNA includes a free license for Oxide LUNA Extension.
If you own the UAD Studer A800 plug-in, you will get a free license deposited for the Studer A800 Extension.
If you do not own the UAD Studer A800 plug-in, you can activate a demo or purchase the LUNA Extension. When you
purchase the Studer A800 Extension, the UAD Studer A800 plug-in is included. Go to the Manage page to activate a
demo or purchase the Studer A800 LUNA Extension.
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Neve Summing licensing
LUNA Neve Summing is optional. You can activate a demo or purchase the Neve Summing Extension from within LUNA.
Go to the Manage page to activate a demo or purchase Neve Summing.

LUNA Instrument licensing
LUNA includes the Shape LUNA Instrument, which is authorized with your LUNA application authorization. All other
LUNA instruments are optional. You can activate a demo or purchase LUNA Instruments from within LUNA. Go to the
Manage page to activate a demo or purchase a LUNA Instrument.

Creating a LUNA Session
When you start LUNA, you see the Session panel.

To create a new empty session:
1. In the New Session area, type a name for the session.
2. Specify a tempo and time signature for the session, or accept the defaults. Note that you can change the tempo
and time signature after you create the session.
3. To find the approximate tempo, you can tap the Tap button in time four or more times.
4. Click the Location bar to open a dialog where you can select the location for the session, or accept the default
location. By default, sessions are saved in ~/Music/LUNA Sessions.
5. When you have configured the new session settings, click Create.
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To create a new session from the main LUNA window, choose File > New, or use the Command+N shortcut.

To create a session from an AAF (Advanced Authoring Format) file:
1.
2.
3.
4.
5.
6.

On the Create Session panel, type a name for the session.
Click the Start From AAF button.
From the dialog that opens, choose the AAF session to import.
Type a name for the session.
Specify a tempo for the session, or click the MIDI button, and choose a MIDI file to import.
Click the Location bar to open a dialog where you can select the location for the session, or accept the default
location. By default, sessions are saved in ~/Music/LUNA Sessions.
7. When you have configured the new session settings, click Create.
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Opening a Session
When you start LUNA, the Session panel appears. Choose a file from the Recent list and click Open to open a recent
existing session. To choose a session from the disk, click From Disk... and navigate to a session to open.
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Undo and Redo
You can undo and redo changes in an open session at any time, except during recording. You can even undo and redo
changes after a session has been closed and reopened. LUNA supports up to 64 Undo or Redo actions within each
Autosave interval period. To configure the Autosave interval, see Configuring the Session Autosave interval.
• To undo a change, use the menu item Edit > Undo, or press Command+Z.
• To redo a change, use the menu item Edit > Redo, or press Shift+Command+Z.

Working with Tracks
A LUNA session consists of tracks. A track contains audio or MIDI information, and audio and MIDI control automation
information. LUNA has four track types:
• On Audio tracks you can record audio, and arrange audio files that you import or drag to the timeline.
• On Instrument tracks, you can record MIDI from external controllers or LUNA’s internal keyboard, and arrange
MIDI files that you import or drag to the timeline. Instrument tracks can play sound from a LUNA Instrument or
an Audio Unit (AU) instrument plug-in.
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• On Bus tracks, you can sum (mix) audio sources in the session, route audio for Aux-style plug-in processing, and
use Neve Summing LUNA Extensions to add punch and warmth to audio sources in your session.
• On the Main track, you can mix all the audio, Instrument, and bus tracks together to create a stereo mix. The
Main track is the only default track in a LUNA session.
When you create tracks, you can choose the track type, stereo or mono format, the number of tracks to add, track
names, a LUNA Instrument or other instrument plug-in (on an Instrument track), and optional Neve Summing (on a bus
track).
When you create a new track, a channel strip is also created. The new track appears in the Tracks Browser, the Timeline,
and the Mixer.

Tracks in the Timeline
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Tracks in the Mixer

Tracks in the Tracks Browser

Track controls
In LUNA, you can use many of the same track controls in multiple views.
For example, audio tracks in the Timeline have the following controls in the Track Controls area.
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Audio tracks in the Mixer and focused in the Timeline have the following controls.
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You can make many of the same adjustments in both views. For example, in both Timeline and the Mixer/Focus
channel, you can:
•
•
•
•
•
•
•

Assign inputs and outputs
Adjust volume and panning
Set the track automation mode
Enable Record and Input monitoring
Solo and mute tracks
Change the track name
Change the track color
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However, there are some adjustments you can only make in the Timeline or Mixer/Focus view.
In Timeline View only, you can:
• Configure the Warp algorithm
• Set a track to Time or Tempo mode
• Edit audio and MIDI, create fades, and other editing tasks
In Mixer/Focus track view only, you can:
•
•
•
•

Configure plug-ins
Add LUNA Instruments
Add Audio Unit instruments
Configure the LUNA Extensions for Tape and Neve Summing

Note: As with audio tracks, you can configure many settings for Instrument tracks, buses, and the Main track in both the
Timeline track controls and in the Mixer/Focus channel.

Selecting tracks
To select a track, click the track name in the Mixer, Timeline, or Tracks browser.
• To select multiple contiguous tracks, Shift-click the track names on the first and last track you want to select.
• To select multiple non-contiguous tracks, Command-click the track names.
• To select all tracks, Option-click a track name.

Applying changes to multiple tracks with Selection Grouping
LUNA includes a selection grouping feature that allows you to change controls on multiple selected tracks. To enable or
disable selection grouping, select or deselect Mixing > Selection Grouping from the LUNA menus, or press Command+G
to toggle selection grouping.
The following items can be adjusted when selection grouping is enabled.
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Volume
Pan
Track View
Automation Mode
Track Follows Mode
Warp Algorithm
Track input
Record Enable (only for tracks that have a unique Input assigned)
Input Enable (only for tracks that have a unique Input assigned)
Solo
Mute
Tape machine and tape settings
Neve Summing assignments and settings
Inserts
Send assignments and controls
Track outputs
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Applying changes to all tracks
To adjust items on all tracks, Option+Click the setting in the track controls or mixer channel strip. For example,
Option+Click the record-enable button to record-enable all tracks that have unique input assignments.
Note: When you Option+Click a control to enable or disable the setting, tracks that are hidden in the Tracks Browser are
not affected.

Creating audio tracks
You use audio tracks to record audio and to place imported audio files within a LUNA session. Audio is recorded in 24bit depth at the current audio interface hardware sample rate. LUNA can import WAV, AIFF, AAC, and MP3 audio that has
a valid sample rate, and play it back at the correct pitch.
Creating an empty audio track

To create an empty audio track:
1. In the Tracks Focus Browser, select Audio in the Create New Tracks dialog (Track > New Tracks or
Shift+Command+N), or click the plus (+) next to Tracks and choose Audio.
2. Choose the number of tracks to create and the format (MONO or STEREO). You can optionally type a name for
the track or tracks here if desired.
3. Click OK to create the tracks, or Cancel to stop track creation.
Track creation tips
• You can open the Create New Tracks dialog by selecting the menu item Track > New Tracks, or typing
Command+Shift+N.
• You can open multiple Create New Tracks dialogs in the Tracks Focus Browser, allowing you to create multiple
types and formats of tracks at the same time.
• If you create multiple tracks, the tracks are created with the name you specify, and a number is appended and
incremented for each track. For example, if you create four tracks called Vox, the tracks Vox 1, Vox 2, Vox 3, and
Vox 4 are created.
• In the Create New Tracks dialog, press Command+↑ or Command+↓ to cycle through track types.
• In the Create New Tracks dialog, press Command+← or Command+→ to cycle between Mono or Stereo track
formats.
• In the Create New Tracks dialog, press Control+↑ or Control+↓ to change the number of tracks to create.
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Creating a new audio track from existing audio
You can create a new track or tracks from one or more existing audio files.
Drag one or more audio files directly from the macOS Finder to the Tracks Focus Browser or into the empty area below
any existing tracks in the Timeline. Audio tracks are created and the audio files appear as clips on the new tracks. Audio
clips are located where you release your cursor when dragged to the timeline, or at the playhead when dragged to the
Tracks browser.
You can also drag an audio file directly into an existing audio track. The audio file appears as an audio clip that is
located where you released your cursor.

Assigning Inputs

When you click on the input for a track, the Input Focus Browser opens, from which you can choose the input for the
track. The list includes all available inputs in your Apollo system. Select an input from the Input Focus Browser. The
type of input you select determines the options that appear. For example, a Unison-capable input track includes
preamp controls.
Note: Unison insert and Record FX inserts are available only when a track is record-enabled or input-enabled.
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Creating Instrument tracks
You can use Instrument tracks to play audio from LUNA Instruments, a MIDI virtual instrument or a MIDI hardware
device such as a synth or sampler. On an instrument track you can:
•
•
•
•
•
•

Insert LUNA Instruments or any Audio Unit (AU) virtual instrument plug-in into an Instrument track.
Record MIDI data from an external MIDI device.
Import MIDI data.
Route the MIDI output from an Instrument track to an external MIDI device.
Route the audio from a MIDI device back to the Instrument track for monitoring.
Edit notes directly in Notes view.

Creating an empty Instrument track

To create an empty Instrument track:
1. In the Tracks Focus Browser, select Instrument in the Create New Tracks dialog, or click the plus (+) next to
Tracks and choose Instrument.
2. Select the number of tracks to create, the format (Mono or Stereo), and an optional name for the track or tracks
if desired.
3. From the VI drop menu, choose the LUNA instrument or Audio Unit instrument plug-in. Choose None to create a
MIDI track or MIDI tracks without instruments.
4. Click OK to create the tracks, or Cancel to stop track creation.
Track creation tips
• You can open the New Track dialog by selecting the menu item Track > New Tracks, or typing
Command+Shift+N.
• You can open multiple New Tracks dialogs in the Tracks Focus Browser, allowing you to create multiple types
and formats of tracks at the same time.
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• If you create multiple tracks, the tracks are created with the name you specify, and a number is appended and
incremented for each track. For example, if you create four tracks called Synth, the tracks Synth 1, Synth 2,
Synth 3, and Synth 4 are created.
Creating a new Instrument track from existing MIDI
You can create a new MIDI track or tracks from one or more existing MIDI (.mid) files by dragging the file(s) directly from
the macOS Finder to the Tracks Focus Browser, or to the empty area below any existing tracks in the Timeline.
Dragging MIDI files to the Tracks Focus Browser or to the empty area below the tracks in the Timeline creates one or
more new Instrument tracks containing new MIDI clips, located at the start of the session. You can also drag a MIDI clip
from the macOS Finder or a plug-in directly onto an existing Instrument track.
Note: You are prompted to either use the tempo map from the MIDI file, or to keep the current (session) tempo map.

Using Bus tracks
You can use bus tracks to route audio through the mix system. A bus track can carry more than one signal. Use a bus to
submix, or for any purpose that requires the grouping or routing of audio streams. You can create a bus track on its
own, and send audio to it from one or more track Sends, or you can assign the Output of one or more tracks directly to a
bus. You can manually create bus tracks and assign sends or track outputs to the bus, or you can automatically create a
bus that is assigned to selected tracks, as either a send or output bus.
For more information on mixing with bus sends, see Using Sends.
Use a bus:
• To combine multiple signals that you want to submix or create “stems” (for example, a submix of the rhythm
guitars or background vocals in a session), and to optionally add Neve Summing.
• To combine multiple signals to effect with a plug-in (for example, as a reverb bus for several vocal tracks).
• For other mix purposes, such as parallel compression of drums.
• To route audio to separate hardware or virtual outputs.
To create a bus track from specific tracks:
1. Select the track or tracks which you want to send or route directly to a bus. You can route audio, Instrument, and
other bus tracks to a bus.
2. Type Shift+Command+B or choose Mixing > Create Bus from the LUNA menus. The Create Bus dialog opens.
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3. Type a name for the bus.
4. In the Route From Selected pulldown, select the track source for the bus. For example, if you want to route the
selected track outputs directly to the bus, select Output. To use a Send to route the tracks to the bus, select a
send.
5. If you have an optional Console LUNA Extension (such as Neve Summing), you can select the Console here. You
can enable or disable Neve Summing after you create the track or tracks.
6. Click Create. The bus is created, with the routing you specified.
Note: If you assign the bus source to a send that is already in use for the selected tracks, that send assignment is
overwritten with the new bus assignment. If you assign the bus source to Output, the selected tracks’ outputs are
routed to the bus. Note that you can manually route the output of one or more tracks to multiple buses.

Getting Started with LUNA – 57

LUNA User Documentation v200731

To create a bus track on its own:
1. In the Tracks browser, click the plus (+) next to Tracks.

2. From the Type list, select Bus.
3. Select the number of buses to create and the format (Mono or Stereo), and type a name for the bus or buses.
4. If you have the optional Neve Summing LUNA Extension, you can select it here. You can enable or disable Neve
Summing after you create the bus or buses.
5. Click OK to create the bus or buses.
Bus inputs and bus routing overview
Once you have created a bus, you can route (send) audio to it. There are two methods for busing:
• Direct busing routes the output of a bus or track directly to a bus. In this scenario, the bus functions as the
track’s output, and the bus then outputs either to another bus, a physical or virtual output or output pair, or the
Main track. Use output busing to submix or to create stems. For example, you can route drums, instruments, and
vocals all to separate buses to control levels, adjust effects, and apply Neve Summing, then either route those to
the Main track or their own physical outputs.
• Send busing sends audio from the track to a bus, without changing the main output of the track. Send busing is
useful when you want to affect the audio and mix it back in to the main mix. For example, you can send drums to
a compressor on a bus and mix the compressed drums with the main drum tracks (parallel compression), or
send instruments and vocals to a 100% wet reverb bus, and mix the reverb bus in with the existing tracks.
To route audio directly to an existing bus:
1. Select the track or tracks you want to route directly to the bus.
2. Click the Out in the Timeline or the Output in the Mixer or on the Focus channel. The Output Focus Browser
opens.
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3. Choose the bus to which you want to route the output of the track or tracks.

The selected track or tracks are now routed to the bus outputs.The fader and pan controls on the bus track now control
overall mix characteristics of the tracks, and you can assign plug-ins and Neve Summing to the bus to affect all source
tracks.
To route audio to an existing bus using a send:
1. Select the track or tracks you want to send to the bus.
2. Click an available Send slot in the Mixer or on the Focus channel for a track. The Send Routing Focus Browser
opens.
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3. Select the destination bus for the send. Send destinations that you have previously created appear in the Focus
Browser under Buses.
4. The selected track or track sends are now routed to the bus.
When a send is routed to a single buses, the destination bus name is listed in the Sends mixer row.
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To route audio to multiple existing buses using a send:
1. Select the track or tracks you want to send to the bus.
2. Click an available Send slot in the Mixer or on the Focus channel for a track. The Send Routing Focus Browser
opens.
3. Command-click multiple non-contiguous destination buses to route the audio to those sends. Send destinations
that you have previously created appear in the Focus Browser under Buses.
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4. The selected track or track sends are now routed to the selected buses.
You can control the send level with the Bus level control. The fader and pan controls on the bus track now
control the overall characteristics of the bus track audio, and you can assign plug-ins and Neve Summing to the
bus to affect the audio from the send.
When a send is routed to multiple buses, the destination in the Sends mixer row is listed as Multiple.
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Using Accelerated Realtime Monitoring (ARM) with bus tracks
When you use Accelerated Realtime Monitoring (ARM), you can configure two bus tracks to work in ARM mode. ARM
allows you to use Realtime UAD Processing on these two buses, while monitoring and/or recording with indiscernible
latency.
To set ARM Mode for a bus track, enable ARM, then click the ARM button on the bus track, and select either Aux 1 or Aux
2. When LUNA is in ARM mode, all bus tracks that do not use one of the two ARM-enabled aux buses will incur some
latency when processing audio.

Using the Main Track
The Main track is the master fader or stereo output bus channel for your LUNA session. All audio that is routed to Main
runs through this bus, and is summed for listening and mixdown purposes. By default, all audio, Instrument, and bus
tracks are routed to the Main track.
You cannot delete the Main track, and you cannot create a new Main track. However, you can route audio to other
outputs instead of the Main track.
The Main track is where you assign your master track Insert plug-ins. You can also enable Neve Summing on the Main
track.
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Using LUNA
LUNA is split into Mixer and Timeline views. At the top of the screen is the Control Bar, which you use in both views.

An Overview of the Control Bar
At the top of the LUNA screen is the Control Bar.

The Control Bar includes several sections that you can use to navigate and control your LUNA session.

Setting the LUNA view options
LUNA provides two main windows: Mixer and Timeline.
Choose the view by clicking in the selector at the far left of the control bar.

Click on the Timeline view icon to switch to Timeline view. Click on the Mixer view icon to switch to Mixer view.
To switch between LUNA views, use the key shortcut Command+= or choose View > Toggle Timeline/Mixer from the
LUNA menus.
To open another LUNA window so you can view the Mixer and Timeline at the same time, use the key shortcut
Shift+Command+= or choose Window > New Alternate Window from the LUNA menus.
Click the Other views icon to show and hide other window views.

Mixer view
Mixer view allows you to view the track channel strips for a session, to set up inputs for tracks to record, and to mix a
session. Each track in the Mixer is comprised of two sections: the Mixer rows and the Fader section.
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Mixer rows
In the Mixer rows, you assign audio and MIDI inputs, configure plug-ins, and assign sends, cues, buses, bus returns, and
outputs. You also configure plug-ins, Tape processing, and Neve Summing in the Mixer.
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Fader section
In the Fader section, you adjust audio, instrument, and bus track levels and panning, enable tracks for recording or
input monitoring, solo and mute tracks, enable and record automation, and monitor the levels of tracks.
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Input and tape controls

Plug-ins, sends, cues, and output

Using the Mixer Navigation Panel
In Mixer view, select View > Section > Mixer Navigation to show the Mixer Navigation panel. Mixer Navigation enables
you to navigate between sections of the mixer, expand or close mixer rows, switch all rows between small and large
views, and show or hide all slots.
By default, all mixer rows are open, and only slots that are in use plus one empty slot row are displayed.
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To use the Mixer Navigation panel:
• Click a section in the Mixer Navigation area to scroll that section to the top of the visible area. Mixer rows that are
visible are illuminated in the Mixer Navigation section.
• To hide a row, deselect the button next to the row name.
• To show only one row, Command+Click the row name.
• To expand all mixer rows, click Open. To Close all mixer rows, click Close.
• To show large view icons and elements in all mixer rows, click Large. To show small view icons and elements,
click Small.
• To show all possible mixer slots for any open rows, click Fixed Slots. Click Fixed slots again to only show the slots
that are in use.
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Using Mixer Modifiers

Mixer modifiers add several controls to the LUNA mixer that make common workflow tasks MUCH faster and easier to
accomplish. When you click a mixer modifier button, the control latches.

Modifiers Timeout
When an option is latched, it is automatically unlatched (times out) after the Modifiers Timeout period to prevent
inadvertent modifications.
The Modifiers Timeout is a preference set in the Settings > Options panel. The default Modifiers Timeout period is six
seconds/flashes.
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To power off items in the Mixer:
1. In the Mixer view, click the Power button on the Modifiers panel. Power modifier icons appear on all items in the
Mixer that can be powered off, including sends, cues, Tape and Neve Summing Extensions, LUNA Instruments,
and plug-ins.
2. Click individual power modifiers, or swipe horizontally across multiple modifiers, to toggle power on or off for
items in the Mixer.
To remove items in the Mixer:
1. In the Mixer view, click the Remove button on the Modifiers panel. Remove modifier icons appear on all items
that can be removed in the Mixer, including inputs, sends, LUNA Instruments, Tape and Neve Summing LUNA
Extensions, and plug-ins.
2. Click individual remove modifiers, or swipe horizontally across multiple modifiers, to remove items from the
Mixer.
To copy and paste items in the Mixer:
1. In the Mixer view, click the Copy button on the Modifiers panel, or press Command+C. Copy modifier icons
appear on all items that can be copied and pasted in the Mixer, including inputs, outputs, sends, cues, LUNA
Instruments, Tape and Neve Summing LUNA Extensions, and plug-ins.
2. Click the individual copy modifier for the item you want to copy. After a modifier is copied, the copy modifier
turns to a red Paste modifier. Destinations to which the copied item can be pasted are highlighted.
3. Click individual paste modifiers, or swipe across multiple modifiers to paste multiple items.
To set a control to the default:
1. In the Mixer view, click the Set Default button on the Modifiers panel. The Set Default button blinks.
2. Click any control to return the control to its default value.
For example, the headroom and trim controls on the Neve Summing Extension, or the fader for a track can be returned
to their default settings by clicking with the Set Default modifier latched. Tape Saturation knobs and controls on the
Studer A800 Extension tape deck can also be returned to default settings by clicking with the Set Default modifier
enabled.

Timeline view
Timeline view shows you a visual layout of your audio and MIDI tracks. On the Timeline, you can record, edit, and
arrange audio and MIDI clips. In the Timeline you can also view the Focus channel for a selected track, which allows you
to access the functions of the Mixer window on that track.
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The playhead
In the Timeline, the tall vertical cursor that indicates where LUNA is currently playing from and recording to is called the
playhead. You use the playhead to set where to play and record, make edits, add markers, tempo changes, and time
signature changes, and make selections.
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Using Focus Browsers
From the Other Views popover, click Tracks to show the Focus Browser.

You can also show the Focus Browser from the LUNA menus by choosing View > Section > Browser.
In its default view, the Focus Browser shows a list of tracks in a session.
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You can create, duplicate, and delete tracks, show and hide tracks, change a track’s color or name, select tracks, and
search for tracks. Each track in the track browser includes a color square, the track name, a track type icon, and a show/
hide circle. All changes are reflected in Timeline and Mixer view.
• To search for a track by name, click in the search bar and begin typing. To focus a track that you have located
with Search, press Return. Use the arrow keys to cycle through tracks. When you are using the Focus Browser to
choose other settings or options (for example, when inserting a plug-in or choosing a plug-in preset), you can
cycle through and audition changes with the arrow keys.
• To show or hide a track, click the circle to the right of the track type icon. Note that hiding a track does not mute
it.
• To rename a track, double-click the track name, type the new name, and press Return. You can type an optional
comment in the Comment field.
• To change the color of a track, click the color square to the left of the track name, choose a color, and click Done.
You can leave the color palette open to quickly recolor additional tracks.
• To select a track, click the track row. To select multiple contiguous tracks, Shift+Click the first and last track you
want to select. To select multiple discontiguous tracks, Command+Click the tracks. To select all tracks,
Option+Click a track.
• To reorder tracks, drag and drop the tracks. The track order is mirrored between Mixer and Timeline views.
• Right-click or Control-click to open the context menu and delete or duplicate a selected track or tracks.
• When you make a selection on any track, you can switch that selection to any other track by clicking the track in
the track browser. To extend the selection to multiple contiguous tracks, Shift+Click the first and last track you
want to select. To extend the selection to multiple discontiguous tracks, Command+Click the tracks. To extend
the selection to all tracks, Option+Click a track.
Focus Browsers appear to the left of the screen so you can select and work with:
• Inputs
• Tracks
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•
•
•
•
•
•
•

Audio and instrument track SHOW options
Instruments
Insert plug-ins
Plug-in presets
Tape machine emulations
Sends
Outputs

Some Focus Browsers allow more choices. For example, when you click a Send on a track, the browser allows you the
option to apply the choices to the selected track, the focused track, or all tracks. You can also configure how the audio
for a particular send is routed.

Using the Focus Channel
From the Other Views popover, click Focus to show the Focus Channel.
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You can also show the Focus Chanel from the LUNA menus by choosing View > Section > Focus Channel.
The Focus Channel allows you to use a channel’s Mixer channel strip without leaving Timeline view. The selected track,
or the first selected track in a group selection, is shown in the Focus channel, when the Focus Channel is enabled.

Other views
Click the Other views icon to show and hide the other views in the Timeline and Mixer. Besides the Focus Browser and
Focus Channel, other views include:
• System info (Info)
• The monitor section (Mon)

Using LUNA – 77

LUNA User Documentation v200731

Viewing System Info
Click Info to show System Info at the bottom of the LUNA window. You can show System Info from the LUNA menus by
choosing View > Section > Info.
System Info shows the following:
•
•
•
•
•
•

Current hardware sample rate
Clock source
Available ARM resources
Render meter (the amount of CPU used for all native processing)
Render IO (the amount of CPU used by plug-ins on Instrument tracks in ARM mode)
Memory (the amount of memory used by LUNA)

The system info section is displayed at the bottom of the LUNA window.

Viewing the Monitor Section
Click Mon to show the Monitor strip at the right of the LUNA window. You can show the Monitor strip from the LUNA
menus by choosing View > Section > Monitor. The Monitor strip shows the audio meters for the session, and allows you
to configure control room settings, cues, ALT speakers, and to set the level or mute, or send a mono mix to the Monitor
outputs.
See “Using Monitor, Control Room, and Talkback” for more information.
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Using the Tempo, Click, and Counter controls
The Tempo, click and counter controls allow you to set and change the session tempo, listen to a click and set the click
volume, see the current playhead location and navigate to other locations quickly.
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Setting a tempo
When you change the session tempo, elements in the LUNA session that are tempo-based adjust to the new tempo.
Instrument tracks are adjusted, and audio clips that are set to Track Follows Tempo mode are stretched or compressed
to fit the new tempo. Audio clips that are time-based are not stretched or compressed, but LUNA keeps the start of each
clip at the same relative point in the Timeline.
To set the overall tempo of the session:
• Hover over the Tempo control. The cursor changes to a double arrow. Click and drag up or down to adjust the
tempo by 1 BPM increments. To adjust by .1 BPM increments, hold Shift while you click and drag. Release the
cursor to set the Tempo. You can click and drag to change tempo while the session is playing to hear your
changes in real time.

• To type the new tempo, click to select the Tempo in the control bar, type a new tempo, and press Return.
To set the tempo by tapping, add tempo changes, make tempo changes over time, and automate tempo changes, see
“Setting the tempo and making tempo changes.”

Listening to a click in playback and record
To listen to a click during playback or record:
1. Click on the metronome icon to enable the click, or press 7 on the Numeric Keypad.
2. Set the click level by dragging the volume up and down, or click and type a dB value for the volume then press
Return.
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To send the click to a cue mix:
1. Click the Record workflow button (for more information about workflows, see “Using Workflows”). The Record
workflow strip opens below the Control Bar.

2. Press the Click to Cue button to see the Click Sends popover. The number of cue buses and their names will vary
depending on your Apollo system.
3. Assign the click to the cues using the On buttons and the level faders.
4. Enable or disable the click globally with the Power button in the popover.
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5. Press Click to Cue again or type the esc key to close the Click to Cue popover.

Setting the counter units
You can set the counter to show bars and beats, minutes and seconds, or samples. Note that the session time display
also follows the units you set.
1. Click the word Counter in the Control Bar. A popover menu appears.
2. Select bars and beats, minutes and seconds, or samples.
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Navigating with the counter
You can navigate by entering a time value in the counter. For example, you can enter 12 to go to 12|1|00 in Bars and
Beats mode, or you can enter 10 in Minutes and Seconds mode to go to :10 in the session.

Using the Transport Controls
Use the transport controls to play, record, and stop audio, and toggle loop record and playback.
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• To play audio, click Play or press the Spacebar.
• To stop playback, click Stop or press the Spacebar.
• To Record audio, click Record, then click Play, or press Command+Spacebar. You can also click Record while
playback is occurring, to begin recording on any record-enabled tracks.
Note: by default, the key command to start recording, Command+Spacebar, is mapped to the macOS Spotlight
search feature. You must disable or remap this feature to use this key command. To disable or remap this
command, in System Preferences > Spotlight > Keyboard Shortcuts uncheck the key commands, or map them to
different key commands. Refer to your macOS documentation for more information.
• When LUNA is in Loop Playback mode, the current selection loops continually (depending on how you make the
selection and the Link Edit/Play Selections setting). See “Loop Playback and Recording” for more information.
When LUNA is in Loop Record mode, LUNA records multiple “takes” of audio or MIDI data on record-enabled
tracks, until you stop playback or toggle out of Record.
• To return to the start of the session, click Return to zero or press Return.
• To move to the end of the session, click Go to end.

Using Workflows
Workflows provide common editing, arranging, and navigation commands on a toolbar that you can open under the
main LUNA control bar.

The Record workflow

Click the Record workflow icon to enable the Record workflow. The Record Workflow allows you to use the following
commands:
Command

Description
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Click to Cue

Enables the Click to the cue mix buses, and allows you to set click volumes for
each individual cue mix.

Cue Outputs

Shows the Cue Outputs configuration.

Pre Roll

Click the power button to enable pre-roll. Pre-roll specifies an amount of time
that the transport plays before LUNA plays from the playhead or your
selection. Material in the session before the playhead or selection will play
during pre-roll. You can set a time value when pre-roll is enabled; for
example, a value of 2 sets two bars of pre-roll.
Note: Pre-roll only plays the first time the transport starts in loop playback/
record mode.
You can also set pre-roll by Option-clicking to the left of the playhead or your
selection in the Timeline.

Post Roll

Click the power button to enable post-roll (an amount of time that the
transport plays after LUNA reaches the end of your selection). Material in the
session after the selection will play during post-roll. You can set a time value
when enabled; for example, a value of 2 sets two bars of post-roll.
Note: Post-roll only plays when there is a selection, and loop playback/
record is not enabled.
You can also set post-roll by Option-clicking to the right of the selection in the
Timeline.

ARM

Click the power button to enable Accelerated Realtime Monitoring for
indiscernible latency when recording audio. When you enable ARM, available
ARM resources are displayed. Available ARM resources depend on the Apollo
hardware in your system and how many ARM-enabled tracks you have Inputenabled or Record-enabled. See “Accelerated Realtime Monitoring” for more
information.
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The MIDI workflow

Click the MIDI workflow icon to enable the MIDI workflow. The MIDI Workflow allows you to use the following
commands:
Command

Description

MIDI Merge

Click the power button to enable MIDI Merge. When MIDI Merge is enabled, the
MIDI notes you play while recording are combined with the existing notes over
which you record. MIDI Merge is useful, for example, if you want to build up a
track like a drum part by playing in separate drums on successive record passes.
When MIDI Merge is disabled, any existing MIDI over which you record is
replaced with the new MIDI you record.

Panic

Sends an All Notes Off MIDI command.

MIDI Keyboard

Click the power button to enable and disable the MIDI Keyboard. The MIDI
keyboard lets you record and play MIDI notes over a range of keys on the
computer keyboard. See the keyboard for the note mapping. You can click keys
on the MIDI keyboard with your mouse to trigger notes, even when MIDI
Keyboard is disabled.
Key command: Option+Command+M.

Octave

Raises or lowers the octave of computer keyboard MIDI input.
Key Commands: Z to lower the range one octave, X to raise the range one
octave.
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Velocity

Raises or lowers the fixed velocity of computer keyboard MIDI input.
Key Commands: C to lower the velocity, V to raise the velocity.

Key buttons

Shows the computer keys that correlate to notes on the MIDI keyboard. You can
also click on keys on this keyboard to play notes, whether the MIDI Keyboard is
enabled or not.

Status

Indicates external MIDI activity.

Export Clip

Opens the Export pane, where you can select clips to export. You can export any
audio or MIDI clip with the Export Clip window. MIDI clips are exported as MIDI
files (.mid) and audio files are exported according to the settings you configure.
Key command: Shift+Command+K.

The Edit workflow

Click the Edit workflow icon to enable the Edit workflow. The Edit Workflow allows you to use the following commands:
Command

Description

Cut

Cuts the selected audio, MIDI, or automation data and places it on the clipboard.
Key command: Command+X, X.
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Copy

Copies the selected audio, MIDI, or automation data and places it on the
clipboard.
Key command: Command+C, C.

Paste

Pastes copied or cut audio, MIDI, or automation data at the playhead.
Key command: Command+V, V.

Duplicate

Copies the selected audio, MIDI, or automation data to the clipboard and pastes
it immediately after the current selection.
Key command: Command+D.

Separate

Splits clips at the playhead. Clips on all selected tracks are split at the playhead
position. To split clips on all tracks, place the playhead using the All Tracks ruler.
Key command: Command+E.

Shift Cut

Cuts the selected audio, MIDI, or automation data to the clipboard and shifts all
subsequent data earlier in the Timeline by the amount selected.
Key command: Shift+X.

Shift Paste

Pastes copied or cut audio, MIDI, or automation data at the playhead, and shifts
subsequent audio, MIDI, or automation data later in the Timeline by the amount
pasted.
Key command: Shift+V.

Shift Duplicate

Copies the selected audio, MIDI, or automation data to the clipboard and pastes
it immediately after the current selection, and shifts subsequent audio, MIDI, or
automation data later in the Timeline by the amount pasted.
Key command: Shift+D.
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Shift Insert

Inserts the selected amount of space at the playhead, and shifts subsequent
audio, MIDI, or automation data later in the Timeline by the amount of space
inserted. Space is inserted only on selected tracks. To insert space for the entire
session, make the selection on the All Tracks ruler.
Key command: Shift+I.

Fade In

Creates a fade In to the playhead. You must place the playhead in an audio clip.
You can create fades on multiple tracks if you have multiple tracks selected with
the playhead placed in an audio clip.
Key command: Control+D.

Fade Out

Creates a fade out from the playhead. You must place the playhead in an audio
clip. You can create fades on multiple tracks if you have multiple tracks selected
with the playhead placed in an audio clip.
Key command: Control+G.

X-fade

Creates a crossfade at the selection. The selection for a crossfade must be a
boundary between two clips, or a selection of two clips with a gap between them.
Key command: Command+F, F.

Mute Clip

Mutes an audio or MIDI clip.
Key command: Command+M.

Consolidate Clips

Consolidates selected clips into one clip. You can select multiple contiguous
clips, and clips on different tracks.
Key command: Option+Shift+3.

Export Clip

Opens the Export pane, where you can select clips to export. You can export any
audio or MIDI clip with the Export Clip window. MIDI clips are exported as MIDI
files (.mid) and audio files are exported according to the settings you
configure. By default, the destination for exported clips is the Exported Files
folder in your LUNA session folder.
Key command: Shift+Command+K.
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The Mix workflow

Click the Mix workflow icon to enable the Mix workflow. The Mix Workflow allows you to use the following commands:
Command

Description

Solo Mode

Click Latch or X-Or to set the solo mode.
• Latch mode allows you to enable multiple solos, and latch them on or off by
clicking Solo buttons.
• X-Or is “Solo Exclusive” mode, and only one element can be soloed at a time.
Each successive Solo button click disables the previous Solo button.

Universe View

Shows a visual overview of your session. Click in the Universe view to move the
playhead to different locations in the session.

Mixdown

Click to open the Mixdown pane, where you can mix down a stereo track of your
session, individual tracks, and stems.
Key command: Shift+Command+B.
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Working in the Timeline Display
Using rulers
Rulers allow you to track timeline data and add markers, time signatures, and tempo changes to the timeline display.
You can also make selections, loop, and make selections on all tracks.

Working with the Bars and Beats ruler
In the Bars and Beats ruler, you can place the playhead, set the Grid resolution, enable Snap, link Edit and Play
selections, make selections, and enable automatic scrolling.

Zooming with the Bars and Beats ruler
Click in the Bars and Beats ruler and drag up or down to zoom audio horizontally. The session zooms with the playhead
centered on the screen (once the zoom level is high enough). Drag down to zoom in, and drag up to zoom out.
Playhead, play selection, and play start
When the transport is stopped or playing, click on the Bars and Beats ruler to immediately move the playhead to
another location. Playback immediately restarts at the spot you click if the transport is playing. Any selection you make
on the Bars and Beats ruler immediately plays if the transport is playing and stops at the end of the selection, or plays
and then loops if Loop Playback/Record is enabled. Clicking or selecting on the Bars and Beats ruler overrides
selections in the Timeline and on the Loop ruler, regardless of the Link Edit and Play Selections setting.
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Link Edit and Play Selections
Enable Link Edit and Play selections to simplify editing and auditioning audio and MIDI. This setting enables you to
listen to the selection you are working on at all times. When you make a selection in the Timeline, the same selection is
made on the Bars and Beats ruler, and vice versa. When Link Edit and Play selections is disabled, you can edit audio and
MIDI on the Timeline, while playing from a location or selection on the Bars and Beats ruler or the Loop ruler, without
affecting the selection or start point.
To enable Link Edit and Play selections, from the LUNA menus, choose Navigation > Link Edit/Play Selections, or click
the Link Edit/Play Selection icon on the Bars and Beats ruler.
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Pre-roll and post-roll
Pre-roll and post-roll specify time selections that play back before (pre-roll) and after (post-roll) a selection. Pre-roll
plays when you press play, before the playhead or a selection; post-roll plays only after reaching the end of a selection.
Pre-roll and post-roll can be useful to hear a selection in context, or to provide a lead-in and lead-out when punch-in
recording.
To set pre or post-roll on the Bars and Beats ruler:
1. Option+Click on the Bars and Beats ruler to the left of a selection or the playhead to use the pre/post-roll Editing
Tool to make a pre-roll selection.
2. Option+Click on the Bars and Beats ruler to the right of a selection to make a post-roll selection.
3. Click on the pre-roll/post-roll boundary and drag to change the pre-roll or post-roll length.

To set a specific length for pre-roll and post-roll:
1. Enable the Record workflow.
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2. Click the power buttons to enable pre-roll, post-roll, or both.
3. Next to the Pre/Post-Roll buttons, type the amount of pre-roll or post-roll, and press Return.
Regardless of the Counter units setting, pre-roll and post-roll are always specified in Bars and Beats. In the text entry
field you can specify bars, bars and beats, or bars, beats and ticks with a separator (space, comma, semicolon, colon,
period, or |). For example, you can type 1 3 480, 1:3:480, 1.3.480, or 1,3,480, then press Return, to specify 1 bar, 3 beats,
and 480 ticks. You can type 2 to specify 2|0|000, or 3:1 to specify 3|1|000.

• Pre-roll plays when you start playback or recording. Pre-roll only plays the first time a selection is played, and
does not play when a selection loops.
• Post-roll plays only when a selection is made, and the selection is not looped, after the playhead reaches the end
of the selection.
• Post-roll does not play when a selection loops, or when the playhead is placed without a selection.
• The pre/post-roll selections remain active on either side of the selection or playhead, even if you change the
selection length or deselect.
• You can enable or disable pre/post-roll with the menu items Transport > Pre-Roll and Transport > Post-Roll. You
can Toggle the state of both pre-roll and post-roll with the menu item Transport > Pre/Post-Roll, or
Command+K.
• You can enable or disable pre-roll and post-roll individually with options in the Record workflow. For more
information about workflows, see “Using Workflows.”

Enable the Record workflow
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Enable or disable pre/post-roll

Grid, Snap, and Relative Snap
Grid resolution determines how finely items are selected and snapped when Snap is enabled. Grid resolution also
specifies the default duration of a MIDI note and the resolution at which automation breakpoints are added, whether
Snap is enabled or disabled.
When Snap is enabled, items snap to the grid, based on the grid resolution. Snap mode snaps items exactly to the grid:
if a note is slightly ahead of, or behind a beat, when you drag that note to a new location in Snap mode, the start of the
note snaps to the nearest grid line. Snap mode applies to MIDI and audio edits and selections.
When Relative Snap mode is enabled, MIDI notes snap to the grid, while maintaining their previous time relationships
(offsets) to grid markers. If a MIDI note is offset from a grid line, and you drag it to another grid line, the note remains the
same distance offset from the new grid line. Relative Snap mode applies only to MIDI note edits.

Working in the Timeline Display – 95

LUNA User Documentation v200731

Working in the Timeline Display – 96

LUNA User Documentation v200731

To set the Grid resolution and enable Snap:
1. On the Bars and Beats ruler, click Grid. From the menu, select the grid resolution. You can select Bar, Beat, a note
from 1/2 to 1/64th, and Dotted or Triplet resolution.
2. To enable Snap, click Snap. Snap is enabled when it is highlighted.
3. To enable Relative Snap mode, click the lower right corner of the Snap control, and choose Relative. To disable
Relative Snap mode, deselect Relative from the same menu.

Working with the All Tracks ruler
In the All Tracks ruler, you can set the size for all tracks, show or hide track versions, and make selections across all
tracks in the session. When you make a selection on the All Tracks ruler, all tracks are selected, so if you make volume or
pan changes, make edits, or add Tape or plug-ins, LUNA will make those changes to all applicable tracks.
Note: All tracks are selected when you use the All Tracks ruler. Be sure to deselect tracks that you don’t want to affect
before you make any non-global changes.

The All Tracks Ruler also includes the Track Heights control and the Versions panel toggle.
Resize all track heights
Click the Resize Tracks control and choose a track height to resize all tracks in the session to one vertical height. To
resize and zoom individual tracks, see “Resizing and zooming the audio track.”
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Show track versions
Click the Versions panel toggle to show track versions. The initial version and any version you create or duplicate is
labeled with a V (for example V1 and V2). Any track version automatically created by loop recording is labeled with a T
(for example, T3 and T4). This allows you to easily distinguish between versions you have manually created and
versions that are automatically generated.

To change the visible items in Timeline View, use View > Timeline Settings from the menu. The options appear in the
Contextual Browser at the left of the LUNA window. An item is visible when its box is active. Note that by default, the
Samples ruler is not shown.
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Loop ruler
Select View > Timeline Settings > Loop to show the Loop ruler. In the Loop ruler you can select a loop, and move the
loop location and change the duration. To enable or disable loop playback, click the Loop Record/Playback button on
the transport, or type Control+L.
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Minutes and Seconds ruler
Select View > Timeline Settings > Min:Sec to show the Minutes and Seconds ruler. This shows the actual time scale for
the session.

Samples ruler
Select View > Timeline Settings> Samples to show the Samples ruler. This shows the time scale of the session in number
of samples.
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Tempo ruler
Select View > Timeline Settings > Tempo to show the Tempo ruler. This shows the tempo of the session on the timeline.
The Tempo ruler has special functions, as you can use it to change the tempo of the session, or add instant or gradual
tempo changes. To make tempo changes, see “Setting the tempo and making tempo changes.” You can also derive
tempo changes over time from pre-existing material using the Align Bar workflow. See “Using Align Bar to derive tempo
from audio tracks.”
Note: Changing the tempo of the session, or a section of the session, will cause MIDI data, and audio tracks that are in
Track Follows Tempo mode to conform to those tempo changes by stretching or contracting.

Signature ruler
Select Signature to show the Time Signature ruler. This shows the time signature of the session on the timeline.
The Time Signature ruler has special functions, as you can use it to change the time signature of the session. See
“Setting the time signature and making meter changes.”
Note: Time signature changes do not change the audio or MIDI data in the session, but merely change the grid,
counters, and click behavior.

Markers ruler
Select Markers to show the Markers ruler. Markers provide a visual reference to locations in the session. For example,
you might mark a chorus or verse, or a tempo or meter change.
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The Markers ruler has special functions, and you can add, delete, move, name, and color markers for usability. See
“Using Markers.”
Note: Marker location is associated with the tempo information of the session. When you change tempo, all markers
within the area affected by the tempo change move to reflect the new locations that the tempo change causes.

Automatically scrolling the timeline during playback or record
To scroll the timeline automatically, press Shift+A, or choose Navigation > Auto-Scroll. Auto-Scroll moves one viewable
timeline screen or “page” at a time, and also auto-scrolls with loops, if the loop extends beyond the length of a screen.
With auto-scrolling enabled the display jumps to the playhead location when you start playback. If you manually scroll
the timeline during playback or record while Auto-Scroll is enabled, Auto-Scroll is temporarily disabled until you stop
and start again. You can press Shift+A to restart auto-scrolling during playback or record.

Enabling or Disabling Automatic Scrolling with the Bars and Beats ruler
On the Bars and Beats ruler control area, click the Auto Scroll button to enable or disable automatic timeline scrolling.

Showing items in Clips
With Timeline Settings, you can specify the items that are shown on audio clips, by selecting or deselecting items under
Clips Show.
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Setting clip names
In the Timeline Settings browser, under Clips Show, select Names to show clip Names at the top of audio clips. You can
double-click a clip name to change it.

Using the clip Gain control
In the Timeline Settings browser, under Clips Show, select Gain Control to show the gain control at the top of each clip.
Hover the mouse cursor over the gain control icon at the top of an audio clip to show the Gain Control Editing Tool.
Move the slider up and down to increase or reduce the gain of a clip, without altering the gain of other clips on the track.
Clip gain allows a wide range of adjustment, from -144 dB to +48 dB. As you adjust clip gain, the waveform display
shows the resulting changes to the audio level. If you select multiple clips and adjust the gain slider on one clip, the
same amount of gain change is applied to all selected clips.

Using the clip Pitch control
In the Timeline Settings browser, under Clips Show, select Pitch Control to show the pitch control at the top of an audio
clip. Hover the mouse cursor over the pitch control icon at the top of an audio clip to show the Pitch Control Editing
Tool. You can move this slider up and down to raise or lower the pitch of a clip by tenths of a semitone. If you select
multiple clips and adjust the pitch slider on one clip, the pitch change is applied to all selected clips. To enter a pitch
change value in semitones, double-click the Pitch control and type a number (for example, 5 to raise the pitch by five
semitones, or -12 to lower the pitch an octave).
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Showing Grid Lines
In Timeline Settings, select Grid Lines to show grid lines in the timeline. Grid lines provide a visual reference for bars,
beats, and subdivisions, depending on the subdivision settings you specify.

Using Align Bar to derive tempo from audio tracks
If you have imported audio tracks, or recorded audio tracks without a click, you can use Align Bar to derive tempos from
those tracks. This is useful, for example, when you have a live drum recording or band recording that you now want to
edit or overdub with other tracks, and you want a click, or you want tempo information for MIDI instruments.
Align Bar will work to set the tempo for a session with many tracks, but you should use one mono or stereo audio track
as a time reference. It is also best if the track you are using for a time reference has strong rhythmic information and
strong transients. For example, a kick drum that hits on the first beat of every bar, or the first beat every two bars, is an
ideal time source.
Note: Align Bar adds tempo markers to the session. Make sure your audio tracks are set to Track Follows Time mode.
Any tracks that are set to Track Follows Tempo mode will be time stretched or compressed as you align bars.

To set tempo using Align Bar:
1. Identify the first bar line of your music source. Place the playhead in an audio file that contains transient
information that is aligned with the tempo of the song (for example, a kick drum track), and press the Tab key to
locate the first transient. You can also locate the first bar line manually.
2. Press Tab until you reach the transient for the bar you want to mark (or press Option+Tab to tab backwards
through transients). When you find the bar you want to mark, press Option+Command+I or choose Edit > Align
Bar. The Align Bar popover opens, with a bar number that LUNA estimates.
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3. Type or accept the bar number in the box and press Return or click OK. A tempo marker is added and the audio
visually adjusts on the timeline.
4. Continue to add bar markers, if needed, by pressing Tab until you find the beginning of a bar, and pressing
Option+Command+I or choosing Edit > Align Bar.
You can continue to add tempo markers in this way for as many bars as you want, with granularity as fine as a single
bar.
Note: The tracks visually appear to stretch and contract as you add tempo markers, but the audio remains unchanged
as long as the tracks are set to Track Follows Time mode.
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Recording Audio
With LUNA's Accelerated Realtime Monitoring (ARM), you can easily record and monitor multiple audio and instrument
tracks with no discernible latency. On tracks that are record-enabled or input-enabled, you can monitor with UAD plugins, and you can monitor two ARM AUX-enabled buses that are in the record path (buses that are receiving audio from a
record or input-enabled track). While recording, you can monitor tracks that are not record-enabled or input-enabled
with UAD plug-ins, LUNA Tape emulation, and Audio Unit plug-ins, and monitor buses with UAD plug-ins and Neve
Summing. All latencies are automatically delay-compensated by LUNA, and track counts are limited only by the
capabilities of your computer.

Recording audio tracks

To prepare an audio track for recording:
1. On the audio track, click on the Input row in the Mixer channel or on the Focus channel. The Input Focus Browser
opens.
2. Choose the Input to which your source is connected. To switch between Mic and Line inputs, click the Mic/Line
switch.
3. Click the Record enable button on the track, or press Shift+R.

Recording Audio – 106

LUNA User Documentation v200731

Configuring track input options
Preamp controls correspond to the equivalent preamp controls on the Apollo hardware. Adjusting Apollo’s hardware
preamp options updates LUNA, and vice versa.
Some preamp hardware controls (Gain, Low Cut, 48V, Pad, and Polarity) are Unison parameters that interact with
Unison plug-ins placed in the Unison insert.
Note: You can only adjust preamp controls and Unison plug-in parameters when a track is record-enabled or inputenabled.
Preamp Inputs
Each of Apollo’s preamp channels have multiple analog inputs (mic, line, Hi-Z) that can be selected with the preamp
controls.
Click to switch between mic and line inputs manually in LUNA or on the Apollo hardware. Channels are automatically
switched to Hi-Z inputs when a 1⁄4” mono (tip-sleeve) cable is connected to Apollo’s Hi-Z input jack.
Line inputs
Analog line inputs without mic preamps are available on some Apollo models. These line inputs may have a reference
level switch instead of preamp controls.
Digital inputs
Digital inputs work like analog inputs, except they don’t have the extra preamp and reference level settings that may be
available on the analog inputs.
Virtual inputs
Virtual input channels do not reflect Apollo hardware inputs. Instead, they receive digital signals from the computer
system via Apollo’s device drivers, enabling Realtime UAD Processing on digital audio signals that may be present in the
system. On macOS, you can route digital signals to virtual inputs with the Audio MIDI Setup utility.
Low Cut
When enabled, the channel’s input signal passes through a low cut (high pass) filter. The filter has a cutoff frequency of
75 Hz with a slope of 12 dB per octave by default, though the filter can change when a Unison plug-in is active in the
channel. The Low Cut filter affects the Mic, Line, and Hi-Z inputs. Low Cut is typically used to eliminate rumble and other
unwanted low frequencies from the input signal.
Note: The default low cut filter slope and frequency can change if a Unison plug-in is active in the channel. The input
scaling and fader taper can also change if you use a Unison plug-in.
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48V
Enable the 48V control to supply 48 volts of phantom power to the equipment connected to the Apollo channel’s Mic
input. The indicator light is red when enabled. Many modern condenser microphones require 48V phantom power to
operate. This option can only be activated when the Mic/Line switch is set to Mic.
Activate 48V phantom power only with compatible equipment such as phantom-powered microphones. Incompatible
equipment, such as some ribbon microphones, may be damaged by the applied voltage. There is a delay and audio is
muted when changing the 48V state, to minimize the clicks and pops that are inherent when engaging phantom power.
The 48V LED on the Apollo flashes during this delay.
Caution: To avoid potential equipment damage, disable +48V phantom power on the channel before connecting or
disconnecting its XLR input.
Pad
Enable the PAD control to attenuate the microphone input signal level by 20 dB. The indicator light turns yellow when
enabled. Pad does not affect the Line or Hi-Z inputs. Pad is used to reduce signal levels when overload distortion is
present at low preamp gain levels, such as when particularly sensitive microphones are used on loud instruments, or if
the A/D converter is clipping.
Polarity
Enable the polarity switch to invert the channel’s signal. The indicator light turns yellow when enabled. Polarity affects
the Mic, Line, and Hi-Z inputs.
Tip: Polarity inversion can help reduce phase cancellations when more than one microphone is used to record a single
source.

Recording audio inputs
Audio can be recorded with or without UAD plug-in processing.
Unison technology is activated when a Unison-enabled UAD plug-in is loaded in the dedicated Unison insert located
above the preamp options. The Unison insert is only available on preamp channels.
Audio on preamp channels is processed by the Unison insert before the Record FX inserts. Unison and Record FX plug-in
processing is always recorded.
Tip: You can monitor through UAD plug-ins without recording their processing by placing them in the standard inserts.
Record enabling and Input enabling tracks
Record and/or Input enable tracks to monitor track inputs according to your workflow needs.
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When you record-enable or input-enable a Unison-capable track, the Unison insert and Record FX inserts are made
available, and the channel preamp controls become active.
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Record enabled
When an audio track is Record enabled, you can monitor the input to the track while the transport is stopped and while
the transport is playing and record-ready. When an audio track is record-enabled, and the transport is playing but not
recording, audio from the input is muted, and audio clips on the track are played through LUNA. When the transport is
recording, all Record enabled tracks are recorded to disk.
You can record-enable one or more selected tracks by pressing ShIft+R.
Input enabled
When an audio track is Input enabled, you can monitor the input to the track at all times, whether the transport is
stopped, playing, or recording. When an audio track is Input-enabled, the audio clips on the track do not play through
the LUNA mixer. When a track is both Record enabled and Input enabled, the track is monitored at all times, but the
track is recorded to disk when the transport is recording.
You can input enable one or more selected tracks by pressing Shift+T.
To record audio:
1. In the Tracks browser, click the plus (+) next to Create New Tracks.
2. From the Type drop menu, choose Audio. Choose the number of tracks to create, the format (Mono or Stereo),
and type a name for the track or tracks.
3. Click OK to create the tracks, or Cancel to stop track creation.
4. Connect a mic, line source, or Hi-Z instrument into an input on the UA audio interface.
5. On the audio track in the Focus channel or Mixer, click the Input mixer row. The Input browser opens.
6. Choose the input to which your source is connected.
7. Click the Record enable button in the track or Focus channel (Timeline view) or in the channel (Mixer view) or
press Shift+R to record enable the audio source.
8. If you want to use a Unison plug-in click the Unison insert and choose the plug-in.
9. Adjust the settings for the Unison plug-in. Some Unison plug-in settings can be adjusted from Apollo hardware.
All settings can be adjusted from the plug-in and LUNA channel controls.
10. To record with Record FX, insert up to four UAD plug-ins in the channel’s Record FX inserts.
11. Adjust the audio settings until the audio levels are correct. You want to record with enough headroom so the
recording track doesn’t clip.
12. Click the ARM button in Global Controls, or choose Transport > Accelerated Realtime Monitoring to enable ARM.
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13. Click Record and Play (Command+Spacebar) in the transport to record audio.
14. Click Stop or press the Spacebar to stop recording.
To listen back to the recording, press Play or the Spacebar.
Note: You can listen to the recorded track if the track is record-enabled, but not if the track is Input-enabled.
To record starting at a specific point on the timeline:
1. Switch to Timeline view.
2. Click on a location in the Timeline where you want to begin recording. Click above the center of an audio track,
or in any of the rulers.
3. To use Pre-roll (listen to the existing track for a specified period of time before you start recording), Option+click
to the left of the playhead on the Bars and Beats ruler.

4. Click the ARM button in Global Controls, or choose Transport > Accelerated Realtime Monitoring to enable ARM.
5. Record-enable track(s), and input-enable if necessary.
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6. Click Record and Play (Command+Spacebar).
7. Click Stop or the Spacebar to stop recording.
You can also move the playhead to a specific time by typing a time in the Counter field, and pressing Return. For
example, in Bars and Beats mode, type 122 to move the playhead to 122|0|000, or type 122|2 to move the playhead to
122|2|000.

To record in a selection on the timeline (punch-in recording):
1. Switch to Timeline view.
2. Click on a location in the Timeline where you want to begin recording, and drag to the right or the left to select
the range to record. Click and drag above the center of an audio track, or in any of the rulers.
3. To adjust the selection length, move the playhead to a position to the right or left of the center of the selection
and Shift+Click. Note that you can lengthen or shorten a selection with this method.
4. To use Pre-roll (listen to the existing track for a specified period of time before you start recording), Option+click
to the left of the playhead on the Bars and Beats ruler.

5. Click the ARM button in Global Controls, or choose Transport > Accelerated Realtime Monitoring to enable ARM.
6. Record-enable track(s), and input-enable if necessary.
7. Click Record and Play (Command+Spacebar).
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8. Click Stop or the Spacebar to stop recording.
You can also make a selection by typing a start time in the Start time field, and either a length in the Length field, or a
stop time in the End field, then pressing Enter. These fields are located to the right of the Transport. For example, in
Bars and Beats mode, type 122 in the start field and 8 in the Length field to select 8 bars from 122|1|000 to 130|1|000.

Stop recording and discard recorded files
To stop any in-progress recordings and immediately delete the audio or MIDI, press Command + Shift + .[period], or
select Transport > Discard Recording while recording. The session continues playback, but the audio or MIDI you are
recording is removed from the timeline and deleted from the session file.
When you discard a recording during loop recording, only the most recent take is removed from the timeline and
deleted from the session file. Files being recorded are moved to the macOS Trash. There is no undo for Discard
Recording.

Loop Playback and Recording
In loop playback/record mode, you play or record over a selection repeatedly. Use loop playback to audition a section
repeatedly, when editing or adjusting levels or plug-ins. Use loop recording to build up or replace a MIDI performance
with successive takes, or to record multiple takes on audio tracks. You can enable Loop by making a selection on any
ruler or in the timeline, or with the special-use Loop Ruler.
You can make a selection on the Loop ruler to continuously loop a section of the session, while making edits to audio or
MIDI data, without changing the original selection or moving the playhead. The Loop ruler appears in orange in
Timeline view at the top of the track area. A selection on the Loop ruler is only active when Loop Playback/Record is
enabled.

Loop Playback behavior
A selection on the Loop ruler continues to loop during playback. You can make selections on the Timeline, and edit
audio and MIDI tracks, and the Loop ruler continues to play the same loop. However, if you make a selection on the Bar
and Beats ruler, that selection overrides the Loop ruler selection. When you stop and start playback, playback starts
from the selection on the Loop ruler, unless the selection has been overridden by a selection on the Bars and beats
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ruler. When Link Edit/Play Selections is active, after the transport stops, playback starts from the timeline selection or
playhead location, even if there is a Loop ruler selection.

Loop Record behavior
A selection on the Loop ruler continues to loop during record. The selection continues to loop and record over that
selection, even if you make a different selection on the Bars and Beats ruler or in the timeline, until the transport stops.

To loop playback while editing audio or MIDI:
1. Disable Link Edit/Play selections on the Bars and Beats ruler.
2. Enable Loop Playback/Record on the Transport (Ctrl+L).
3. Select a range in the Loop ruler. This range indicates the start and end of the section to loop. You can click and
drag on either end of the loop selection to extend or shorten the selection.
4. Click Play on the Transport or press the Spacebar.
The section you selected plays back. While the looped selection is playing you can select, edit, copy, paste, or delete
data from any audio or Instrument tracks in the timeline, and make any other adjustment, without the loop stopping or
changing. When you complete edits for a section, you can click and drag the loop to a different position in the timeline,
or edit the length of the loop. Loop playback continues as you adjust the loop.
After you make changes to a loop, Loop playback resumes, based on the Update Playback setting.
Setting

Playback behavior after the loop changes

Transport > Update Playback > Instantly

Playback immediately restarts from the beginning of the new loop
selection.

Transport > Update Playback > At Next Bar

Playback continues to the end of the next bar, then restarts from
the beginning of the new loop selection.
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Transport > Update Playback > At Loop End

Playback continues to the end of the loop that was previously
defined, then restarts from the beginning of the new loop selection.

Loop recording and Versions and Takes
When you loop record, you replace a section of a track that you select with one or more recording passes, or “takes.”
When LUNA reaches the end of the selection, the transport returns back to the start of the selection, and records again.
Each loop record pass is saved as a Version labeled with a T (for Take). The first recording on a track is labeled with a V,
as are all other Versions created by adding or duplicating Versions. Takes are labeled with a T to indicate that they were
automatically created by the loop record process.To show recorded Versions and Takes, click the Versions button at the
top of the Tracks area.

Note: If the track height is too small to show the Versions list, the name of the current version appears in the Versions
area, and you can click on the name to open a list of Versions and perform Version operations.
A Take is not always a complete track. Therefore, when you switch from a Version to a Take, you will not see the entire
track, but only the section that was loop-recorded.

To loop record:
1. Make an audio selection and click the Loop Play / Record button or press Control+L.

2. Record your source.
3. Click the Versions icon to show track Versions.

4. To switch between Versions, click the Version.
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To assemble different clips together using Versions, see “Comping Tracks with Versions.”

Tracking multiple audio sources
Features for recording multiple audio sources in LUNA include:
•
•
•
•
•

Setting up audio tracks for multiple inputs at once by assigning cascading inputs.
Using cues to send a click and custom mixes to different groups of performers.
Easily copying the current mix to a cue bus.
Punch-in recording with multiple tracks.
Switching the transport in and out of record on the fly.

Configuring multiple tracks for recording
Use Cascade mode to route multiple inputs to audio tracks quickly.
To assign multiple inputs in order to tracks:
1. Select multiple tracks in the Timeline or Mixer.
2. Click the input on the first track you want to assign. The Input browser opens.
3. Next to Routing, click the ••• options menu and select Cascade.
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4. Click the first input you want to assign.
The remaining selected tracks are assigned the remaining inputs, in order.

Recording multiple inputs at once
To record on multiple inputs, use selection grouping to enable recording on multiple tracks. To enable selection
grouping, select Mixing > Selection Grouping (Command+G).

To record on multiple tracks:
1. In the Mixer or Timeline, select multiple tracks. All tracks you record enable must be assigned with unique
inputs.
2. Record-enable one track, either by clicking the record-enable button, or pressing Shift+R. All selected tracks will
be record-enabled.
3. Add Unison, Record FX, and standard insert plug-ins to the tracks if needed.
4. Adjust the audio settings until the audio levels are correct. You want to record with enough headroom so the
recording track doesn’t clip.
5. Click Record and Play (Command+Spacebar) in the transport to record audio.
6. Click Stop or press the Spacebar to stop recording.
You can make multiple input recordings with all of the same options as a single track recording, including Unison plugins, Record FX plug-ins, standard insert plug-ins, and buses, as DSP is available.
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Recording on multiple tracks
You can easily switch multiple tracks in and out of record mode while playing a session. Simply record enable the tracks
you want to record, and press the Record button on the transport to toggle in and out of record. Enable ARM mode to
do this seamlessly.

Using Console Tracking Mode
Console Tracking mode allows you to use Console for live channel inputs, and prevents LUNA from automatically
muting and unmuting console channels when recording. Essentially, all inputs remain live, and Console works as it
previously did, while LUNA is running.
In Console Tracking Mode, UAD plug‑ins do not persist in LUNA inputs as they normally do. Instead, when you recordenable a track in Console Tracking mode, the plug-ins assigned to the track in Console are loaded into the LUNA
channel.
Because you always hear the channels from Console in Console Tracking Mode, you do not need to use the Input enable
button on a track to monitor the audio source, as long as the source is not muted in Console. However, you still need to
record-enable tracks to record audio.
To enable Console Tracking Mode:
• From the LUNA app menu, choose Transport > Console Tracking Mode.

Making cue mixes
You can use up to four independent stereo Cue mixes in LUNA. You set Cue sources and assign Cue mixes to those
sources, to allow performers to listen to a different mix when recording. When a hardware output pair is set to Cue (in
the Cue Outputs popover), the cue source is the dedicated cue mix, determined by the settings on the Cue row in the
Mixer. In this mode, the mix of the cue bus is determined by the cue send controls in the session’s tracks.
Note: The number of available Cue mixes is determined by the connected UA audio interface hardware and the Cue Bus
Count value in LUNA Settings.
Cue sends are pre-fader by default, though they can be configured to be post-fader. When a Cue is pre-fader, changes to
levels, pan, mute and solo on the channel strip do not affect the Cue mix send for that channel.
Once you assign outputs to Cues (in the Cue Outputs popover), you can set channels as pre-fader in a Cue mix, and you
can use the compact or large Cue strips to set the level and pan for each track in the Cue mix, and to mute tracks in the
Cue mix. To simplify setting up a Cue mix, you can easily copy the levels and pan settings from your mix to one or more
Cue mixes.
Cues have a dedicated Level knob, mute and Pre-fader switch. When you expand a Cue row to Large view, the expanded
Cue channel has a more accurate fader and dedicated pan controls.
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To assign a Cue to an output:
1. Choose View > Section > Monitor.
2. Click the Cue Outputs button on the Monitor column. A list of devices and available Cue outputs appears on a
popover window. The left column displays connected devices, the right columns display available outputs for
each Cue, and each row displays the device’s current Cue output assignments.
3. If you want to make a custom mix for a Cue, deselect Mix in a column on the popover. When Mix is NOT
illuminated, you create a Cue mix using the channel strip Cue sends.

Recording Audio – 119

LUNA User Documentation v200731

To copy the main mix to a Cue:
1. In the Mixer, right-click or Control+click on an audio, Instrument, or bus track’s volume fader. The Copy Cue Mix
popover opens.
2. Select the Cue to which you want to copy the main mix.
Levels and panning for all track faders are copied to the selected Cue.

Punch-in recording with multiple tracks
You can easily punch-in record on multiple record-enabled tracks, with multiple performers. You can even recordenable input tracks while LUNA is playing or recording, which allows you to enter record mode for any input without
stopping the transport.
To prepare for punch-in recording:
• If you want to record at a specific point, move the playhead to the record location, or make a selection you want
to record over. Alternatively, you can play the song and punch in with the record button as needed.
• If you are not using Console Tracking Mode, make sure record-enabled tracks are not Input-enabled. This allows
performers to hear the recorded tracks until recording starts, and after recording stops, and hear live input while
recording.
• Set the system in ARM mode.
• Set a pre-roll for the performers. This allows the performers to play along to the music before the recording
starts.
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In this scenario, you can press Record and Play (Command+Spacebar) to record on multiple tracks. With the capabilities
of the LUNA recording engine, you can also easily play the song and have the performers play along, and punch them in
and out manually by pressing the Record button on the Transport to toggle recording on and off.
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Editing Audio and using the Editing Tool
Resizing and zooming the audio track
You can resize an audio track to simplify editing. At the top of the timeline tracks area, below the Rulers, click the Tracks
icon, and choose a new track height size.

This resizes all tracks to the new size.
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• To resize selected tracks with a key command, press Control+↑ to increase track heights, or Control+↓ to
decrease track heights.
• To resize all tracks with a key command, press Control+Option+↑ to increase track heights, or Control+Option+↓
to decrease track heights.
• To resize an individual track, hover over the lower edge of the Track controls area. A double arrow appears. Drag
up or down to resize.
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• To resize selected tracks with a key command, press Control+↑ to increase track heights, or Control+↓ to
decrease track heights.
• To expand a selection to the full available editing space, press the E key (if the system is not in MIDI Keyboard
Mode).
• To resize (zoom) the track horizontally, click the plus and minus buttons at the bottom of the Edit workspace (or
use the keyboard shortcuts Command+[ to zoom out, and Command+] to zoom in).
• On a trackpad, you can pinch in or out to zoom the timeline horizontally.
• With a mousewheel, you can hold the Option key and scroll to zoom horizontally.

To vertically zoom (increase or decrease the waveform size) on audio tracks:
Type Command+Option+[ to zoom out (decrease waveform size). Type Command+Option+] to zoom in (increase
waveform size).
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Zooming waveforms

Audio clips and fades
An audio clip is a self-contained section of audio that is either recorded, imported, pasted, or duplicated on an audio
track. Audio tracks can contain multiple clips, and clips can overlap or be combined or split.
You can edit audio with the Editing Tool and key commands.
When you hover the mouse cursor over an audio or MIDI clip, it becomes the Editing Tool. Where you place the cursor,
and what the editing context is, determines the Editing Tool behavior.

Making selections
• To select audio, hover your cursor above the vertical middle of the clip. The cursor changes to the Select Editing
Tool.

• Click and drag to the right or left to select an audio range. Selections conform to the Snap setting and grid.
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• To extend or shorten a selection, press Shift, then click the location to which you want to extend or shorten the
selection.
• To make a free selection when Snap is enabled, press Command, then make the selection.
• To select on multiple tracks, press Shift to select multiple tracks, then make your selection.
• To extend a selection you have already made to more tracks, press Shift, then click on the tracks you want to
add to the selection.

Moving a clip
To move a clip, hover at the top or in the lower half of a clip. The move tool appears. Click and drag the clip to a new
location. You can drag a clip on the same track, or to another track, if it is the same type (audio or MIDI). If you have
Snap enabled, the moved clip snaps to the grid. To move without snapping to the grid, press the Command key while
you drag.

When you move an audio clip, it can overlap an existing clip. You can see this overlapping and underlying area when
dragging the audio clip. When you play a section with overlapping clips, you only hear the topmost audio clip. If you
later move the clip again, any underlying clips that exist are revealed. If you fade or crossfade audio, the underlying
audio can be revealed or used in the fade or crossfade, depending on the length of the overlapping and underlying
audio clips.
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Snapping to the clip start time or the playhead
When you drag a clip to another track or on the same track, you can snap the clip to the original start time by pressing
the Control key while dragging, or at any time before you release the clip.
To snap the start of a clip to the playhead location, place your playhead, then Control+Click the clip.

Cutting, copying, and pasting audio
Cut audio to remove it from the timeline and place it on the clipboard, ready to be pasted. Copy audio to place it on the
clipboard without removing it from the timeline. Paste audio to place the contents of the clipboard on the timeline, at
the playhead.

Copying and pasting audio by dragging
To quickly copy a clip and drag it to a new location, Option+Click the clip and drag it to a new location. This “copy and
drag” operation retains the underlying audio structure.

Cutting audio
To cut audio, select the audio range or clip and press Command+X. The audio range or clip is cut, and placed on the
clipboard, ready to be pasted. When you cut audio, a gap is left in the audio file from which you cut. if you selected a
clip, the clip is removed from the timeline. Note that when you cut audio, you are cutting a representation of the audio,
but the cut is non-destructive, and the original audio file remains unchanged. You can trim the edges of a cut selection
to restore the portions of audio you have removed (see Trimming an audio clip).

Copying audio
To copy audio, select the audio range or clip and press Command+C. The audio is copied, and placed on the clipboard,
ready to be pasted.
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Pasting audio
To paste audio, place the playhead or make a selection, and press Command+V. Note that the full length of the cut or
copied selection is pasted, and the underlying audio and audio structure under the paste is not retained. For example, if
you paste an audio selection over other layered clips and crossfades, those elements are not restored if you later move,
cut, or delete the overlaying clip.
Tip: If you want to place an audio clip while retaining the underlying clip structure, Move the clip instead of pasting it, or
copy and paste by Option+Clicking and dragging the audio.

Duplicating audio
When you duplicate audio, you copy the audio selection or clip and immediately paste it starting at the end of the
current selection. Any existing audio is replaced. Duplicated audio, like pasted audio, does not retain the underlying clip
structure.
Press Command+D to duplicate audio.

Shifting audio
Shift editing allows you to edit audio and keep your arrangement flowing around your edits. For example, you can cut
or paste audio or MIDI, and have the audio on one or more tracks shift back or forward in time to accommodate the cut
or paste. You perform shift editing by pressing the Shift key with the modifier key (for example, Shift+V to shift-paste).
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Shift+X
Press Shift+X to cut the selection, and shift all the following audio or MIDI data to fill the space that is removed. You can
do this on a single track, multiple selected tracks, or all tracks.

Shift+V
Press Shift+V to paste a selection, and shift all the following audio or MIDI data to accommodate the pasted data. You
can do this on a single track, multiple selected tracks, or all tracks.

Shift+D
Press Shift+D to duplicate (copy and paste) the selection, and shift all the following audio or MIDI data to fill the space
that is removed. You can do this on a single track, multiple selected tracks, or all tracks.

Shift+I
Press Shift+I to insert space, and shift audio or MIDI data following your selection by the length of the selection. You can
do this on a single track, multiple selected tracks, or all tracks.

Shift+Delete
Press Shift+Delete to delete your selection and shift audio or MIDI data following your selection by the length of the
selection. You can do this on a single track, multiple selected tracks, or all tracks.

Trimming an audio clip
Hover the Editing Tool near the bottom at the start or end of a clip to trim the length of the clip. Click and drag to the
right from the start of the clip, or to the left from the end of the clip to trim its length. Note that trimming follows the
Snap settings, unless you hold the Command key while trimming.

Trim tool
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Trim in progress

Trimming a clip with key commands
You can use key commands to trim clips.
• Press A to trim from the start of a clip to the playhead or to the start of a selection.
• Press S to trim from the playhead or the end of a selection to the end of the clip.
• With a selection made, press Command+T to trim the clip and retain only the selection.
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Selecting within an audio clip
Hover just above the vertical center at the start or end of a clip to select. Note that this works anywhere in a clip, not just
at the start or end. Click and drag to select. Selections follow the Snap settings, unless you hold the Command key while
selecting.

Tool appearance
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Selection made

Moving or copying an audio clip
When you hover near the vertical and horizontal center, the cursor changes to the move/copy Crosshair Arrows Editing
Tool. Drag the clip to a new location or a different track. Note that selections snap to the Snap settings, unless you hold
the Command key while dragging.
Option+Click to create a copy of the clip that you can then drag to a new location or track.

Reversing Audio
To hear one or more audio clips play backwards, select clips on one or more tracks, then right-click on a selected clip
and select Reverse from the contextual menu. The selected audio is reversed, and new clips with _RVRS appended to
the clip names are created, replacing the original clips.
You can only reverse whole clips. If you want to reverse a selection, Separate the selection first (Command+E or Edit >
Separate Selection).
Tip: To reverse audio with a trackpad instead of a mouse, click the trackpad with two fingers and select Reverse.
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Navigating between clip transients
An audio transient is a loud, quick sound at the beginning of a waveform. You can use transients to find audio start
points. For example, the start of a beat on a drum track, the start of a picked note on a guitar tracks, or the start of a
phrase on a vocal track. In LUNA, you can navigate between transients using key commands. Navigating between
transients works on a single track or multiple tracks. Note that with many tracks selected, navigating between
transients can move the playhead very slowly, as there are many more transients.
•
•
•
•

Press Tab to move to the next transient.
Press Option+Tab to move to the previous transient.
Press Shift+Tab to select to the next transient.
Press Shift+Option+Tab to select to the previous transient.
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Navigating between bars
You can move the playhead between bars with key commands.
• Press ] or 2 on the Numeric Keypad to move the playhead one bar to the right.
• Press [ or 1 on the Numeric Keypad to move the playhead one bar to the left.
• Add the Shift key to extend the selection when navigating between bars.

Separating audio clips
You can separate audio clips to create two or more audio clips from an existing clip.
• Separate an audio clip at the playhead with the menu command Edit > Separate Selection, or Command+E.
• Separate a selection on the current grid with the menu command Edit > Separate on Grid.
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Healing (recombining) separated clips
After you separate clips, you can press Command+H or choose Edit > Heal Separation to recombine separated clips. The
Heal Separation command works on two or more clips. Separated clips can only be recombined if the clips are arranged
as they were originally. If you have rearranged clips, Heal Separation does not work. If you have made changes to
separated clips with warps, clip gain, or clip pitch, those changes are discarded when the clips are healed. With clips
you have rearranged that you want to combine, Consolidate clips.
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Consolidating audio clips
You can combine two or more selected clips together by consolidating clips. You can also consolidate clips with spaces
between them. When you consolidate such files, LUNA adds silence for the length of the space in the consolidated audio
file.
• To consolidate, select one or more clips, and choose the menu item Edit > Consolidate, or Option+Shift+3.
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Working with fades on audio clips with the Editing Tool
Hover near the top at the start or end of an audio clip to show the Fade Editing Tool.

Creating a fade
Click and drag to the right from the beginning of the clip or to the left from the end of the clip to create a fade in or out.
Fades follow the snap settings, unless you hold the Command key while dragging.
Note: When you trim a clip that has a fade applied, the original fade length is preserved.
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Editing the length of a fade
Hover over the fade boundary marker. The Fade Editing Tool appears. You can click and drag a fade to change its
length. Fade length adjustments follow the snap settings, unless you click the Command key while dragging.

Editing the slope of an audio fade
Hover over the fade slope adjust point at the center of the fade. The Fade Slope Editing Tool appears, indicating you can
adjust the fade slope.
Click and drag with the Fade Slope Editing Tool to adjust the fade slope. Drag up or down to adjust the slope of the fade
to be more or less gradual. Drag towards the clip boundary or fade boundary to change how quickly the fade slopes in
or out. Option+Click on a fade to reset to the original fade.

Right-click or Control+Click on a Fade to switch between Equal Power and Equal Gain mode.
Tip: Equal Power is a logarithmic fade, where equal gain is a linear fade. These options are not critical for fading in and
out, because you can easily adjust the fade shape manually.
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Crossfading between audio clips with the Editing Tool
To see the Crossfade Editing Tool, hover your cursor over the vertical center of the boundary where two clips meet, or
on the vertical center of the edge of one clip if you are crossfading across a gap. Crossfades can be created between
material where two clips meet. In addition, if there is sufficient material to the right of the left clip, and to the left of the
right clip, crossfades can be created across a gap. Such a crossfade reveals trimmed audio to accommodate the
crossfade. It is also possible to create a crossfade where only one of the two clips has material. In this case, the
crossfade is adjusted to accommodate the clip that does not have material available. You can adjust the start, end, and
center point of the crossfade after the crossfade is created, and you can adjust the crossfade slope.

Crossfade tool at clip boundary

Crossfade tool at clip edge (crossfading across a gap)
Drag the crossfade tool across the clip boundary or across the gap to crossfade between the clips. Crossfade
adjustments follow the snap settings, unless you click the Command key while dragging.
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To adjust where the crossfade is centered, click and drag from the crossfade slope adjust point. Option+Click the
crossfade slope adjust point to reset the crossfade to default.

To lengthen or shorten one end of an existing crossfade, hover your cursor over an edge of the crossfade. The crossfade
boundary markers (white inverted triangles) appear at the upper edge of each side of the crossfade. Click the marker
you want to adjust. The hand cursor appears. Drag to shorten or lengthen a crossfade edge.

To move or delete a crossfade, click in the lower half of the crossfade to select the crossfade. Drag the crossfade to
move it. Note that you can only drag a crossfade as long as there is audio material underlying the fade being crossfaded.
Crossfades snap to the Snap settings. To move the crossfade freely when Snap is enabled, click the Command key while
dragging.
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To delete a crossfade, click in the lower half of the crossfade to select the crossfade, then press the Delete key.
To switch Equal Power and Equal Gain mode for the crossfade, Right-click or Control+click in the center of the
crossfade, and choose the mode.
Tip: Equal Gain is the default mode, and is recommended for phase-coherent material, for example when fading
between clips from the same guitar track or drum track. Equal Power mode works better for material that is less similar,
dissimilar, or not phase-coherent, for example two different vocalists or two different guitar recordings.
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Playing a Virtual Instrument and Recording MIDI
Instrument Track overview
An Instrument track can combine a LUNA Instrument or Audio Unit instrument plug-in and MIDI data. You can record
MIDI on an Instrument track. An Instrument track can record MIDI data alone with no audio or Instrument plug-in. LUNA
uses a MIDI resolution of 960 pulses-per-quarter note (PPQ or PPQN).

Creating an Instrument track
You record MIDI data, instantiate LUNA Instruments, and use other instrument plug-ins on an Instrument track.
Tip: To instantly create a stereo Instrument track with Shape instantiated, choose Track > New Instrument, or press
Shift+Command+I.

To create an Instrument track:
1. In the Tracks browser, click the plus (+) next to Tracks and choose Instrument from the contextual menu. If the
Create New Tracks dialog is already open, choose Instrument from the Type drop menu.
2. Type the number of tracks to create, choose the format (Mono or Stereo), and type a name for the track or
tracks.
3. From the INST drop menu, choose a LUNA Instrument, an Audio Unit instrument plug-in, or choose None to
record MIDI alone or to use an external MIDI instrument.
4. Click OK to create the tracks, or Cancel to stop track creation.
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Choosing a MIDI controller
LUNA will accept MIDI input from all MIDI devices that are recognized by the macOS Audio MIDI Setup app. If you have
multiple MIDI devices, you can choose which MIDI input the instrument track will use to trigger the instrument.
On an Instrument track in the Mixer or on an Instrument track Focused in the Timeline, click the MIDI In row, and choose
the MIDI Input to use for the instrument. Press Esc or click the close button to close the MIDI In browser.
Note: A track that is Input enabled responds to an assigned MIDI controller only when the track is selected. However,
record-enabled tracks respond to assigned MIDI controllers when the tracks are not selected.

Using MIDI Keyboard Mode to input MIDI
If you don’t have an external MIDI controller, or you prefer to use the computer keyboard to input MIDI notes, you can
use MIDI Keyboard Mode. MIDI Keyboard Mode maps MIDI notes (1-⅓ octave from C to E) to keys on the computer
keyboard, which you can use to perform MIDI recording.

Playing a Virtual Instrument and Recording MIDI – 145

LUNA User Documentation v200731

When you enable MIDI Keyboard Mode, you can enter MIDI notes when monitoring or recording by pressing keys on the
computer keyboard. MIDI Keyboard Mode provides the ability to change the octave of the keyboard and to set a velocity
level for MIDI notes you input with the computer keyboard.
Note: Any single-key commands that use one of the notes on the MIDI keyboard will not work when MIDI Keyboard
Mode is enabled. For example, “E” (Frame Selection) and “F” (Create a Fade) are not supported when MIDI Keyboard
Mode is enabled. When available, use the modifier-key version of such a key command (for example, Command+F to
create a fade). There is no modifier key for the “E” command.
To enable or disable MIDI Keyboard Mode:
• Press Option+Command+M, or
• Choose View > MIDI Keyboard Mode, or
• Click the MIDI icon under Workflows at the top of the screen to enable the MIDI Workflow, then toggle MIDI
Keyboard Mode (for more information about workflows, see “Using Workflows”).

To play notes with MIDI Keyboard Mode:
• Press the keys as indicated in the MIDI Keyboard map in the workflow bar at the top of the screen.
• To change the octave over which the keys send MIDI notes, press Z on the computer keyboard to lower the range
one octave. Press X to raise the range one octave. You can also click the Up and Down arrows under Octave in
the Workflow area at the top of the screen.
• To set the MIDI Note velocity that each key press sends, press C on the computer keyboard to decrease the
velocity, or D to increase the velocity. You can also click the Up and Down arrows under Velocity in the Workflow
area at the top of the screen, to raise or lower the velocity one step at a time.
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MIDI Merge or MIDI Replace
Before you record, decide whether you want to use MIDI Merge or MIDI Replace.
• With MIDI Merge (select Transport > MIDI Merge or 9 on the Numeric Keypad), the MIDI notes you play are
combined with the existing notes over which you record. MIDI Merge is useful, for example, if you want to build
up a track like a drum part by playing in separate drums on successive record passes.
• With MIDI Replace (deselect Transport > MIDI Merge or 9 on the Numeric Keypad), the MIDI notes you play
replace those in the selection over which you record. MIDI Replace is useful when you want to correct a part, or
play a part differently, without keeping the previous part.

Recording on an Instrument track
When you record on an Instrument track, ARM mode is not required to get the fastest response from LUNA Instruments
or third-party Audio Unit instruments, because the buffer is the same in both cases. However, if you use UAD plug-ins to
process audio on the Instrument track or on a bus, you should enable ARM mode to get the lowest possible latency. In
ARM mode, you cannot use Audio Unit insert effect plug-ins on any record-enabled track.

To record on an instrument track:
1. In the Tracks browser, click the plus (+) next to Tracks and choose Instrument. If the Create New Tracks dialog is
open, from the Type drop menu, choose Instrument.
2. Type the number of tracks to create, choose the format (Mono or Stereo), and type a name for the track or
tracks.
3. From the INST drop menu, choose a LUNA Instrument, an Audio Unit instrument plug-in, or choose None to
record MIDI alone.
4. Click OK to create the tracks, or Cancel to stop track creation.
5. In the Focus channel or Mixer, click the Input mixer row. The Input browser opens.
6. Choose the MIDI input to which your controller is connected. MIDI devices recognized in the macOS Audio MIDI
Setup app are available here. You can also play and record MIDI notes using the computer keyboard. Select View
> MIDI Keyboard Mode from the menus, or press Option+Command+M to use the computer keyboard to input
MIDI notes with the keyboard.
7. Click the Input enable button (Shift+T) or click the Record enable button (Shift+R) on the track or Focus channel
(Timeline view) or on the channel (Mixer view). Input-enabling a track allows you to monitor the Instrument or
audio source when the Instrument, plug-in, or device is triggered with the MIDI Input source. Record-enabling a
track allows you to record MIDI data to the Instrument track, when you click Play and Record on the transport, or
press Command+Spacebar.
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8. If you are using UAD plug-ins in the Record FX or standard inserts on the Instrument track, enable ARM mode for
the lowest possible latency.
9. Choose whether to use MIDI Merge or MIDI Replace.
10. Click Record and Play on the transport or Command+Spacebar to record MIDI.
11. Click Stop or press the Spacebar to stop recording.
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Recording MIDI and playing back audio from an external MIDI
instrument
You can record MIDI from an external MIDI instrument, while monitoring the audio from that device or another device.
By sending the MIDI output from an Instrument track to an external MIDI hardware device, for example a synth or a
drum module, you can monitor or record the audio from this device on an available audio input.

To trigger and record MIDI and monitor or record audio from a MIDI sound
generator:
With this task, you send MIDI data from an Instrument track to an external MIDI device, and monitor or record the audio
output from that device on a separate audio track. Use this task to record a synth or sound module to an audio track,
while retaining the ability to edit the original MIDI performance data.
Before you do this task, create a mono or stereo audio track, and connect the synth or sound module to an Apollo
hardware input or stereo input pair.
1. In the Tracks browser, Timeline, or Mixer, select the Instrument track on which you have recorded MIDI.
2. In the Mixer channel or Focus channel for the track, click the MIDI Out mixer row. The MIDI Out browser opens.
3. Choose the MIDI Output to which you want to send MIDI data. MIDI devices recognized in the macOS Audio MIDI
Setup app are available here, as are all Instrument tracks in your session. Choose the MIDI device that you have
connected as the audio generator.
4. On the audio track, click on the Input slot, then from the Input browser, choose the Apollo hardware input or
stereo input pair to which the device is connected.
5. Press the Input-enable button (Shift+T) to monitor the audio source when the instrument is triggered with the
MIDI output.
6. Press the Record-enable button (Shift+R) on the Instrument track to record MIDI data. Press the Record-enable
button (Shift+R) on the audio track to enable audio recording.
7. If you are using UAD plug-ins in the Record FX or standard inserts on the Instrument track, enable ARM mode for
the lowest possible latency.
8. Select the range you want to record, or place the playhead where you want to start recording.
9. Press Record then Play (Command + Spacebar).
Audio generated by the synth or sound module is recorded to the audio track and the MIDI source data is recorded to
the Instrument track.
Note: If the external MIDI controller is the same device as the MIDI sound generator (if it’s a MIDI keyboard controller
with built-in sounds), be sure to disable the MIDI keyboard’s “MIDI Local Control” setting to prevent doubled MIDI
notes.

Playing back an Instrument track
To play back an Instrument track:
• Place the playhead or make a selection, and press Play on the transport, or press the Spacebar.
• MIDI notes, program changes, and continuous controllers (CCs) are played from the playhead, even if the
playhead starts after the MIDI events occur. Like audio and track automation, MIDI data values at the current
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play position are played correctly. This type of MIDI playback is called MIDI Chase, Note Chasing, or MIDI Note
Chasing.

Overdubbing and Looping on an Instrument track
You can overdub directly on a MIDI clip, starting wherever you place the playhead, or in a range that you select. You also
have the option to loop record, which creates separate Versions (which are labeled as Takes when loop recording) for
each complete loop recording pass.
Before you record, decide whether you want to use MIDI Merge or MIDI Replace.
• With MIDI Merge (select Transport > MIDI Merge), the MIDI notes you play are combined with the existing notes
over which you record. MIDI Merge is useful, for example, if you want to build up a track like a drum part by
playing in separate drums on successive record passes.
• With MIDI Replace (deselect Transport > MIDI Merge), the MIDI notes you play replace those in the selection over
which you record. MIDI Replace is useful when you want to correct a part, or play a part differently, without
keeping the previous part.

To record over existing MIDI without a selection:
1. Click within the track or in a ruler above the tracks to place the playhead where you want to start recording.

2. To use Pre-roll (listen to the existing track for a specified period of time before you start recording), Option+click
to the left of the playhead on the Bars and Beats ruler.
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3. Record-enable the MIDI track.
4. Press Record then Play (Command+Spacebar), and begin playing. MIDI records from the playhead. If you set a
pre-roll amount, the system plays the pre-roll section before recording starts.
5. Click Stop or press the Spacebar to stop recording.

To record over a MIDI selection:
1. Hovering the cursor over the bottom solid-colored border of the audio clip, click and drag to make a selection.
The selection snaps to the grid, if Snap is enabled.

2. To use Pre-roll (listen to the existing track for a specified period of time before you start recording) Option+Click
to the left of the playhead on the Bars and Beats ruler. To set post-roll, Option+Click to the right of the selection
on the Bars and Beats ruler.

Playing a Virtual Instrument and Recording MIDI – 151

LUNA User Documentation v200731

3. Record-enable the track.
4. Press Record then Play (Command+Spacebar), and play your MIDI controller or the computer keyboard. MIDI
records from the start of the selection, and stops recording at the end of the selection. If you set a pre-roll
amount, the system plays the pre-roll selection before recording starts. If you set a post-roll amount, the system
plays the post-roll selection after recording completes.

The MIDI you record is either merged with the existing MIDI, or replaces it, depending on whether MIDI Merge is enabled.

Loop recording MIDI
When you loop record, you either replace a section of a track that you select with one or more recorded takes, or you
record multiple merged passes. When LUNA reaches the end of the selection, the transport returns back to the start of
the selection, and records again. Each complete record pass is saved as a Take. To show recorded Takes, click the
Versions button at the top of the Tracks area.
On a MIDI track, takes are separate from track versions. You can switch between Takes of one clip, and the selected
track version and any other clips associated with it remain.

To loop record (with MIDI Merge):
1. Select Transport > MIDI Merge.
2. Make a MIDI selection and click the Loop Play / Record button.

3. Record your source. As the loop plays, you can record additional notes with each pass.
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4. To switch between Versions or Takes, click the Version or Take.

To loop record (with MIDI Replace):
1. Deselect Transport > MIDI Merge.
2. Make a MIDI selection and click the Loop Play / Record button.

3. Record your source. As the loop plays, you replace the previous recording with each pass.
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4. To switch between Versions and Takes, click the Version or Take.
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Working with MIDI on Instrument Tracks
Editing MIDI
MIDI has some special editing functions because you can work with MIDI both as clips and as individual notes. Clips can
be edited, copied and moved as individual objects that contain groups of notes. In Notes view, there are additional
note-level selection and editing features.

Working with clips on a MIDI track
The two main editing views on a MIDI (Instrument) track are Clips and Notes.
Note: For clip editing functions (except for making selections), Clips and Notes view behave the same, so Notes view is
used for some examples in this section.

Selecting MIDI in Clips view
To select a clip, click near the vertical top or bottom of the clip.
Note: In Notes view, you can only select a MIDI clip from the top of the clip.

To select a range in a MIDI clip, hover your mouse above the vertical middle of the clip. The selection cursor appears.
Click and drag to the left or right to make a selection.

Renaming a MIDI clip
Double-click in the top bar of a MIDI clip anywhere except on the CC view or Quantize button to rename the MIDI clip. A
popover opens. Type the new clip name, then click Done.
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Moving MIDI clips
To move a clip, hover at the top of the clip. The move tool appears. Click and drag the clip to a new location. You can
drag a clip on the same track, or to another track, if it is the same type (audio or MIDI). If you have Snap enabled, the
moved clip snaps to the grid. To move without snapping to the grid, press the Command key while you drag.
When you move a MIDI clip, it can overlap an existing clip. You can see the overlapping area when dragging the clip. The
overlapping MIDI area is played, while any underlying notes are not. If you later move the clip again, any underlying
clips that exist are revealed.

Trimming MIDI clips
Trim a MIDI clip to either make it smaller or to extend the MIDI clip. This is useful because if you want to add more MIDI
notes before or after an existing passage, you must extend the MIDI clip to contain that data. Alternatively, you can
shorten a MIDI clip to hide notes at the beginning or end of a clip. Those notes are still available if you later trim the MIDI
clip out to show them.
To trim a MIDI clip:
• Hover near the bottom at the start or end of a MIDI clip. The Trim Editing Tool appears.
• Click and drag to shorten or lengthen the MIDI clip.
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MIDI clip showing Trim Editing Tool

MIDI clip extended with Trim Editing Tool

Resizing the MIDI track
Before you add and edit MIDI notes, or cut, copy or paste MIDI data, you will likely want to resize the MIDI track. There
are several ways to do this.
• At the top of the Edit workspace, click the Tracks icon, and choose a new track height size. This resizes all tracks
to the new size.
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• Drag up or down from the lower edge of the Track controls area to resize the track.This resizes just one track.
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• To expand the track to the full available editing space, press the E key.
• To resize the track horizontally, click the plus and minus buttons at the bottom of the Edit workspace (or use the
keyboard shortcuts Command+[ to zoom out, and Command+] to zoom in). With a mousewheel or trackpad, you
can hold the Option key and scroll to zoom horizontally. You can pinch to zoom in or out on a trackpad.

Showing MIDI notes
You can vertically resize the MIDI notes on an Instrument track to make them easier to edit and work with.
To do this, set the Instrument track to MIDI Notes view. On the Instrument track, click where it says Show, and from the
View browser, choose Notes. The Show area on the Instrument track indicates that you are in Notes view, and the
keyboard and piano roll appear to the right of the track controls.
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At the left of the MIDI track is a scroll bar. You can use the scroll bar to move up and down in the piano roll, and to resize
the notes in the piano roll vertically.

To resize the MIDI notes on the piano roll:
•
•
•
•
•

Click and drag up or down at the top or bottom of the scroll bar.
Drag up to make notes smaller vertically.
Drag down to make notes larger vertically.
Click Fold at the top of the Notes view keyboard to show only the notes used on the clip, with note names.
Click Fit at the bottom the Note view keyboard to fit the range of notes on the piano roll to the height of the
track.
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Selecting MIDI notes
There are several ways to select multiple MIDI notes:
• Click and drag a selection rectangle around the notes (rubber banding).
• Shift+Click on multiple notes. You can select contiguous or non-contiguous notes.
• Click a note on the Notes view keyboard at the left edge of the track to select all instances of that note. This
selects all notes on the track, not just in a clip.
• Shift+Click different notes on the Notes view keyboard at the left edge of the track to select all instances of
multiple notes.
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Select with a selection rectangle

Shift-click to select multiple contiguous or non-contiguous notes
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Select from the Notes view keyboard

Cutting, copying, and pasting MIDI notes
Cutting, copying, and pasting MIDI works differently from editing audio, because you can select non-contiguous MIDI
notes, and the paste operation respects the structure of the cut or copied data. If you paste within an existing clip, the
notes are pasted within the boundaries of the clip. If you paste MIDI notes on the timeline outside a MIDI clip, a new MIDI
clip is created.
MIDI notes are selected, cut, copied, and pasted with the same time relationships and durations as the selection. MIDI
selections conform to the grid if Snap is enabled.
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To cut and paste MIDI notes:
1. Select MIDI notes to cut. You can select a range with the Select Editing Tool, draw a selection with the selection
rectangle, select contiguous or non-contiguous notes by shift-clicking individual notes, or select specific notes
from the Notes View Keyboard.
2. Press Command+X or X (if MIDI Keyboard Mode is not enabled) to cut notes. The MIDI notes are removed from
the clip and copied to the clipboard.
3. Place the playhead at a location in the Timeline or in another MIDI clip and paste the MIDI notes with
Command+V or V (if MIDI Keyboard Mode is not enabled).
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To copy and paste MIDI notes:
1. Select MIDI notes to copy. You can select a range with the Select Editing Tool, draw a selection with the selection
rectangle, select contiguous or non-contiguous notes by shift-clicking individual notes, or select specific notes
from the Notes View Keyboard.
2. Press Command+C or C (if MIDI Keyboard Mode is not enabled) to copy notes. The MIDI notes are copied to the
clipboard.
3. Place the playhead at a location in the Timeline or in another MIDI clip and paste the MIDI notes with
Command+V or V (if MIDI Keyboard Mode is not enabled)

Shift-editing MIDI clips
The shift workflow allows you to edit MIDI and keep your arrangement flowing around your edits. For example, you can
cut or paste MIDI, and have the MIDI clips on one or more tracks shift back or forward in time to accommodate the cut
or paste.
Note: The Shift-editing workflow works only with a time selection on a clip (for example, a whole clip, or a selection
made with the Select Editing Tool). You cannot Shift edit with single notes, rectangular selections, non-contiguous
notes, or note selections made with the Notes View Keyboard.
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Shift+X
Use Shift+X to cut the selection to the clipboard, and shift all the following MIDI data to fill the space that is removed.
You can do this on a single track, multiple selected tracks, or all tracks.
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Shift+V
Use Shift+V to paste a selection, and shift all the following MIDI data to accommodate the pasted data. You can do this
on a single track, multiple selected tracks, or all tracks.

Shift+D
Use Shift+D to duplicate (copy and paste) the selection, and shift all the following MIDI data to fill the space that is
removed. You can do this on a single track, multiple selected tracks, or all tracks.

Shift+I
Use Shift+I to insert space, and shift MIDI data following your selection by the length of the selection. You can do this on
a single track, multiple selected tracks, or all tracks.

Shift+Delete
Shift+Delete deletes the selection, and shifts all the following MIDI data to fill the removed space.

Editing MIDI with the Editing Tool
You can record MIDI from a MIDI controller to an Instrument track, and you can add or edit MIDI notes and controller
values with MIDI on an Instrument track manually, using the Editing Tool. Set the Grid settings to specify the default
note length. When you add a MIDI note, the default note length is the Grid setting. Notes you add snap to the grid if
Snap is enabled.

Adding and Editing MIDI notes on an Instrument track
To work with notes in a MIDI clip or on an Instrument track, click View on the track, and choose Notes in the Browser to
set the track to MIDI Notes view.
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To add a MIDI note to an Instrument track:
• Hover over a note location. The MIDI Note Editing Tool (a plus symbol) appears. Double-click on the location
where you want to add the note. The note is added.

• To add multiple notes, press Control and click and drag from left to right across the track. The MIDI Pencil
Editing Tool appears and draws notes across the track. MIDI notes of the duration determined by the Grid size
are added, on the pitch where you release the click.

• To delete a MIDI note, hover over the note. The MIDI Hand Editing Tool appears. Double-click the note to delete
it.
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To move a MIDI note:
• Hover over the note. The MIDI Hand Editing Tool appears. Click on the note and drag it up or down to change the
MIDI note, and left or right to change the time location. As you move the note up and down, the different notes
are triggered on the Instrument plug-in. MIDI notes will snap to the grid if Snap is enabled.
To trim a MIDI note:
• Hover near the edge of a MIDI note. The MIDI Trim Editing Tool appears. Click on the left or right edge of the note
and drag to trim the note. MIDI note edges will snap to the grid if Snap is enabled. To ignore the Grid when
trimming, press Command after you start to trim.

To change the velocity of a MIDI note, do one of the following:
• Press Command and hover over a note. The MIDI Velocity Editing Tool appears. Command+Click on the note and
drag up or down to increase or decrease the note velocity. The relative transparency of the note indicates the
velocity. Notes become less opaque and more transparent as velocity decreases, and more opaque and less
transparent as velocity increases.
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• Show the MIDI CC sliders (set to Velocity by default), and click and drag on a velocity stalk to edit velocity for a
note. You can click the note to highlight the note’s velocity stalk. If you select multiple notes, Option+Click and
drag to edit multiple velocity stalks. Shift-click to select multiple velocity stalks.

To show the MIDI CC track for an Instrument track:
• Click the MIDI CC icon at the top of the track, next to the track name.

Working with MIDI on Instrument Tracks – 172

LUNA User Documentation v200731

To edit the velocity of a MIDI note on the velocity track:
• Click on the velocity stalk and drag it up or down.
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To edit the velocity for multiple MIDI notes:
1. Select multiple notes on the timeline, or select multiple velocity stalks on the velocity track. Shift-click to select
multiple non-contiguous velocity stalks.
2. Option+Click on a note velocity stalk and drag up or down. All selected note velocities are adjusted relative to
each other.

To draw MIDI note velocities:
1. Press Control on the velocity track. The cursor changes to a pencil.
2. Draw velocities across the velocity track. Note that if you have made a selection, you can only draw velocities on
selected notes.
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Transposing MIDI notes
•
•
•
•

To transpose one or more selected MIDI notes up one semitone, press ↑.
To transpose one or more selected MIDI notes down one semitone, press ↓.
To transpose one or more selected MIDI notes up an octave, press Shift+↑.
To transpose one or more selected MIDI notes down an octave, press Shift+↓.
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Quantizing MIDI notes
You can quantize MIDI notes, selections, or clips to any grid increment, and add swing.
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The following parameters are supported.
Setting

Description

Grid

Quantize notes to the selected Grid setting, from /1 (whole notes, to /64 (64th
notes). You can also select Dotted values, Triplet values, or both.

Follow Snap Setting

Quantize notes to the Snap Grid setting.

Swing

Shifts every other Grid boundary by the percentage specified, from 0-100. Swing of
0% does not shift notes, while 100% swing shifts 2/3 of the way to the next grid line.

Strength

Set the strength at which the quantize settings are applied. At 50%, notes are
quantized halfway from their position to the grid. At 100%, notes are fully quantized
to the grid.

Auto Apply

Auto Apply to adjust the quantize settings and see and hear the results in real time.
If Auto Apply is not set, you must click Quantize to see and hear the quantize results.

To quantize MIDI notes:
1. Select a MIDI note or notes, or a MIDI clip.
2. Press the Q at the top of the track header to open the Quantize panel, or type Shift+Command+U.
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3. To preview your Quantize choices in real time, select Auto Apply.
4. Choose a grid value to which to quantize notes. You can select from 64th notes to whole notes, and dotted or
triplet modifiers.
5. To follow the Snap grid setting, click Follow Snap Setting.
6. To adjust the amount of swing from 0 to 100%, move the Swing slider.
7. To adjust quantize strength, move the Strength slider from 0 to 100%.
8. Click Quantize to apply your settings.
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Editing MIDI Continuous Controllers
You can show MIDI Continuous Controller (CC) lanes and edit automation.
To show MIDI Continuous Controllers, click the MIDI CC button on a MIDI clip.

By default, MIDI CC view shows Velocity and the velocity sliders.

To show a MIDI CC controller lane:
1. Click the MIDI CC button on the MIDI clip.
2. Click on the Velocity button on the track control area to open the MIDI CC browser. The MIDI CC browser lists all
the MIDI CCs.
3. Choose a MIDI CC controller. The automation lane for the controller is displayed.
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To write automation for a CC, see “To write MIDI CC automation.”
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Working with Audio in the Timeline
Track Follows Modes: Time and Tempo
Audio tracks can be in one of two Track Follows modes: Time or Tempo.
• A track in Track Follows Time mode maintains its original playback time, regardless of changes in the tempo of
the session. All audio clips on the track, and elements associated with those clips, maintain their original time
duration, including start and end points, edits, fades, and automation.
• A track in Track Follows Tempo mode adjusts to the tempo of the session and any session tempo changes. An
audio clip that is configured in Track Follows Tempo mode will adjust shorter or longer, if the session tempo is
adjusted. All audio clips on the track, and elements associated with those clips, scale to the new tempo. Clip
start and end points, duration, edits, fades, and automation all scale to the new tempo.

Track Follows Time mode

Track Follows Tempo mode

Default for imported audio files that have no embedded
tempo value, and audio tracks created as a result of AAF
import.

Default for all newly created audio tracks and
imported audio files that have an embedded tempo
value.

Clips start and end on a time value.

Clips start and end on a tick value.

Fade ins start on a time value at the clip start, and end on a
tick value relative to the clip start time. Fade outs start on a
tick value relative to the clip end, and stop in time at the
clip end.

Fades start and end on a tick value relative to the clip
start and end.

Automation breakpoints are stored at time values.

Automation breakpoints are stored at tick values.

When an element is saved on a time value, its position
remains fixed in time no matter what happens with the
tempo. Tempo changes cause the element to move and
change duration visually, though the sound of the element
doesn’t change. The time it takes to play events does not
change, but the start point and visual duration on the
timeline moves relative to the tempo map.

When an element is saved on a tick value its position
remains fixed to a position in the tempo map.
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Changing an audio track from Track Follows Tempo to Track Follows Time mode
Changing an audio track from Track Follows Tempo to Track Follows Time mode will not change the duration of the
clips on the track. If the clip has been previously time-stretched or time-compressed by a tempo change, the clip will
not revert to its original duration. When you change the clip mode from Track Follows Tempo to Track Follows Time,
two markers are added at the start and end of the clip, to mark the exact tick-based start and end of the clip. The clip
will still move in time so that the start of the clip stays in the same relative spot, but the duration of the clip will no
longer change with tempo changes.

Changing an audio track from Track Follows Time to Track Follows Tempo mode
When you change an audio track from Track Follows Time to Track Follows Tempo mode, the duration of the clips on
the track does not immediately change. However, the clips on the track are now “anchored” to the ticks at which they
are currently located. Any tempo change to the session or on the Timeline that affects a clip will time stretch or time
compress the clip. Session tempo changes also affect fades, crossfades, edits, and automation breakpoints on the
audio track, and such fades, crossfades, edits, and automation breakpoints are stretched or compressed with tempo
changes.
Restoring a time-stretched or compressed clip to its original duration
To restore a clip to its original duration and remove any warping, double-click the top of clip, and in the Clips window,
click Reset Warps.
Workflow: Changing the tempo of a song and conforming audio and Instrument tracks
The typical situation for this workflow is one where you have recorded some or all of the session tracks, and decide to
change the tempo of the session to change the feel, for creative or other reasons.
To change session tempo, you’ll need to configure your audio tracks to follow the tempo, and configure the Warp
algorithm for the different types of tracks.
Recommended warp algorithms
As a starting point, the following warp algorithms are recommended:
• LUNA Razor Blade for drum loops and multitrack drum tracks. LUNA Razor Blade will maintain the best phase
coherence and the most accurate transients and tails for time-stretched or time-compressed drum tracks,
though with extreme stretching or compressing, audio artifacts can occur.
• LUNA Polyphonic or Polyphonic for polyphonic material, instruments, and vocals.
• Monophonic for vocals or single-note lines. For example, a bass line or a monosynth without complex overtones
might sound better with the Monophonic algorithm than the Polyphonic algorithm.
You can easily change Warp algorithms while material plays to audition different algorithms.
Note: You can apply Warp algorithms to a track and/or individually to audio clips. You can also apply different
algorithms to different clips on the same track.
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To configure audio tracks for tempo changes or warping:
1. In the Timeline, select all audio tracks, click the Mode control on the track controls, then choose Tempo from the
Track Follows Mode popover menu.

2. For each audio track or group of audio tracks, click the Warp control on the track controls, then choose an
algorithm from the popover menu.

To configure an audio clip for tempo changes or warping:
1. In the Timeline, double-click the header of the audio clip for which you want to change the Warp algorithm. The
Clip window opens.
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2. From the Algorithm pulldown menu, choose the Warp algorithm for the clip.

3. Click Done.

You can now make a global tempo change, or any other type of tempo change, and your audio and Instrument tracks
will automatically adjust to the new tempo. See “Setting the tempo and making tempo changes” for more information.

Adding audio files and tracks
Audio files are imported differently, depending on whether they have embedded tempo information. A file with
embedded tempo information (for example, an ACIDized wav file) is stretched or compressed to fit the tempo, and set
in Tempo mode. A file without embedded tempo information is placed at the start of the session but the audio is not
transformed in any way, and the track is set in Time mode.

Importing an audio file
You can import an audio file using File > Import. A file with embedded tempo information (for example, an ACIDized wav
file) is placed at the playhead, aligned to the grid, stretched or compressed to fit the tempo, and set in Tempo mode. A
file without embedded tempo information is not transformed in any way, and the track is set in Time mode.
When you import audio files with embedded tempo information into an empty session, you are prompted to either keep
the session at the current tempo, or adjust the session to the tempo of the audio files.
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Choose whether to keep the session at the current tempo, or to use the tempo from the imported audio file.

Dragging an audio file into the Tracks browser
You can drag audio files into the tracks browser. Each audio file will be created as a new track. The previous rules apply;
if the audio has embedded tempo information, it is stretched or compressed to the tempo of the session, and set in
Tempo mode. If the audio does not have embedded tempo information, it is set in Time mode and unchanged.

Dragging an audio file onto the Timeline
You can drag audio files directly into the timeline. The previous rules apply; however, audio that you drag to the
timeline is placed at the spot where you drop it. If you drop an audio file onto an existing track or tracks, the audio is
added on that track or those tracks at the location where you dropped it. If you drop the audio into an empty part of the
workspace, the audio is placed at the time location where you dropped it on a new track or tracks.

Assigning track colors
There are three color hotspots you can click to assign track colors:
• The colored strip at the bottom of a track in the Mixer
• The colored strip at the left of a track in the Timeline
• The colored square to the left of a track name in the Tracks browser

To assign colors:
1. Click one of these locations to assign a track color. The Color browser opens, with a color wheel and a block of
your recently used colors at the bottom of the color wheel.
2. On the Color wheel or in the block of used colors, click the color to use. The color is assigned to the track
controls and track clips.
3. To exit the Color browser click Done or press Esc.
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Comping tracks with Versions
In LUNA, you can comp or create a compilation track from a recorded track to assemble a compilation of audio or MIDI
on the same track or another track. The comping workflow in LUNA uses Track Versions. Track Versions are similar to
what other applications may refer to as versions, playlists, or lanes.
Two methods for comping are provided here.
• Comp to the same track: this method for comping assembles the comp track on the original track, by switching
between versions and copying and pasting sections to either an existing track version or a new track version.
• Comp to a different track: this method for comping requires two tracks. With this method, you can either
duplicate the track you are comping from, or you can create a blank track on which to assemble the comped
track.

To prepare for comping:
• Record a track.
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• If you want to record an entirely new version, open the Versions panel, and click the plus (+) to create a new
Version.
• To record Takes, simply loop record over a selection. A Take is the same as a version, but the name in prepended
with a T to indicate it is a Take.

To comp to a new or existing version on the same track:
1. If you want to create a new Version for the comp track, click the plus (+) in the Version list. Otherwise, you can
easily comp to an existing version.
2. To easily recognize the comp track and any Versions or Takes, rename the Versions. Double-click each Version,
or select the version and click the Pencil tool, and rename relevant Versions. For example, you might rename the
comp track “comp,” and give descriptive names to Takes based on their content (louder, softer, aggressive, etc.).

3. In the Versions list, select the Version on which you want to comp audio, or press Shift + ↓ or Shift + ↑ to navigate
through the list.
4. Enable Loop playback (Control+L or the Loop mode button on the transport).
5. Select the section you want to audition and replace.
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6. Press Play or the Spacebar. To move through the candidate takes and versions, press press Shift + ↓ or Shift + ↑,
or click the different takes and versions on the Versions list.
7. When you find a selection you want to use on the comped track, copy the selection with Command+C, return to
the main comp track with the Versions list or Shift + ↓ / Shift + ↑, and press Command+V to paste it.
Repeat this process for each phrase or selection you want to comp. In this way, you can move through a number of
versions and takes, selecting phrases and assembling a final comp track.

To comp to a new track:
1. Create a new audio track and move it directly below or above the track from which you are comping.
2. To easily recognize any Versions or Takes, rename the Versions. Double-click each Version, or select the version
and click the Pencil tool, and rename relevant Versions. For example, you might rename the comp track “comp”,
and give descriptive names to Takes based on their content (louder, softer, aggressive, etc.).

3. Enable Loop playback (Control+L or the Loop mode button on the transport).
4. Select the section you want to comp from on the source track.
5. Press Play or the Spacebar. To move through the candidate Versions, press Shift + ↓ or Shift + ↑, or click the
Versions on the Versions list.
6. When you find a selection you want to use on the comped track, copy the selection with Command+C.
7. Click the track name to select the comp track, and press Command+V to paste the selection. Clicking the track
name retains the location selection on the target track so the paste occurs in the right location.
Tip: You can press the semicolon key ( ; ) to move the selection down one track, or the P key to move the
selection up one track.
Repeat this process for each phrase or selection you want to comp. In this way, you can move through a number of
versions and takes, selecting phrases and assembling a final comped take.
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Tip: When comping from one track to another, you can use Solo Exclusive mode to quickly solo between your comp
source and comp target track, without hearing duplicate or conflicting audio. To enable Solo Exclusive mode, toggle the
Mix workflow and click the Solo Exclusive mode button. For more information about Workflows, see Using Workflows.
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Making Tempo and Time Signature Changes
You use the Tempo and Signature rulers to specify tempo and time signature, and make tempo and time signature
changes.

Setting the tempo and making tempo changes
When you change the session tempo, elements in the LUNA session that are tempo-based adjust to the new tempo.
Instrument tracks are adjusted, and audio clips that are set to Tempo mode are stretched or compressed to fit the new
tempo. Audio clips that are time based are not stretched or compressed, but LUNA keeps the start of each clip at the
same relative point in the Timeline.

Setting a tempo
To set the overall tempo of the session:
• Hover over the Tempo control. The cursor changes to a double arrow. Click and drag up or down to adjust the
tempo by 1 BPM increments. To adjust by .1 BPM increments, hold Shift while you click and drag. Release the
cursor to set the Tempo. You can click and drag to change tempo while the session is playing to hear your
changes in real time.

• To type the new tempo, click to select the Tempo in the control bar, type a new tempo, and press Return.
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To set the session tempo by tapping:
1. In Timeline view, double-click the session tempo in the Tempo ruler.

1. The Tempo browser opens. Tap the Tap button at least four times, then click Apply.
Tip: You can close the Tempo browser by typing the esc key.

To add a tempo change:
1. Place the playhead in the timeline where you want to apply the tempo change.
1. Click on the Tempo ruler control area.
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1. The Add Tempo browser opens, with the selected timeline location in the Start field. Type the Tempo or tap in a
tempo with the Tap button, and click Apply.

The tempo change is added at the location specified.
Changing tempo over time
You can use the tempo curve dialog to add a gradual tempo change.
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In the tempo curve dialog, you can determine the shape of a tempo change over time, with these options:
•
•
•
•

Start and Stop points for the Tempo curve (set by selecting a range in the Timeline).
Tempos at the start and the end of the tempo curve. You can set tempos by tapping.
The shape of the tempo curve, which specifies how linear or curved the tempo change is over time.
The Grid on which the tempo curve is defined. A tempo event is added to the Tempo ruler at each grid marker, as
specified.

To specify a tempo change over time:
1. Select a range in the timeline to specify the start and end points of the tempo curve.
2. Click the Tempo ruler control area.
3. Set the Start and End tempo. You can select and type or Tap the tempo for each field (remember to tap at least
four times).

Working with Audio in the Timeline – 193

LUNA User Documentation v200731

4. Use the Shape slider to specify the curve of the tempo change. A curve of 0 is linear. A negative curve ramps up
sharply, then slows towards the end of the tempo change. A positive curve starts more slowly and ramps up
more quickly towards the end of the tempo change.
5. Specify the Grid for the tempo change over time. A tempo change event is added at each gridline, as specified, so
the finer the grid, the less “stepped” or abrupt the tempo change might seem.
6. Click Apply to apply the tempo change. The Tempo Curve is applied.
To draw (automate) a tempo change:
1. Open the tempo lane by clicking > on the Tempo ruler. The tempo lane opens and shows the tempo as a line.

2. Control+Click to change the cursor to a pencil. With this cursor you can draw tempo events. Tempo events snap
to the grid if Snap is enabled.

3. To disable snapping while drawing tempo events, press Control+Command while you draw tempo events.

To edit tempo events (automation):
• Click and drag a tempo event up or down.
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• To edit a range of events, click and drag above or below the tempo line to select a range. Click on a tempo line
and drag up or down.

To delete tempo events:
• Double-click a single tempo event to delete it.
• To delete a range of tempo events, click and drag above or below the tempo line to select a range. Press the
Delete key to delete the range of tempo events.

Setting the time signature and making meter changes
When you change time signature, elements in the LUNA session do not change, but rather, the way they are counted
changes. For example, if you add a change from 4 / 4 time to 3 / 4 time, bar lines will move and the click will indicate a
three bar measure instead of a four bar measure. However, audio and MIDI will not move, stretch, or expand.
To set the time signature of a session:
1. Hover over the Signature ruler and click the plus (+) symbol. The Time Signature browser opens.
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2. Type the bar at which you want the time signature to start.
3. Type the number of beats in a bar.
4. From the Note pull down, choose the note value that represents one beat. For example, choose 4 for a quarter
note, or 8 for an eighth note.
5. Press Return or click Apply.
The Time Signature is changed on the ruler, at the bar you specify.
To add a time signature change:
1. Click in the session where you want the time signature change to be located.
2. Hover over the Signature ruler and click the plus (+) symbol. The Time Signature browser opens.
3. Type a bar number where you want the time signature change to start. The nearest preceding bar is
automatically populated.
4. Type the number of beats in a bar.
5. From the Note pull down, choose the note value that represents one beat. For example, choose 4 for a quarter
note, or 8 for an eighth note.
6. Press Return or click Apply.
The Time Signature change is added to the ruler, at the bar specified.

Other time signature operations
• Move a time signature marker on the Signature ruler by clicking the icon and dragging.
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• Edit a time signature by double-clicking the time signature marker to open the Time Signature browser. Make
your changes and press Return or click Apply.
• Delete a time signature marker by selecting the marker in the time signature ruler and pressing Delete.
• You can have the time signature markers follow your edits when arranging your session. Just be sure to select
the Signature ruler along with other elements when you copy, cut, and paste elements in your session.

Using Markers
Markers are an easy and colorful way to mark locations such as verses, choruses, or any other sections in your session.
You can use markers to define locations, and easily navigate between locations in your session.
To add a marker:
1. Click a location in the session or on a ruler.
2. Hover over the Markers ruler, and click anywhere on the highlighted bar, or press Enter (if you have a keyboard
with a Numeric Keypad), or Function + Return.
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3.
4.
5.
6.
7.

In the Marker browser, specify the Start location. The location of the playhead is prefilled.
Type a name for the marker.
Choose a marker color.
You can add optional comments in the Comments box.
Press Return or click Apply to save the marker.
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Note: To quickly add a marker as recording or playback is occurring, press Enter twice on the numeric keypad, or
Function+Return, then Return. Multiple markers added this way are automatically numbered, and automatically cycle
through the marker colors.
To edit a marker:
1. Double-click the name of a marker on the marker ruler. The Marker browser opens.
2. Edit the options for the marker, and press Return or click Apply.
The marker is updated with the options you set.
Other marker operations
• To move a marker, click and drag the marker.

• To delete a marker, select the marker, and click Delete in the Marker browser.

• To move the playhead to a marker, click the marker name.
• To make a selection to a marker, place the playhead where you want to start the selection, then hold Shift and
click the marker.
• You can copy, cut and paste markers by selecting on the Markers ruler. Make sure to select the start of the
marker to copy or cut the marker..
• When you edit items on any other ruler, or audio or MIDI clips in the Timeline, you can copy, cut, paste, and
delete markers along with those items by including the Markers ruler in your selection, or selecting and editing
on the All Tracks ruler. Note that only markers that have their start selected are edited with other items.
• To move the playhead to the next marker, press Control+Option+’.
• To move the playhead to the previous marker, press Control+Option+L.

Warping and pitch shifting audio
You can warp a clip to change the tempo of the clip with or without changing the pitch of the clip. You can also warp
audio to correct the timing within an audio clip, or to create an effect.
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You warp audio in Warps view. Enter Warps view by clicking View on the Timeline track controls, and choosing Warps
from the browser.

Warps view shows transient markers that are automatically generated in audio clips on a track. Warps view also allows
access to the Warp Trim Editing Tool, with which you can time-stretch or time-compress a clip. You can adjust these
warp markers independently or in combination, or you can add manual warp markers.
You can also pitch shift an audio clip with clip controls.

Warp algorithms
Warp algorithms are applied when you stretch or compress Tempo-based clips by adjusting session tempo, and when
you pitch shift audio using the clip pitch controls. Warp algorithms also affect how LUNA plays back warp trimmed
audio, and how audio plays when you make inter-clip adjustments using warp markers. Warp algorithms are applied
non-destructively during playback.
You can audition different warp algorithms by changing the warp algorithm while playing back warped or pitch-shifted
material.

Algorithm

Description

Polyphonic

The polyphonic algorithm is the default setting for tempo-based tracks. This
algorithm works for most material, including complex musical material (for
example, an instrument playing chords), and for multiple instruments, bands, and
other complex material. This algorithm can also work for monophonic material
and drums, though Razor Blade will give more accurate results on drums.
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Monophonic

The monophonic algorithm is best suited for use on monophonic material, such
as a bass line or a vocal.

Varispeed

The varispeed algorithm changes the pitch of source material as the tempo is
changed, lowering pitch as the source is slowed, and raising pitch as the source
speeds up. This can be useful for tape transport style effects or creative sound
manipulation.

LUNA Razor Blade

The LUNA Razor Blade algorithm is a UA-designed algorithm that is specifically
designed for percussion and drums, and attempts to minimize artifacts and
preserve transients during warping. With LUNA Razor Blade, transients retain their
original sound so drums don’t lose impact when stretched or compressed. LUNA
Razor Blade is also very effective when tempo-shifting or Warp trimming
multitrack drums, without introducing phasing or other artifacts.

LUNA Polyphonic

The LUNA Polyphonic algorithm is developed by UA, and provides a more generaluse warping algorithm than LUNA Razor Blade. LUNA Polyphonic does not
preserve transients as accurately as LUNA Razor Blade, but sounds good on a
wider range of transients and pitched instruments. For example, LUNA Polyphonic
may sound better on a guitar recording with crisp staccato attack, whereas LUNA
Razor Blade may sound better on a snare track.

Changing audio pitch or duration
You can easily change the pitch of an audio clip. You can change the duration of an audio clip while retaining rhythm
and pitch, or while changing the pitch and rhythm.
Configuring a track for warping or pitch shifting:
1. In Timeline view, click View Mode on the track controls, and from the View browser, choose Warps. You can click
the buttons to apply the change to All tracks or selected tracks, or press Esc or click the X to exit the View
browser.
2. If you are adjusting tempo and want the track to conform to tempo changes, click Track Mode on the track
controls, and choose Tempo from the popover.
Note: you can apply pitch changes to clips, adjust warp markers and Warp Trim clips in Time or Tempo mode;
however audio tracks will only adjust to session tempo changes in Tempo mode.
3. Click Warp on the track controls, and choose a Warp algorithm from the algorithm drop menu.
To apply these changes to multiple tracks, select multiple tracks before you make the selections.
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Pitching an audio clip up or down while maintaining track length
To pitch an audio clip up, use the pitch clip controls. You can do this with the Pitch Editing Tool or the clip controls.
Change clip pitch using the Pitch Editing Tool:
1. Hover over the pitch control in the clip header. The Pitch Editing Tool appears.
2. Slide the control up or down to raise or lower the pitch. To type an exact value, double-click the pitch control,
and type the pitch change value in semitones and cents in the popover, then press Return or click OK.

Change clip pitch using the Clip header controls:
1. Double-click the name of the clip or the empty area next to the pitch control to open the Clip controls.
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2. Raise or lower the pitch with the Pitch knob. To type a value, double-click the Pitch knob and type a semitone
and cent value, then click Done.
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Warp Trimming
You can Warp Trim to time-stretch or time-compress a clip. With Warp Trim, you can easily conform an imported loop to
a tempo, or stretch a clip to double-time or half-time. You can also warp trim clips for creative effect.
Note: If you set the Warp Algorithm to Varispeed, Warp Trimming changes the pitch of the clip based on the amount of
time stretching or time compression.
Warp Trimming to time-stretch or time-compress a clip in Clips view:
1. With Clips view enabled, hover the cursor at the start or end of a clip, near the vertical center. The Trim Editing
Tool appears.
2. Click and drag to Warp Trim. Warp Trim snaps to the grid if Snap is enabled unless you hold the Command key
while trimming.
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Warp Trimming to time-stretch or time-compress a clip in Warps view:
1. With Warps view enabled, hover the cursor at the start or end of a clip, near the vertical center. The Warp Trim
Editing Tool appears.

2. Click and drag to Warp Trim. Warp Trim snaps to the grid if Snap is enabled unless you hold the Command key
while trimming.
Depending on the algorithm, extreme Warp Trims may not play or may have undesirable audio artifacts. For UAdeveloped algorithms, extreme settings are indicated by the waveforms appearing red as they approach settings that
may have undesirable audio artifacts, or may not play.

Warping within a clip
Within a clip you can easily move elements back and forth in time with warp markers. LUNA automatically adds
indicators to transients in each audio clip, and you can also add arbitrary warp markers. When you add warp markers,
you can then move (stretch and compress) audio before and after the warp marker.
There are three ways you can add Warp markers to a clip:
• Adding a single warp marker on a transient indicator.
• Adding a Bounded Warp (three Warp markers on three adjacent transient indicators) with the Bounded Warp
Editing Tool. A bounded Warp allows you to adjust the center Warp freely, while the Warp markers to the left and
right prevent the changes from affecting the rest of the clip.
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• Adding an arbitrary warp marker.
To add and adjust a single warp marker:
1.
2.
3.
4.

Hover the cursor over a transient indicator. The Warp Editing Tool appears.
Click to add a warp marker.
Click and drag to adjust the warp marker. The warp marker snaps to the grid if Snap is enabled.
To drag without snapping to the grid, press Command while you drag.

To add and adjust a Bounded Warp marker:
1. Hover the cursor below the vertical center of the clip, below a transient indicator. The Bounded Warp Editing
Tool appears.
2. Click to add a Bounded Warp. A warp marker appears on the transient you hovered over, and on the transient to
the left and right.
3. Click and drag to adjust the warp marker. The warp marker snaps to the grid if Snap is enabled.
4. To drag without snapping to the grid, press Command while you drag.
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To add an arbitrary warp marker:
1. Hover the cursor near the top of the clip, where the transient indicators appear. You can add a warp marker
anywhere (your cursor will snap to the grid if Snap is enabled).
2. Click to add a warp marker.
3. Click and drag to adjust the warp marker. The warp marker snaps to the grid if Snap is enabled.
4. To drag without snapping to the grid, press Command while you drag.
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To delete warp markers:
There are several ways to delete one or more warp markers.
• To delete a single warp marker, double-click it, or select the warp marker and press Delete.
• To delete multiple warp markers, select multiple markers and press Delete.
• To delete all markers from a clip, double-click the top of the clip. In the Clip popover that opens, click Reset
Warps. Note that this will remove all warp markers and warped audio, and also revert any Warp Trim operations.
To select and move multiple warp markers:
• Hold Shift, then click in the vertical middle of the clip and drag to select multiple contiguous warp markers. Click
one warp marker and drag to adjust all selected markers.
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• Hold Shift, and click and drag over only each warp marker you want to select, to select multiple non-contiguous
warp markers (tip: disable Snap). Click one warp marker, and drag to adjust all selected markers.
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Using the Mixer
About Mixer View
Mixer view presents an analog console-like layout of your audio, instrument, and bus tracks, and the main track. You
can use mixer view to:
•
•
•
•
•
•
•
•
•
•
•
•

Mix audio levels and pan tracks
Arrange tracks for audio, instruments, buses, and the Main track
Assign track inputs
Use tape emulation on an audio or Instrument track
Use Neve summing emulation on a bus or the Main track
Use insert effects on a track
Configure sends from a track
Send track audio to cues
Change a track's output
Record enable, mute, and solo a channel
Monitor a channel’s input
Configure a bus and view the sources for that bus

Mixing Audio
When you mix, you combine multiple audio and instrument tracks to create a stereo output file, and/or output stems, or
multiple audio sources combined into mono or stereo outputs with buses. To create the sound of the overall mix, you
balance the levels, frequency content, dynamics, creative effects, and stereo panning position of the audio and
instrument tracks in your session.

Balancing volume levels
To balance audio levels in LUNA’s mixer, you can use:
•
•
•
•

Clip gain (Timeline)
The volume fader (Mixer/Focus track)
The volume fader in the track controls (Timeline)
Text entry in Timeline track controls or Mixer channel

To balance levels with the Mixer or a Focus channel:
1. Play the session.
2. Move the volume fader up to increase volume, and down to decrease volume. The level is indicated by the value
at the bottom of the volume meter.
3. To set a precise value for the volume fader, double-click the value at the bottom of the volume meter and type a
value in dB, then click OK. You can type whole values, decimal values, and negative. For example 5, 1.6, and -3.7
are all valid values.
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To balance levels with the Timeline track controls:
1. Play the session.
2. Move the volume fader left or right on the track controls in the Timeline. Move the fader left to reduce volume,
and right to increase volume.
3. To set a precise value for the volume, click the displayed volume and type a value in dB, then press Return. You
can type whole values, decimal values, and negative. For example 5, 1.6, and -3.7 are all valid values.
Note that after entry, the value in the track controls shows the nearest whole value, even though the correct decimal
value is applied to the fader.
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To balance levels with the clip gain control:
1. Hover the mouse cursor over the gain control icon at the top of an audio clip to show the Gain Control Editing
Tool.
2. Move the slider up and down to increase or reduce the gain of a clip, without altering the gain of other clips on
the track.
3. To enter a precise value, double-click the gain control, type the value in the popover, and press OK.
Clip gain allows a wide range of adjustment, from -144 dB to +48 dB. As you adjust clip gain, the waveform display
shows the resulting changes to the audio level. If you select multiple clips and adjust the gain slider on one clip, the gain
change is applied to all selected clips. To reset the clip gain control to 0 dB, Option-click the control.

Panning tracks
You pan a track to locate the track in the stereo field. In LUNA, a track can be mono or stereo, and you can pan tracks
differently based on the track format. Use the pan knobs to pan the tracks to the left or right of the stereo image. A
mono track has a single pan knob, while a stereo track has two pan controls–one for the left track, and one for the right
track.
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To pan a track in the mixer:
• Click and drag the pan control at the top of the channel strip.
• To type a precise value for the pan knob, double-click and type a positive or negative pan value from 0-100, then
press Enter. When you type a pan value, use the prefix minus (-) for left and no prefix for right. You can also
include the letter L for left or the letter R for right. For example, -24, L24, and 24L both pan a pan control 24% left.
33, R33, and 33R all pan a control 33% right.
• To simplify panning for a stereo track, you can Control+Click or right-click the pan control, and choose Simple
Stereo Pan from the drop menu. The Simple Stereo pan option allows you to pan both stereo tracks with one
control to achieve the stereo image you want.
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Panning in Timeline view
You can also pan tracks in the Timeline view.
In the track controls for each track, you can double-click and drag on the pan setting, or click the pan value and type a
value from 0-100, then press Enter. When you type a pan value, you can use the prefix minus (-) for left and no prefix for
right. You can also type L for left or the letter R for right. For example, -24 and 24L both pan the audio 24% left.
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Muting and soloing
When you mute a track it goes silent in the mix, and in any sends to which it is routed (unless they are assigned prefader). When you mute a track, it goes silent in the session for the duration that the mute is applied. You can also
automate mutes.
Soloing a track isolates it, or plays it without the other mix elements. When you solo a track, any bus to which it is sent
also continues to sound in the session; however only the soloed tracks sound through the bus. You can solo multiple
tracks by default in LUNA. You can also configure LUNA to allow only one track to be soloed at a time (see “The Mix
workflow” for the X-Or Solo setting).

Bus Spill
The Bus Spill control is a feature on a bus track and the Main track that allows you to see only the bus track and all the
bus sources (all tracks routed to the bus) in the Mixer and Timeline. To enable Bus Spill, click the Spill button on a bus or
the Main track. When Bus Spill is enabled, the Timeline and MIxer show only the source tracks that feed the bus, and the
Main track. The Spill button flashes on the bus or Main track when Bus Spill is enabled.

Compacting mixer faders
You can click at the top of the mixer fader section to compact the mixer faders, and allow more space to work with the
mixer slots. Click again to expand the mixer faders to full height. You can also toggle this setting with the menu item
View > Compact Monitor Faders.
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Mixing down tracks
LUNA offers a full suite of mixdown options, including the ability to export any combination of raw tracks and bus
outputs from a session, in stereo or mono as required, with or without effects applied. LUNA can also export MIDI tracks
as a multitrack MIDI file with tempo.
For a simple stereo mixdown, LUNA mixes down either the entire range of audio and MIDI, or a selected audio range at
any sample rate supported by the hardware, and bit depths from 8 to 24. You can mix down a file as WAV, AIFF, or AAC
(.mp4).

To mix your LUNA session down to a stereo audio file:
1. In Timeline view, select the length on the timeline or in the rulers that you want to mix down.
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2. Select File > Export > Mixdown. The Mixdown dialog appears.
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3. Choose the file type for the mixdown file.
4. For WAV or AIFF, choose the sample rate and bit depth for the mixed file. There are additional options you can
set for an AAC file: VBR (variable bit rate) and quality, or CBR (continuous bit rate) and the bitrate in kbps.
5. To listen to your session during mixdown, choose the Real-Time Mixdown option. Note that the session will mix
down faster if you deselect Real-Time Mixdown.
6. Click Mixdown to mix down the file.
By default, files are automatically named with the name of the session, and the name of the output (for example,
session - MAIN.wav). Double-click the mixdown file name to change it. By default, files are mixed down to the Exported
Files folder in the LUNA session folder.

To mix down tracks and buses from a LUNA session:
1. In Timeline view, select the length on the timeline or in the rulers that you want to mix down.
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2. Select File > Export > Mixdown. The Mixdown dialog appears.
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3. Choose the file type for the mixed down files.
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4. For WAV or AIFF, choose the sample rate and bit depth for the mixed down files. There are additional options you
can set for an AAC file: VBR (variable bit rate) and quality, or CBR (continuous bit rate) and the bitrate in kbps.
5. To export the MIDI from the session as a multitrack MIDI file with tempo data, choose Include MIDI file for tempo
map and instruments.
6. To export tracks without effects, choose Bypass Effects.
7. To export mono tracks as mono files, choose Bypass Pan (Preserve Mono Tracks). If you do not choose this
option, panned mono tracks are exported as stereo tracks with the panning information applied to the stereo
exported file.
8. To listen to your session during mixdown, choose the Real-Time Mixdown option. Note that the session will mix
down faster if you don’t choose Real-Time Mixdown.
9. Under Sources, click Main >.
10. Select the tracks to export. You can export any combination of tracks and buses.
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11. Click Done to return to the Mixdown dialog.
12. Click Mixdown to mix down the files.
By default, files are automatically named with the name of the session, and the names of the outputs appended (for
example, session - MAIN.wav, session - verb.wav). Double-click the name of any mixdown file to rename it. By default,
files are mixed down to the Exported Files folder in the LUNA session folder.

Exporting Audio from the Timeline
You can export individual audio clips as single files, multiple audio clips on the same track as multiple files, and multiple
audio clips from different tracks as separate files, directly from the Timeline.
To export audio clips:
1. In the Timeline view, click one or multiple audio clips to export.
2. Right-click an audio clip and select Export Clip. You can also select one or more audio clips and press
Shift+Command+K, or choose the menu item File > Export > Clips.

3. While the Export dialog is open, select clips in your session you want to export. Each clip is added to the export
list.
4. To remove a clip from the export list, click it again. (Tip: you can click a clip in the Export browser to select and
center that clip in the timeline.)
5. Under Save To in the export browser, select the location where you want to export the clips by clicking the folder
icon and choosing a location from the Finder.
6. Under Audio File Settings, specify the settings for File Type, Sample Rate and Bit Depth.
7. Click Export to export your clips.

Using Neve Summing
You can add Neve Summing to bus tracks and the main track using a LUNA Extension.

Using the Neve Summing LUNA Extension
Neve Summing imparts the sound and headroom characteristics of a Neve console bus channel directly into the LUNA
summing buses. You can purchase the optional Neve Summing LUNA Extension to add Neve summing to Bus and Main
tracks.
Note: when you change the Neve Summing setting for a bus, the faders for the bus and for all tracks that feed the bus
will change position because of the difference in fader taper between LUNA native summing bus and Main channels and
Neve Summing bus and Main channels.
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To add Neve Summing:
• In the Input row of a bus or the Main track, click the Console button, and choose Neve Summing.
• Set the controls for Headroom (HR), Trim, and Impedance.
To adjust controls on multiple tracks, select multiple tracks, then change the controls on one track. Selection Grouping
(Mixing > Selection Grouping, or Command+G) must be enabled to adjust Neve Summing settings on multiple tracks at
one time.

Neve Summing provides these controls and characteristics:
• Channel characteristics: The fader and panning characteristics of the bus change to accurately emulate the Neve
console bus characteristics.
• Headroom (HR): The headroom setting increases or decreases the amount of headroom in the channel, and the
amount of saturation. The available range is +4 dB to +28 dB, and the lowest setting (fully counter-clockwise) has
the least saturation and the most available headroom. As you turn this up to the top of the range, you can get
saturation and even distortion characteristics. You can rotate the knob or double-click it to choose a value from
the drop menu. The headroom control is gain-compensated, so the volume changes are minimal when changing
the headroom control. The Low impedance setting is louder than unity gain, even with gain compensation.
• Trim: The trim setting allows you to compensate for gain changes introduced by the summing headroom and
impedance controls, and allows you to increase or decrease the overall level of the summing bus. The available
range is -6 dB to +6 dB. You can rotate the knob or double-click it to typw a value.
• Impedance: This setting changes the impedance character of the bus or Main channel from low to high
impedance. The default is high impedance. The Low and High bus impedance settings provide different audio
character and gain levels, and one or the other might be more appropriate for your audio material and bus.
Generally, the Low impedance setting is louder than the unprocessed audio.
• In/Out: The In/Out button allows you to toggle Neve summing on and off to audition the audio effects.
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Using Tape

Using Tape LUNA Extensions
With LUNA, you can incorporate the classic sound of tape directly into your mixing workflow. LUNA implements tape
emulation in a way that is both easy to use and sonically diverse. Both Oxide and Studer A800 provide you with the
accurate, classic sound of a classic multitrack machine. The overall sound of Oxide is configured with presets and a perchannel saturation control, while Studer A800 offers per-machine and per-track control over the individual tape
channel parameters. Tape can be enabled on any instrument or audio track, and is applied during playback only.
You can add emulated tape processing to audio and instrument tracks using LUNA Extensions. LUNA includes the Oxide
LUNA Extension for simple one-knob tape emulation.
The optional Studer A800 LUNA Extension adds more advanced tape control, and the sound of a venerable modeled
tape machine. If you already own the UAD Studer A800 plug-in, the Studer A800 LUNA Extension is available in your
account. Conversely, if you purchase the Studer A800 LUNA Extension, the UAD Studer A800 plug-in is included.
LUNA Extension tape machine emulation includes global settings for the tape machine, and per-track settings for
saturation. In this way, the tape machine emulation is similar to a true recording and mixing tape signal path.
LUNA is designed with the capability to use up to four “machines” for tape emulation. You can configure each machine
slot with different global tape characteristics, and apply any one of the four machines to a track or group of tracks in
your session. Overall tape characteristics are determined by each machine. You can then set the saturation individually
for each track to which Oxide tape is applied, and other settings for each Studer A800 channel. In this way, you can
configure separate machines within your session, and still set individual “tape channel” characteristics for each track.
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For example, a typical scenario could include two machines, with one machine more aggressively driven than the other.
You can assign drums, bass, and guitars to the more aggressively driven machine, and vocals and backgrounds to the
cleaner machine. You can add a third and a fourth machine with even more diverse characteristics. The ability to
configure up to four machines provides wide flexibility in the range of tape sounds you can apply in a session.

Oxide LUNA Extension Configuration
The Oxide Extension includes presets to configure the tape machine settings. You cannot manually adjust controls for
the Oxide LUNA Extension. However, if you own the UAD Oxide Tape plug-in, you can configure and save presets in the
plug-in that you can then use in the LUNA Extension.

Studer A800 LUNA Extension Configuration
The Studer A800 LUNA Extension allows you to load presets and adjust manual controls. Settings like bias, tape speed,
and tape type are configured on the tape machine globally for the session, and in addition, each track has its own level
(saturation) control, as well as control over the individual track’s HF Driver and Repro EQ settings. You can use presets
that you save in the UAD Studer A800 plug-in with the LUNA Extension.

Using Tape Machines
To configure a Tape Machine in a tape deck slot:
1. On an audio or Instrument track in Mixer view, or on a Focus track in Timeline view, click the Tape slot. The Tape
browser opens.
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2. Double-click a tape slot (A-D) in which you want to configure the tape machine.
3. From the Machine list, select a tape machine type (Oxide or Studer A800). Studer A800 is only available if you
have the Studer A800 LUNA Extension licensed and installed. The tape machine configuration is displayed in the
browser.
4. Configure the tape machine through presets (Oxide, Studer A800) or configure the tape machine settings (Studer
A800).
Once you have configured a tape machine in a slot, you can assign that tape machine to any number of audio or
Instrument tracks. You can configure a total of four tape machines, each with unique settings, for each LUNA session.
To assign a tape machine to a track:
1. Click the Tape insert on a track. The Tape Machine selector opens on the left of the screen.
2. Choose the tape machine from the list in the Tape Machine browser. A tape machine Saturation knob appears on
the track, along with a VU meter and a Power button. In the Mixer, with Large View enabled for the tape row,
additional settings for the Studer A800 LUNA Extension appear.
3. Use the Saturation knob to increase or decrease the amount of tape saturation applied to the track.
4. If you are using the Studer A800 LUNA Extension, you can configure the HF Driver HF setting, Bias, Repro LF, and
Repro HF settings, and enable noise on a per-track basis, in addition to the overall machine controls.
5. Click the power button to enable or disable tape emulation on the track.
To configure the global sound of an Oxide tape machine:
1. Click the Tape insert on a track. The Tape Machine selector opens on the left of the screen.
2. Choose an Oxide tape machine from the list.
3. Choose a preset to configure the global sound of the Oxide tape machine in the session.
Tip: If you have the UAD Oxide Tape plug-in, you can use presets you have created in the plug-in with LUNA tape tracks.
To configure the global sound of a Studer A800 tape machine:
1. Click the Tape insert on a track. The Tape Machine selector opens on the left of the screen.
2. Double-click the A800 tape machine that you want to configure.
3. Choose a Preset to configure the global sound of the Studer A800, or adjust the controls manually. Click Open to
open the additional machine controls.
To adjust a tape control, you can click and drag on the control to rotate it to the desired position, or you can doubleclick the control to choose from a list of values.
To adjust controls on multiple tracks, select multiple tracks, then change the controls on one track. Selection Grouping
(Mixing > Selection Grouping, or Command+G) must be enabled to adjust tape settings on multiple tracks at one time.
You can access tape controls from the tape configured on a track.
Hover your mouse over the tape slot on a track, and use the tape options to open the tape browser, open the assigned
tape machine for the track, or remove tape from the track.
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Using Insert plug-ins

You use inserts to add UAD and Audio Unit plug-In processing to audio, bus, instrument, and main tracks. You can
expand the Inserts row to view the standard inserts. Record FX and the Unison insert appear in the Input row, when a
track is Input or Record enabled. Click an available insert to open the list of available plug-ins in the Focus Browser, and
click a plug-in from the pane to insert it.
Note: Only UAD plug-ins can be used in Record FX inserts. Only Unison-capable UAD plug-ins can be used in Unison
inserts.
Plug-in states are indicated with colors and outlines.
•
•
•
•
•

A gray plug-in plate indicates a powered-on and authorized plug-in.
A red plug-in plate indicates that a plug-in is not authorized.
A black plug-in plate indicates that a plug-in is powered off.
A blue plug-in plate indicates that the plug-in is focused in the browser.
A yellow outline around a plug-in plate indicates that the plug-in window is open in LUNA.
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Adding plug-ins
Click on a Unison insert, Record FX insert, or standard Insert insert to add a plug-in. Note that you can only add a
Unison-enabled UAD plug-in in the Unison insert, and UAD plug-ins in the Record FX inserts, and those inserts are only
active when an audio track is record-enabled or input-enabled.
When you click on an insert, your list of supported plug-ins opens in the Plug-Ins browser. The list of plug-ins in the
browser changes depending on the context. As an example, only Unison plug-ins appear when you click a Unison insert.
On audio tracks, only UAD plug-ins appear in the Record FX insert. When LUNA is ARM-enabled, only UAD plug-ins
appear in standard inserts when the track is record-enabled or input-enabled.
Plug-ins are organized by manufacturer, and you can click a manufacturer’s name to show or hide the list of plug-ins. In
addition, UAD plug-ins are sorted into two folders:
• My Universal Audio includes all UAD plug-ins that you own, and those that are currently in an active demo state.
• Universal Audio includes those UAD plug-ins that you do not own, and that are not currently active as demos.
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Searching for plug-ins
You can easily search for and choose plug-ins in the plug-ins browser. To search for a plug-in, after you click on an insert
to open the plug-in browser, begin typing. As you type the browser shows the search results.
You can navigate through the list of plug-ins and apply plug-ins using the up and down arrow keys.
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Hiding, showing, and closing plug-in windows
When one or more plug-ins are open in LUNA, you can use key commands to hide or close them.
• To hide all floating windows, press Shift+W. This temporarily closes all floating windows (plug-ins, cue outputs,
and others). You can restore these hidden windows by pressing Shift+W again. When you hide windows, then
open a new window (for example, when adding another insert plug-in), any previously hidden windows
reappear.
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• To close windows, press Command+W. This closes the topmost floating window. Press Command+W repeatedly
to close additional floating windows.

Using plug-in presets
Plug-in presets are selected and saved using the Preset Focus Browser.
Note: You use the same plug-in presets with UAD plug-ins in Standard, Record FX, or Unison inserts, and they function
identically.
To apply a plug-in preset:
1. Click Presets on the plug-in title bar, or on the plug-in icon in the Insert rack, click ••• and choose Presets… The
Presets Focus Browser opens.
2. Click a preset to select it.

You can use the Up and Down arrows to navigate through presets. To search for a preset, click next to the magnifying
glass at the top of the browser, and begin typing.
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To save a plug-in preset:
1.
2.
3.
4.

Select a preset from the Preset Focus Browser.
Make changes to the plug-in as required.
Click Save. The Save Preset As dialog opens.
Click Save to save the changes to the existing preset, or type a name for the preset to save a new preset, then
click Save.

You can delete or rename presets that you have created. If you save changes to a system preset, the preset is saved as a
User preset with the same name.

Showing large plug-in icons
In the Inserts section, click on the Large View icon to show expanded inserts. This shows icons that represent the plugins loaded in the inserts.

Adding an icon for a plug-in
By default, Audio Units insert, MIDI FX, and instrument plug-ins have a generic icon. You can add a plug-in icon at any
time. The plug-in icon takes a snapshot of the current user interface of the plug-in.
To create a plug-in icon:
1. Click on a plug-in in an Instrument, MIDI FX, or Insert row in Mixer View or on a Focus track.
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2. Arrange the window of the plug-in as you would like it to appear in the icon.
3. Click the plug-in Name bar at the top of the plug-in window, and choose Create Plug-In Icon.
The icon is created from the current plug-in window.

Using Sends
You can use the send slots to send audio from a track to a bus track, the main output, or any available physical output
on your Apollo. Note that multiple sends can send to the same physical output. They are mixed together before being
sent to the physical output.
Click on the send slot to open a list of send destinations in the Focus Browser on the left, to which you can route the
send.
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You can also send from a single send slot on a track to multiple buses. To assign a send slot to multiple outputs, click
the Send assignment slot, then in the Sends browser, Shift-click or Command-click the outputs to assign. The send is
then labeled with “Multiple.”
After you add a send, the send appears in the mixer track, with a small set of send controls displayed. These include the
Send level, the Pre-fader button (P), and the Mute button (M).
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To use sends:
• Expand the Sends row in Mixer View, or on a Focus track in Timeline view.
• Turn the Send knob to control the level of audio that you want to send to the destination. You can double-click
the Send knob to type a value. When audio is playing on the track, the Send knob indicates the audio level on the
track with a circular meter.
• Click the Pre button (P) to route audio to the send destination before the channel’s main fader level. When audio
is routed pre-fader, audio is sent from the disk to the destination regardless of the setting of the channel’s fader
and mute status. If audio is not routed to the send pre-fader, then if the channel is muted no audio is sent, and
gain changes on the channel fader do affect the send.
• Click the Mute button (M) to mute audio to the send.
• To copy the main mix to a send, in Mixer view, Control+click or right-click on a track’s Pan knob, and choose the
send to which you want to copy the mix.

Click the Large view icon to expand all sends in the selected slot in the LUNA mixer. Large view shows a Send fader
instead of a knob, and also shows the Pan control for the send. Use the Pan control to pan the audio when routed to a
stereo destination.
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Using Cues
Use cue mix buses to create up to four custom stereo mixes that are separate from the main monitor mix. You can use
cue mixes:
• To send performers a headphone monitoring mix that is different from the main monitor mix, or a mix of the
Main track and other channels.
• To send separate mixes to other rooms or audio equipment.
• Any time you want to send an alternate mix to another destination.
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To use cue mixes:
• Expand the Cues row in Mixer View, or on a Focus track in Timeline view.
• Turn the Cue level knob to control the level of audio that you want to send to the cue destination. You can
double-click the Cue level knob to type a value. When audio is playing on the track, the Cue leve knob indicates
the audio level on the track with a circular meter.
• Click the Pre button (P) to route audio to the cue destination before the channel’s main fader level. When audio
is routed pre-fader, audio is sent from the disk to the destination regardless of the setting of the channel’s fader
and mute status. If audio is not routed to the cue pre-fader, then if the channel is muted no audio is sent, and
level changes on the channel fader do affect the send.
• Click the Mute button (M) to mute audio to the cue.
Click the Large view icon to expand the cues in a selected slot in the LUNA mixer. Large view shows a Cue fader instead
of a level knob, and also shows the Pan control for the cue. Use the Pan control to pan the cue mix when routed to a
stereo destination.

The cues that are displayed and available are dependent on your Apollo hardware. You can configure the number of
available Cues in LUNA Settings > Hardware panel > Cue Bus Count.

Changing Track Output
You can change the track output, for example, to send a track’s output directly to a hardware output, or to route a
track’s output to a bus.
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To change the track output:
1. Scroll to the Output row in the Mixer, or on the Focus channel.
2. Click the Output for the track.
3. In the track Output browser, select the output. You can route a track’s output to Main, an Aux, or a hardware or
virtual output or output pair.
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Automation
Automation overview
Automation is the process of writing changes to various controls in your session over time, that are then played back as
the session is played back, when track automation is enabled. Most parameters on a track can be automated.
This section covers:
•
•
•
•
•
•

Automation modes
Automating volume
Automating panning
Automating plug-in parameters
Automating extension controls
Automating MIDI Continuous Controllers for an Instrument

Automation modes
LUNA has the following automation modes.

Automation Mode

Description

Off

Do not play back automation that is written on the track.

Read

Play back all automation that is written on the track.

Touch

Plays back the track and any written automation, but begins to write
automation as soon as you touch an automatable control. For example, if you
touch a volume fader that is or is not already automated, automation data is
written as long as you touch or move the fader.
Use Touch to write initial automation to a track, to write precise control
automation, or to “touch up” existing automation.
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Latch

Latch automation mode reads automation and writes it just as Touch.
However, Latch “latches” at the point you release the control, and remains in
that position until it is touched again, until playback stops, or until the loop
restarts.
Use Latch when you want to write automation and then leave the control at a
specific value. For example, if you want to ramp up a clip’s volume, then leave
the volume at a set position for the remainder of a section, use Latch.

Trim

Use Trim when you want to preserve automation, but want to raise or lower the
overall level of the automation. When you set a track to Read Trim mode,
indicated on the track as Read (T), the fader changes color to indicate that it is
in Trim mode. When in Trim mode, the volume fader for a track does not move
to indicate track automation. The fader allows you to change the overall level,
while the underlying automation is preserved.
In Trim mode, LUNA can also still be in Touch or Latch mode. These modes are
indicated as Touch (T) and Latch (T). Trim modes allow you to write level
changes to the automation with Trim behavior, without completely overwriting
the automation. For example, you can reduce or increase the overall level of an
automation pass, while still preserving the underlying automation, by using
Latch Trim or Touch Trim. Touch Trim writes the trim adjustment to the
automation as long as you hold the fader, then returns to the previous Trim
level when you release the fader. Latch Trim writes the trim adjustment to the
automation, but continues to write automation at the trimmed level where you
release the fader until playback or until the loop restarts.
You can write Trim automation using the Volume fader in the Mixer or on the
Focus channel in the Timeline. All non-trimmable controls still write control
changes in either Touch or Latch mode. Trim automation is only available on
Volume.

Selecting an item or items to automate
The View browser for a track (accessed from Timeline view) shows the items you can automate. For an audio track, this
is volume, mute, and mono or stereo pans, and the controls for any plug-ins on the track. For an Instrument track, this is
volume, mute, and mono or stereo pans, plus all the MIDI Continuous Controllers (CCs) of the Instrument plug-in, and
controls for any plug-ins on the track.
Plug-ins on audio and Instrument tracks also have controls that can be automated. The browser shows all automatable
parameters for all plug-ins on a track. When automation has been added, the View browser highlights any automated
parameter in yellow.
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Drawing automation
For precise editing of automation, you can draw automation. Double-click anywhere on a track that is showing an
automatable control to add an automation breakpoint. You can draw automation anywhere on a track on the timeline,
including in places where there are no clips. When you draw automation, the automation points you add snap to the
grid if Snap is enabled. To draw automation without snapping to the grid, press Command while drawing automation.

To draw automation on an audio or Instrument clip:
1. In Timeline view, click View, and choose the parameter for which you want to draw automation (for example,
Volume). Note that you may have to expand the Output in the View browser to see the controls that can be
automated. The audio or MIDI clip shows a line for the automatable parameter.
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2. To add a single automation point, double-click. to add multiple automation points, press Control and hover over
the clip. The cursor changes to the Pencil Editing Tool.

3. While you hold Control, click the points you want to add on the automation line. Hold Control and drag to draw
automation across the track.

4. To draw automation without snapping automation points to the grid, press Control+Command while drawing
automation.

5. To clear an automation point, hold Control and hover over an automation point. The cursor changes to the
Eraser Editing Tool (the pencil turns around). Click an automation point to remove it.

Automation – 243

LUNA User Documentation v200731

6. To clear a range of automation, select the range on the audio or Instrument track, and press Delete.

Your automation changes are played back when the session plays the clip, when an Auto Mode is enabled. When Auto
Mode is Off, automation is ignored.

Writing volume automation with the volume fader
You can write automation with a track control, such as a pan control or volume fader. Automatable controls do not
require that you enable recording for automation. Setting a write automation mode (Touch or Latch) for a track
automatically enables you to write automation for any automatable control. Automation is written from the time you
touch a control until you release the control, playback stops, the loop restarts, or you switch LUNA automation modes.
If you are writing Touch automation, releasing the fader stops writing automation and returns the fader to the previous
level (before you started writing automation). If you are writing Latch automation, the fader remains at the release
level.
Note: You can write volume automation on an audio track, an Instrument track, a bus track, or the Main track. On an
Instrument track, you can write Volume automation for the track Output, or other types of volume automation for
controls in the Instrument plug-in or for Continuous Controllers (CCs).
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To write volume automation:
1. On the Focus channel in the Timeline, or on the track in the Mixer, set the track for which you want to automate
volume to either Touch or Latch mode.
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2. To view the results of your automation, and to edit the automation, switch the track view to Volume. In the track
control area in the Timeline, click View, then from the browser choose Volume.
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3. Make a selection or place the playhead where you want to start playback.
4. Press Play or the Spacebar.
5. As the track plays, adjust the volume. Volume automation is written to the track.

6. To stop writing automation, press the Stop button or the Spacebar, or release the fader. Automation also stops
writing when playback stops (for example, at the end of a selection).
If you are writing Touch automation, release the fader to stop writing automation and return the fader to the previous
level (before you started writing automation). If you are writing Latch automation, the fader remains at the release
level.

Writing pan automation
Pan automation is represented on a horizontal line, with the center being unpanned, above the center panning
increasing to the left, and below the center panning increasing to the right.
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To write pan automation:
1. In the Track controls on the Timeline, on the Focus channel in the Timeline, or on the track channel strip in the
Mixer, set the track for which you want to automate panning to either Touch or Latch mode.

Automation – 248

LUNA User Documentation v200731

2. To view the results of your automation, and to edit the automation, switch the track view to Pan. In the track
control area in the Timeline, click View, then from the browser choose Pan.
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3. Make a selection or place your cursor where you want to start playback.
4. Press Play or the Spacebar.
5. As the track plays, adjust the pan control in the mixer or on the track. Pan automation is written to the track.
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6. To stop writing automation, press the Stop button or the Spacebar, or release the fader. Automation also stops
writing when playback stops (for example, at the end of a selection).
If you are writing Touch automation, release the fader to stop writing automation and return the fader to the previous
level (before you started writing automation). If you are writing Latch automation, the fader remains at the release
level.

Automating plug-in parameters
You can edit automation for any plug-in assigned to a track. All automatable plug-in parameters appear in the track’s
View browser.

To write plug-in automation:
1. On the Track control area in the Timeline, click View, then from the browser choose the plug-in parameter to
automate. On the track, the plug-in parameter line appears.
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2. To add automation points, press Control and hover over the track. The cursor changes to the Pencil Editing Tool.

3. While you hold Control, click the points you want to add on the automation line. Hold Control and drag to draw
automation across the track.
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4. To draw automation without snapping automation points to the grid, press Control+Command while drawing
automation.

5. To clear an automation point, hold Control and hover over an automation point. The cursor changes to the
Eraser Editing Tool (the pencil turns around). Click an automation point to remove it.

6. To clear a range of automation, select the range on the audio or Instrument track, and press Delete.
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Your automation changes are played back when the session plays the clip and Automation is enabled. When Auto Mode
is Off, automation is ignored.

Automating LUNA Extension controls
You can write automation for any LUNA Extension assigned to a track. All automatable LUNA Extension controls are
listed in the track’s View browser.

To write LUNA Extension automation by adjusting a control:
1. On the track controls, set the track for which you want to automate LUNA Extension controls to either Touch or
Latch mode.
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2. To see the results of your automation in the timeline during playback, click View on the track controls, and from
the View browser, select the control for which you want to view automation.
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3. Press the Spacebar or play on the transport. While the track is playing, adjust the control you want to automate.
4. Press the Spacebar or stop on the transport to stop writing automation.
If you selected the control in the View browser, you can see the control automation while it is being written, and see the
automation results after it is written.
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To write LUNA Extension automation manually:
1. On the Track control area in the Timeline, click View, then from the browser choose the LUNA Extension control
to automate. On the track, the LUNA Extension control line appears.
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2. To add automation points, press Control and hover over the track. The cursor changes to the Pencil Editing Tool.
You can also double-click to add an automation point at the cursor.
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3. While you hold Control, click the points you want to add on the automation line. Hold Control and drag to draw
automation across the track. To adjust a single automation point, click and drag.

4. To draw automation without snapping automation points to the grid, press Control+Command while drawing
automation.

5. To clear an automation point, hold Control and hover over an automation point. The cursor changes to the
Eraser Editing Tool (the pencil turns around). Click an automation point to remove it.
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6. To clear a range of automation, select the range on the audio or Instrument track, and press Delete.

Your automation changes are played back when the session plays the clip and Automation is enabled. When Auto Mode
is Off, automation is ignored.

Automating a MIDI Continuous Controller
You can edit automation for any MIDI Continuous Controller (CC) on an Instrument track. All automatable CC messages
appear in the track’s View browser.
Note: you can edit all MIDI CCs supported by the Instrument, even if the CC is not used in a program.
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To write MIDI CC automation:
1. Enable the MIDI CC view by clicking the MIDI CC icon on a clip on the Instrument track.

2. On the Track control area in the Timeline, click the CC Controller button (this defaults to Volume), then from the
browser choose the MIDI CC to automate. Below the MIDI piano roll, the MIDI CC line appears.

3. To add automation points, press Control and hover over the CC track. The cursor changes to the Pencil Editing
Tool.
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4. While you hold Control, click the points you want to add on the automation line. Hold Control and drag to draw
automation across the track.

5. To draw automation without snapping automation points to the grid, press Control+Command while drawing
automation.
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6. To clear an automation point, hold Control and hover over an automation point. The cursor changes to the
Eraser Editing Tool (the pencil turns around). Click an automation point to remove it.
7. To clear a range of automation, select the range on the audio or Instrument track, and press Delete.
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Your automation changes are played back when the session plays the clip and Automation is enabled. When Auto Mode
is Off, automation is ignored.

Trimming automation
Trimming automation is the process of adjusting a range of automation data. You can trim a selection, a segment (the
line between two automation points), or all automation on a clip.

Show automation
Before you trim automation, you must show the automation in the Timeline that you want to trim.
• Click View on the track to select the automated control you want to adjust.
Tip: Automated controls are highlighted in the Focus Browser.

• To adjust a MIDI CC, open the MIDI CC view and choose the MIDI CC from the Track controls panel.
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To trim all automation on a clip:
1. Hover the cursor over the automation line on the clip. The Automation Trim Editing Tool appears.
Note that the cursor must be between automation points, and you may have to zoom in to place the cursor.
2. Click on the automation line and move the automation up or down to trim.

Note: Automation is trimmed for the entire clip. Automation breakpoints are added at the start and end of the clip.
To trim an automation selection:
1. Make a selection on the track or CC automation line.
2. Hover the cursor over the automation line on the clip or CC track. Make sure the cursor is over the automation
line and not an automation point. The Automation Trim Editing Tool appears.
3. Click on the automation line and move the selected automation up or down to trim.
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To trim an automation segment:
1. Hover the cursor over an automation segment on the clip. The Automation Trim Editing Tool appears.
2. Click on the automation segment and move the segment up or down to trim.

Tip: You may have to zoom in to trim an automation segment instead of the entire clip. You can only trim an
automation segment when it has no slope (it begins and ends on the same value).

Clearing all automation for a selection
To clear all automation data within a selection, make a selection on one or more tracks in the timeline, then choose Edit
> Clear All Automation. When you clear automation for a selection, breakpoints are added at the beginning and end of
the selection, if automation extends beyond the selection. This command clears automation for all controls and CCs for
the selection.
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Working with Sessions
Creating a New Session
To create a new empty session:
1. On the Create Session panel, type a name for the session.
2. Specify a tempo and time signature for the session, or accept the defaults. Note that you can change the tempo
and meter after you create the session.
3. To find the approximate tempo, you can tap the Tap button in time four or more times.
4. Click the Location bar to open a dialog where you can choose the location for the session file, or accept the
default location.
5. When you have configured the new session settings, click Create.
A new session is created in a parent folder of the same name. When you export files, an Exported Files folder is created
in this folder. This folder is the default location for any files exported from the session.
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To create a new session from the main LUNA window, choose File > New (or use the Command+N shortcut) from the File
menu.

To open an existing session, either:
• Click the session name in the Recent list, and click Open, or
• Click Open From Disk… and select the session, then click Open.

To clear the recent sessions list, either:
• Right-click in the Recent sessions list and select Clear Recent.
• Or choose File > Open Recent > Clear Recent List from the LUNA menus.

Importing an AAF Session
AAF (Advanced Authoring Format) is used by DAW and video applications such as Avid Pro Tools and Adobe Premiere to
exchange sessions. LUNA can create new sessions using the AAF file, the audio files generated when the AAF is exported,
and a multi-track MIDI file generated with the AAF file.

What is imported
When you export or import an AAF file, you can exchange multiple audio tracks with their time positions, fades, and
track names. Automation, panning, master tracks, buses, and plug-ins are not included in an AAF file.
To create a session from an AAF file:
1.
2.
3.
4.
5.
6.

On the Create Session panel, type a name for the session.
Click the Start From AAF button.
From the dialog that opens, choose the AAF session to import.
Type a name for the session.
Specify a tempo for the session, or click the MIDI button, and choose a MIDI file to import.
Click the Location bar to open a dialog where you can select the location for the session, or accept the default
location.
7. When you have configured the new session settings, click Create.
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Accelerated Realtime Monitoring
Accelerated Realtime Monitoring™ (ARM) is a deep hardware, DSP, and software integration feature inside LUNA that
allows you to achieve the lowest possible latency while recording with UAD plug-ins in real time.
For those familiar with Apollo’s Console software, ARM eliminates the need to use the Console app altogether, while
providing all of the same features and benefits such as low latency plug-ins, input routing, cue mixing, and others.
You can turn ARM on or off globally. Use ARM to achieve the lowest possible input monitoring latency when you monitor
input signals through LUNA outputs, including monitors, headphones, and cues.
Note: ARM is not supported at 4x sample rates (176.4 kHz and 192 kHz).

Enabling ARM
ARM is enabled system-wide. When you enable ARM, all ARM components are affected, including audio tracks,
Instrument tracks, and ARM Aux-enabled buses.

To enable ARM:
•
•
•
•

Click the Toggle ARM Mode button in the Global settings at the top of the LUNA window, or
Click the ARM toggle in Mixer view to the left of the track record/input enable controls, or
Choose Transport > Accelerated Realtime Monitoring from the LUNA menus, or
Click the ARM button in the Record Workflow (see “Using Workflows”).
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To enable a bus to use an ARM Aux:
1.
2.
3.
4.

Enable ARM.
On the Bus track in Mixer view, click the ARM button.
From the Accelerated Realtime Monitoring drop menu, select an ARM Aux to assign the bus.
To bypass an ARM Aux for the bus, select None.

Using ARM with audio tracks
When ARM is enabled, record or input-enabled audio tracks are accelerated through Apollo’s DSP, which provides nearzero latency.
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Only UAD plug-ins can be monitored on an input or record-enabled audio track when Accelerated Realtime Monitoring
is enabled. Audio Unit plug-ins can be inserted, but remain disabled until the track is record or input-disabled, or ARM is
disabled.
When recording in ARM mode, all Record FX and Unison inserts are active. UAD plug-ins in the first four standard insert
slots are enabled when a track is record-enabled or input-enabled. All eight inserts and insert slots are enabled when
ARM is disabled or when the track is record-disabled or input-disabled. Any Audio Unit plug-ins on these tracks are
bypassed.
LUNA and ARM control the muting and unmuting of Apollo input channels used on audio tracks. Apollo input channels
that are used on record-enabled or input-enabled tracks are unmuted, and all other Apollo input channels are muted.

Using ARM with Instrument tracks
When ARM Is enabled, LUNA Instruments and Audio Unit instruments automatically run at a low host buffer and then
are automatically routed to the Apollo for low latency plug-in processing and routing.
When you record on an Instrument track, you can use ARM Mode to get the fastest response from UAD plug-ins that
process audio on the Instrument track. When ARM is enabled, you can use Audio Unit plug-ins on Instrument tracks that
are record or input-enabled.

Using ARM with bus tracks
ARM supports two low latency auxiliary (AUX) buses, which are typically used for monitoring time-based effects such as
reverb or delay in real time. Any two buses in the LUNA session can be declared as ARM AUXes. The two declared AUXes
use Console’s AUX engine. These AUXes should have a UAD plug-in instantiated, and the sends must be correctly routed
within the LUNA Mixer.
To set ARM Mode for a bus track, enable ARM, then click the ARM button on the bus track and select either Aux 1 or Aux 2
from its drop menu. When LUNA is in ARM mode, only the two ARM-enabled aux buses receive input from record or
input-enabled tracks.

Notes for ARM with bus tracks
• When LUNA is in ARM mode, tracks that are routed directly to buses while record or input-enabled do not play
through the bus. Instead, they play through the Main output.
• To avoid additional latency, ARM Aux buses are not phase-aligned, and are therefore recommended only for
time-based effects such as reverb and delay.

LUNA buffers, latency, and delay compensation
LUNA controls hardware I/O buffer settings during recording and playback automatically. The system buffer size for
audio and bus tracks is 512 samples. In ARM mode, when an audio track is record or input-enabled, or audio is routed to
an ARM AUX-enabled bus, the buffer for that audio is near zero.
Instruments are played at a fixed 128 sample buffer, regardless of ARM mode.
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All audio and Instrument tracks are automatically delay-compensated on playback to sync tightly with pre-existing
material.

Components affected by ARM
The following components are affected when you enable or disable Accelerated Realtime Monitoring.
LUNA App
Item

ARM Disabled

ARM Enabled (and Record/Input Enabled)

Audio
tracks with
Apollo
hardware
inputs

LUNA manages signal flow.

Audio tracks use Apollo DSP resources to achieve the
lowest possible latency to the Apollo Monitor and CUE
outputs, up to the supported number of ARM channels.

Instrument
tracks

LUNA Instruments, Audio Unit
instruments, UAD plug-ins, and Audio
Unit plug-ins are supported.

LUNA Instruments, Audio Unit instruments, UAD plugins, and Audio Unit plug-ins are supported.

ARM Aux
1-2

LUNA manages signal flow.

Aux tracks use Apollo DSP resources to achieve the
lowest possible latency to the Apollo Monitor and CUE
outputs, up to the supported number of ARM channels.

Cues

LUNA manages signal flow.

Cues use Apollo DSP resources to achieve the lowest
possible latency to the CUE outputs, up to the supported
number of ARM channels.

UAD
Powered
Plug-Ins

UAD plug-ins are active and process
audio, as long as there are available DSP
resources. UAD plug-ins can be active in
the Unison insert, up to four RECORD FX
inserts, and up to eight standard inserts.
UAD plug-ins in the Unison and RECORD
FX inserts are always recorded to disk.

UAD plug-ins are active and process audio, as long as
there are available DSP resources. UAD plug-ins can be
active in the Unison slot, up to four RECORD FX slots, and
up to four standard insert slots. Plug-ins in the Unison
slot and RECORD FX slot are recorded to disk. Plug-ins in
standard insert slots 5-8 are disabled.
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LUNA
Extensions:

Extensions are active and process audio,
but are not recorded to disk.

Extensions are deactivated. Extensions resume
processing when ARM is disabled.

Audio Unit plug-ins are active and
process audio. Audio Unit plug-ins can
be used in standard inserts only.

Audio Unit plug-ins (except virtual instruments) are
deactivated on Audio and Bus tracks. Audio Unit plug-ins
can be instantiated, however they are made inactive and
a notification shows. Audio Unit plug-ins resume
processing when ARM is disabled.

Tape, Neve
Summing

Audio Unit
plug-ins

Available ARM resources
The system indicates the number of ARM channels available to assign to record- or input-enabled inputs at all times.
These channels are used for playback and enabled seamless punch-in. This number decreases when ARM is enabled
and you record- or input-enable one or more tracks.
ARM channels use the DSP in your Apollo interface. The number of available ARM channels depends on the physical
inputs in your system.
UA Interface Model

Available ARM Channels

Apollo Rack Models (except Silver)

16

Apollo Silver

10

Apollo x4

12

Apollo Twin

10

Arrow

2

How ARM resources are used
• An audio track that is record-enabled or input-enabled requires one mono ARM resource per channel (one for a
mono track, two for a stereo track).
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• A bus that is fed by a record-enabled or input-enabled track, and is assigned to ARM Aux 1 or Aux 2, requires two
mono (one stereo) ARM resources.
Example: A stereo audio track that is routed to two ARM-enabled buses requires six mono (three stereo) ARM resources,
whereas a mono audio track with no ARM-enabled bus assignments consumes one mono ARM resource.
To view available ARM resources, enable ARM, and toggle the Record workflow on.

Accelerated Realtime Monitoring – 277

LUNA User Documentation v200731

Configuring LUNA Settings
You can configure settings for LUNA using the Setting screens, or by choosing LUNA > Preferences from the LUNA
menus.

Configuring the Session Autosave interval
To specify an automatic save interval:
1. Open the LUNA Sidebar by clicking the UA diamond logo on the left of the screen, and clicking Settings, or
choose LUNA > Preferences from the app menu.
2. Click Options.
3. In the Autosave Interval field under Miscellaneous in the Options panel, type an auto-save interval in minutes.

To revert to a previous autosaved version:
• From the LUNA app menu, select File > Revert To, and select a version to which to revert.

To save a session copy:
• From the app menus, choose File > Save a Copy As. Specify the location and filename, and click Save.

Setting the Hardware Sample Rate
LUNA can run a session at any supported hardware sample rate. The sample rate is displayed and selectable in the
Settings > Hardware Panel > Sample Rate menu, and also in the Rate menu at lower left of LUNA’s main window. You
can switch the sample rate of a session at any time, and LUNA will create temporary audio files to maintain the session
pitch and time.
To change the hardware sample rate from within a LUNA session:
1. Make sure the Info section is displayed (View > Section > Info).
2. At the lower right corner where the Rate is displayed, click the sample rate, and choose the new sample rate.
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To change the hardware sample rate from Hardware Settings:
1. At the left of the LUNA window, click the UA icon, then click Settings.
2. Choose the Hardware panel.
3. From the Sample Rate menu, select the new sample rate.

Choosing a Clock Source
The active clock source (Internal, ADAT, S/PDIF, or Word Clock) is displayed here. This area flashes red if the currently
selected clock is unresolved (when digital audio is not synchronized).

To choose a clock source:
1. At the left of the LUNA window, click the UA icon, then click Settings.
2. Choose the Hardware page.
3. From the Clock Source drop menu, choose the clock source.

Configuring the Digital Mirror setting
This setting configures the S/PDIF outputs (Apollo, Apollo 8/x8, Apollo 8p/x8p and Apollo x4) or AES/EBU outputs
(Apollo 16/x16) to mirror the Monitor 1 and 2 outputs. This feature is typically used when connecting to the stereo
inputs of other devices with digital inputs such as a speaker system, stereo recorder, or external D/A converter. When
Digital Mirror is ON, the Monitor Level knob controls both the digital output level and the analog monitor output level
(these digital outputs are post-fader when mirrored).

Configuring Input Delay Compensation
UAD plug-in latency can be automatically compensated with Input Delay Compensation (IDC). Input Delay
Compensation maintains phase alignment across all analog and digital inputs when UAD plug-ins that induce latency
are used in LUNA. For example, if you use two microphones on an acoustic source (such as a drum kit) and a latencyinducing UAD plug-in is used on one of the mic channels but not the other, without input delay compensation, the
phase of the two mic channels would no longer be aligned.
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Note: LUNA will give you a warning when this situation occurs.
To change the input delay compensation from Hardware Settings:
1. At the left of the LUNA window, click the UA icon, then click Settings.
2. Choose the Hardware page.
3. From the Input Delay Compensation menu, choose the input delay compensation value.

Setting

Description

Off

0 samples

Short

100 samples

Medium

200 samples

Medium-Long

300 samples

Long

1000 samples

For more information about Input Delay Compensation, see the Apollo Thunderbolt Software Manual.

Configuring Cue Buses
In addition to the main monitor stereo mix bus and the two auxiliary stereo mix buses, Apollo features up to four stereo
cue mix buses (two with Apollo Twin) that can be used for a variety of signal routing purposes.
The cue mix buses are used to create unique mixes that are separate from the main monitor mix. Cues are typically used
for performers that want to hear a headphone mix that is different from the main monitor mix, sending separate mixes
to other rooms or audio equipment, and similar applications.

To set the number of cue buses available in LUNA:
1. At the left of the LUNA window, click the UA icon, then click Settings.
2. Choose the Hardware panel.
3. From the Cue Buses menu, choose the number of cue buses (if available).
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Cue Labels
The cue labels vary per Apollo device model, as described below.
Apollo rack models and Apollo x4 – The cues are labeled CUE 1, CUE 2, CUE 3, and CUE 4 respectively.
Apollo Twin – With Apollo Twin, the two cues are labeled HP (headphone) and LINE 3/4 (line outputs 3 and 4) to reflect
the available hardware outputs on the device.

Cue Components
The complete cue system is comprised of the cue mix buses, the cue sends, and the cue outputs.
Cue Mix Buses – A cue mix bus is the summed stereo mix of individual audio signals. Signals are routed into the cue mix
buses via the cue send controls, and returned from the cue mix bus via the cue outputs controls.
Cue Sends – The cue sends adjust the individual channel signals going into the cue mix bus. Each input channel and aux
return contains individual level, pan,* and mute controls for each active cue mix bus. All cue sends are pre-fader and
pre-mute so they are not affected by adjustments to the main monitor mix.
Note: If two input channels are stereo-linked, the cue sends on the stereo pair cannot be panned. Sends for stereo
channels are hard-panned left and right.
Cue Outputs – Cue mix buses are returned via the Cue Outputs window, which is a matrix for routing the cues to
Apollo’s available hardware outputs.
Cue Monitoring – Available cue outputs also can be selected as a source for the main monitor outs via the Monitor
Output Options, enabling any cue mix bus to be heard in the main monitor speakers.

Cue Count
By default, two cues are displayed in Console (four with Apollo 16 and x16). Up to four cues are available with Apollo by
increasing the Cue Bus Count in the Hardware panel within the Console Settings window.

Configuring Alt Monitor Count
Apollo features Alt (alternate) monitoring capabilities. Alt monitoring can be used to control an alternate pair or pairs of
monitor speakers, which is convenient for quickly comparing how a mix sounds through a different set of speakers. Up
to two pairs of Alt monitors can be used (one pair with Apollo Twin).
To configure one or more Alt Monitor settings:
1. At the left of the LUNA window, click the UA icon, then click Settings.
2. Choose the Hardware page.
3. From the Alt Count menu, choose the number of Alt Monitor mixes.
Alt monitoring is enabled in Hardware Settings within the Settings window by increasing the Alt Count setting to a nonzero value.
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Alt Monitor Connections
Note: The Alt channel output assignments cannot be modified.
Apollo rack models and Apollo x4 – The Alt 1 monitor signal is routed to line outputs 1-2, and the Alt 2 monitor signal is
routed to line outputs 3-4.
Apollo Twin – The Alt monitor signal is routed to line outputs 3-4.
See the Apollo Software manual for more information.

Configuring Devices
You can set digital input and output formats, output reference level, and configure line inputs to bypass preamps. You
can also configure channel DSP pairing, and easily identify devices.

Setting Digital Input formats (Apollo Twin, Apollo 8p, Apollo x8p, Apollo x4)
1. At the left of the LUNA window, click the UA icon, then click Settings.
2. Choose the Hardware panel.
3. From the Digital Input menu, choose the digital input format.
This menu selects the digital input type (ADAT or S/PDIF) to be used by the TOSLINK optical connector and Console’s
digital input channels.
Optical S/PDIF digital input is supported at sample rates up to 96 kHz. If the current setting is ADAT and the sample rate
is higher than 96 kHz, when S/PDIF input is selected, the clock source is changed to Internal and the S/PDIF inputs are
no longer available.

Setting Digital Output formats (Apollo 8p, Apollo x8p, Apollo x4)
1. At the left of the LUNA window, click the UA icon, then click Settings.
2. Choose the Hardware page.
3. From the Digital Output menu, choose the format of the digital output.
This menu selects the digital output type (ADAT or S/PDIF) to be used by the TOSLINK optical connector and Console’s
digital outputs channels.
Optical S/PDIF digital output is supported at sample rates up to 96 kHz. If the current setting is ADAT and the sample
rate is higher than 96 kHz, when S/PDIF input is selected, the clock source is changed to Internal and the S/PDIF outputs
are no longer available.

Setting Output Reference Levels
Use the Output Reference Levels section for each interface to set reference level for the line outputs. The number of
menus displayed depends on the currently connected Apollo hardware (for example, Apollo 16, which features more
outputs, will display more output menus).

Configuring LUNA Settings – 282

LUNA User Documentation v200731

The line output reference levels can be set to –10 dBV or +4 dBu in adjacent pairs. The value is usually set to match the
nominal input level of devices connected to these outputs (a setting of +4 dBu outputs a higher signal level than –10
dBV).
With Apollo X Series rackmount interfaces, you can set output reference levels to +24 dBu in LUNA Settings for operating
level compatibility with professional mixing consoles and other high-end pro audio equipment.

Allowing Line Input Gain
By default, line inputs on preamp channels are routed through the channel’s preamp so the line input level can be
adjusted with the Gain knob. However, preamp channel line inputs can be individually set to completely bypass the
channel’s preamp circuitry and instead operate at a fixed reference level.
Use this feature to route the preamp channel’s line input signal directly into the D/A converter for the purest path when
additional gain is not needed (for example, when connecting external mic preamps to preamp channel line inputs).
Two settings are available:
• On – The line input is routed through the channel’s preamp
• Bypass – The preamp and associated circuitry are bypassed.The Preamp Gain Indicator ring for the channel is lit
solid green. If a Unison plug-in is on a track that uses this channel’s line input, the Unison plug-in is bypassed.

Configuring Channel DSP Pairing
Channel DSP Pairing allows multiple UAD plug-ins that are inserted in a single LUNA track to span across two paired
DSP cores. This feature effectively doubles the amount of Realtime UAD Processing DSP loading that is available on a
single input.
Note: Channel DSP Pairing changes the way available DSP resources are allocated. The feature does not increase the
total amount of available DSP.
When enabled (the default setting), Channel DSP Pairing is automatic. Simply insert UAD plug-ins in tracks as usual, and
input DSP resources are automatically distributed across DSP pairs as efficiently as possible.
Note: Individual UAD plug-ins must fit within a single DSP core, even when Channel DSP Pairing is available. A single
UAD plug-in cannot span across paired DSPs.
A maximum of two DSP cores can be paired with a single Apollo input. More than one DSP pair can be allocated, so
multiple Apollo inputs can take advantage of the feature.
The number of available DSP pairs is adjustable. Apollo rackmount models can be set to a maximum of four available
DSP pairs (default value of 2), while Apollo Twin models have a maximum of two available pairs (default value of one).
As the DSP Pairs value is increased, the Virtual Channels value is decreased. This reciprocal action sets how Apollo’s
internal DSP resources are allocated.
For more details, see the Apollo Thunderbolt Software Manual.
To configure Channel DSP Pairing:
1. At the left of the LUNA window, click the UA icon, then click Settings.
2. Choose the Hardware page.
3. Under Channel DSP Pairing, move the slider to balance DSP Pairs with Virtual Channels.
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Identifying Devices
Click the Identify switch to cause the currently selected unit’s front panel LEDs to flash in a pattern. This feature is
typically used with multi-unit systems to distinguish units when making I/O connections.

Setting up the I/O Matrix
Use the I/O Matrix panel is where custom I/O routings for Core Audio are managed at the driver level. For an overview of
I/O Matrix features, see the Apollo Thunderbolt Software Manual.

Setting Display Options
To set display options, open the LUNA Sidebar, and click Settings.

Configuring Pre or Post Fader Metering
1. Click the Options tab.
2. From the Metering popover, choose Post-Fader or Pre-Fader.
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Setting Clip Holds
1. Click the Options tab.
2. From the Clip hold popover, choose the clp hold duration. To clear meter clips to clear immediately, choose
None. If meter clips should persist for the entire time a session is open, choose Infinite. You can also choose a
duration in seconds from the available options.

Setting Peak Holds
1. Click the Options tab.
2. From the Peak Hold popover, choose the duration that peaks on LUNA meters should remain.

Showing Device Names
1. Click the Options tab.
2. From the Show Device Names popover, choose Off or On.

Configuring Editing Options
You can configure the default fade shape and length, and set the controls mode.

Configuring the default fade shape
From the Fade Shape menu, you can configure the default fade shape as Equal Power or Equal Gain.
Equal Gain is the default mode, and it works better for phase-coherent material, for example when fading between clips
from the same guitar track or drum track. Equal Power mode works better for material that is less similar, dissimilar, or
not phase-coherent, for example two different vocalists or two different guitar recordings.

Configuring the default fade length
Configure the default fade length to specify the default length of any fade that is created automatically. For example, if
you select a range of audio with edits in it, and select Edit > Create Fades (Command+F), this value determines the
length of the fades created.
Note: This value specifies the total length of the default fade or crossfade, so with the default setting of 100ms, the
length of a fade in or fade out is 100ms, and the length of a crossfade is 100ms, or 50ms on each side of the crossfade.

Setting Controls Mode
This setting determines how LUNA knobs and UAD plug-in parameter knobs respond to adjustment. Three control
modes are offered: Circular, Relative Circular, and Linear. The behavior of each mode is described below.
• Linear (slider) – In Linear mode, the knob is adjusted by dragging horizontally or vertically instead of by rotating.
This behavior is similar to moving a physical fader.
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• Circular (jump) – In Circular mode, the software knobs behave similar to physical rotary knobs. Values are
changed by clicking on the knob then rotating in a circular direction. When the edge of the knob is clicked, the
parameter value jumps to the mouse position.
• Relative Circular (grab) – Relative Circular mode operates similar to Circular mode, but the knob value does not
jump to the mouse position when clicked. Instead, the knob value is modified relative to its original value.
In Relative Circular mode, click anywhere on the knob to make an adjustment originating at the original value
(it’s not necessary to click on the current knob position).
Tip: To increase resolution when adjusting rotary controls in circular and relative circular modes, increase the radius of
the mouse relative to the knob while dragging (move the mouse farther away from the knob while dragging in a circular
motion).

Using Monitor, Control Room, and Talkback sections
The Monitor, Control Room, and Talkback sections show controls for monitoring and for using talkback on talkbackenabled Apollo units.

Viewing the Monitor strip
The meters on the Monitor strip display the signal levels of the monitor mix bus just before the monitor level control.
Levels displayed here mirror the state of the Monitor 1 – 2 LED meters on Apollo’s front panel. You can control the level
of the Monitor outs, switch to Mono, and Mute the Monitor outs.
From the Monitor strip, you can also open the Control Room strip and the Cue Outputs window.
To work with Cues, see “Making cue mixes.”
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To show the Monitor strip:
In the View section, click the Other Views icon and choose Mon, or from the app menu, choose View > Section > Monitor.
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Viewing the Control Room strip
The control room strip allows you to configure options for the monitor outputs.
By default, the control room column is not visible. To show the column, click Control Room on the Monitor strip, or
choose View > Section > Control Room from the app menu.
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Control Room Sources
Use the Source options to choose the source for the mix bus that is sent to Apollo’s monitor outputs. The source is
selected when its switch is lit.
The control room Source switches control the source that feeds the control room mix. The source can be the Monitor
mix or any of the available cues.
Use Dim to quickly reduce the listening volume in the control room by a set amount and quickly return to the prior
volume.
Alt Trims
The ALT trim controls are typically used to compensate for different levels of the alternate monitor speakers so they
have the same apparent volume as the main monitor speakers.
Note: ALT controls are only visible when the Alt Count menu in the Hardware panel within the Settings window is set to
a non-zero value.
Talkback strip
The talkback input channel strip is available in the Control Room module within Console whenever an Apollo model
featuring talkback is connected.
The talkback strip has eight UAD plug-in inserts for Realtime UAD Processing. All talkback plug-in inserts operate the
same way as other inputs.
Talkback sends display an overview of the talkback levels being sent to each available send bus, including Aux 1 and 2,
and 2 Cue mix buses.
To access the Talkback Sends Popover window, where individual talkback send levels are adjusted, click the Talkback
Sends Display.

Using Global Controls
Use global controls to toggle LUNA settings globally.

• To toggle record-enabled tracks globally, on the control bar in the Global section, click the Toggle Record
button. All record-enabled tracks are toggled out of record-enabled mode. Click Toggle Record again to toggle
the tracks back to record-enabled mode.
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• To toggle input-enabled tracks globally, on the control bar in the Global section, click the Toggle Input Enable
button. All input-enabled tracks are toggled out of input-enabled mode. Click Toggle Input Enable again to
toggle the tracks back to input-enabled mode.
• To toggle soloed tracks globally, on the control bar in the Global section, click the Toggle Solo button. All soloed
tracks are toggled out of solo mode. Click Toggle Solo again to solo the tracks.
• To toggle muted tracks globally, on the control bar in the Global section, click the Toggle Mute button. All muted
tracks are unmuted. Click Toggle Mute again to mute the tracks again.
• To toggle ARM mode, on the control bar in the Global section, click the Toggle ARM Mode button. The system is
ARM-enabled and any audio tracks that are record-enabled or input-enabled are put into ARM mode. To leave
ARM mode, click Toggle ARM Mode again.
• To clear meter clips globally, on the control bar in the Global section, click the Clear Meter Clips button. All meter
clips are cleared.

Viewing System Info
From the menu, select View > Section > Info.
The system info section is displayed at the bottom of the LUNA window.

This area displays the sample rate, clock source, DSP, CPU, and memory resource loads used by LUNA, including all
loaded UAD plug-ins (Console and DAW). UAD loads can be monitored as needed, for example when deciding which UAD
plug-ins to load, based upon how much DSP is available. Values displayed here are mirrored in the UAD Meter & Control
Panel application. More detailed display of DSP usage is available in the System panel within the UAD Meter & Control
Panel application.
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Keyboard Shortcuts and Menu Reference
LUNA Keyboard Shortcuts
Windows and Display
Feature

Modifier(s)

Key

Toggle Timeline/Mixer

Command

=

Next Window

Command

`

Previous Window

Command+Shift

`

Show/Hide Floating Windows

Shift

W

Close Floating Window

Command

W

New Window

Option+Command

N

New Alternate Window

Shift+Command

=

Toggle Full Screen

Command+Shift

F

Playback and Timeline
Feature

Toggle Playback

Modifier(s)

Key

Spacebar
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Feature

Modifier(s)

Key

Toggle Record

Command

Spacebar

Numeric Keypad 3

Restart Playback

Control+Option+Command

Spacebar

Loop Playback

Control

L

Numeric Keypad 4

Return To Zero

Toggle Pre/Post Roll

Return

Command

K

Toggle Metronome

Numeric Keypad 7

Create Marker

Enter

Zooming and Scrolling
Feature

Modifier(s)

Key

Auto Scroll

Command

A

Zoom In

Command

]

T

Zoom Out

Command

[
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Feature

Modifier(s)

Key

R

Frame Selection

E

Increase Selected Track Heights

Control

↑

Decrease Selected Track Heights

Control

↓

Increase All Track Heights

Control+Option

↑

Decrease All Track Heights

Control+Option

↓

Zoom In Audio Waveforms

Option+Command

]

Zoom Out Audio Waveforms

Option+Command

[

Reset Audio Waveform Zoom

Control+Option+Command

[

Scroll To Left Selection

Shift

←

Q

Scroll To Right Selection

Shift

→

W
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Record / Input / Solo / Mute
Feature

Modifier(s)

Key

Toggle Record Arm

Shift

R

Toggle Input Enable

Shift

T

Toggle Solo

Shift

S

Toggle Mute

Shift

M

Toggle Record

Command

Spacebar

Numeric Keypad 3

Discard Recording

Shift+Command

.

Editing and Fades
Feature

Modifier(s)

Clear

Key

Delete

Undo

Command

Z

Redo

Command+Shift

Z

Cut

Command

X

X
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Feature

Modifier(s)

Key

Copy

Command

C

C

Paste

Command

V

V

Duplicate selection

Command

D

Shift Cut

Shift

X

Shift Paste

Shift

V

Shift Duplicate

Shift

D

Shift Insert

Shift

I

Shift Clear

Shift

Delete

Mute Selection

Command

M

Create Fades

Command

F

Fade To Clip Start (Fade In)

Control

D

D

Fade To Clip Stop (Fade Out)

Control

G
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Feature

Modifier(s)

Key

G

Trim From Clip Start

A

Trim From Clip End

S

Trim Clip to Selection

Command

T

Separate Selection

Command

E

B

Consolidate Selection

Option+Shift

3

Heal Separation

Command

H

Export Mixdown

Option+Command

B

Export Clips

Command+Shift

K

Generate Sinewave in Selection

Control+Option+Shift

3

Control+Option+Shift

#
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Making Selections
Feature

Modifier(s)

Key

Select All

Command

A

Set Selection Start (while stopped or playing back)

↓

Set Selection End (while playing back)

↑

Moving Selections
Feature

Modifier(s)

Key

Move Selection Up

P

Move Selection Down

;

Move Selection to Next Bar

]

Numeric Keypad 2

Move Selection to Previous Bar

[

Numeric Keypad 1

Move Selection To Next Clip Edge

'

Move Selection To Previous Clip Edge

L

Move Selection To Next Transient

Tab
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Feature

Modifier(s)

Key

Option

‘

Option

Tab

Option

L

Move Selection To Next Marker

Control+Option

'

Move Selection To Previous Marker

Control+Option

L

Loop Select

Command+Shift

L

Move Selection To Previous Transient

Extending Selections
Feature

Modifier(s)

Key

Extend Selection Up

Shift

P

Extend Selection Down

Shift

;

Extend Selection To Next Bar

Shift

]

Shift

Numeric Keypad 2

Shift

[

Shift

Numeric Keypad 1

Shift

'

Extend Selection to Previous Bar

Extend Selection To Next Clip Edge
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Feature

Modifier(s)

Key

Extend Selection To Previous Clip Edge

Shift

L

Extend Selection To Next Transient

Shift

Tab

Option+Shift

‘

Option+Shift

Tab

Option+Shift

L

Extend Selection to Next Marker

Shift+Control+Option

'

Extend selection to Previous Marker

Shift+Control+Option

L

Extend Selection To Session Start

Shift

Return

Extend Selection To Session End

Option+Shift

Return

Extend Selection To Previous Transient

Tracks and Versions
Feature

Modifier(s)

Key

Toggle Selection Grouping

Command

G

New Tracks

Shift+Command

N

New Instrument Track (with Shape)

Shift+Command

I

Create Bus

Shift+Command

B
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Feature

Modifier(s)

Key

Import

Command

I

Duplicate Tracks

Option

D

New Version On All Tracks

Control+Option

\

New Version On Selected Tracks

Control+Option+Shift

|

Duplicate Version For All Tracks

Control+Option+Command

\

Duplicate Version On Selected Tracks

Control+Option+Command+Shift

|

Find Track

Option+Command

F

Toggle Selected Track Views

Control+Command

←,→

Toggle All Track Views

Control+Option+Command

←,→

Grid
Feature

Modifiers(s)

Key

Increase Grid

Shift

=

Decrease Grid

Shift

Toggle Snap To Grid

Shift

\

Toggle Relative Grid Snap

Command+Shift

\

•
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Feature

Modifiers(s)

Key

Align Bar

Option+Command

I

MIDI
Feature

Modifier(s)

MIDI Merge

Key

Numeric Keypad 9

MIDI Keyboard Mode

Option+Command

M

Open Quantize Browser

Command+Shift

U

Quantize Selection

Command

U

Pitch Selected MIDI Notes up One Semitone

Shift

↑

Pitch Selected MIDI Notes down One
Semitone

↓

Pitch Selected MIDI Notes up One Octave

Shift

↑

Pitch Selected MIDI Notes down One Octave

Shift

⇩

Nudge MIDI Note Left

,

Nudge MIDI Note Left 2X

M

Nudge MIDI Note Right

.
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Feature

Modifier(s)

Nudge MIDI Note Right 2X

Key

/

Sessions and LUNA
Feature

Modifier(s)

Key

New Session

Command

N

Open Session

Command

O

Close Session

Command+Shift

W

Save Session Copy

Command+Shift

E

Browse All Recent

Option+Command

O

Quit

Command

Q

Show Settings

Command

F5

Command

,

All Keyboard Shortcuts (Alphabetical)
Feature

Modifier(s)

Key

Align Bar

Option+Command

I

Auto-Scroll

Shift

A
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Browse All Recent

Option+Command

Clear

O

Delete

Close

Command

W

Close Session

Command+Shift

W

Consolidate Selection

Option+Shift

3

Option+Shift

#

Command

C

Copy

C

Create Bus

Command+Shift

B

Create Fades

Command

F

F

Create Marker

Cut

Enter

Command

X

X

Decrease All Track Heights

Control+Option

↓
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Decrease Grid

Shift

•

Decrease Selected Track Heights

Control

↓

Discard Recording

Shift+Command

.

Duplicate (Track or tracks)

Option

D

Duplicate Selection

Command

D

Duplicate Version For All Tracks

Control+Option+Command

\

Duplicate Version On Selected Tracks

Control+Option+Command+Shift

|

Export Clips

Command+Shift

K

Export Mixdown

Option+Command

B

Extend Selection Down

Shift

;

Extend Selection To Next Bar

Shift

]

Shift

Numeric Keypad 2

Extend Selection To Next Clip Edge

Shift

'

Extend Selection to Next Marker

Shift+Control+Option

'

Extend Selection To Next Transient

Shift

Tab

Option+Shift

‘

Keyboard Shortcuts and Menu Reference – 305

LUNA User Documentation v200731

Extend Selection to Previous Bar

Shift

[

Shift

Numeric Keypad 1

Extend Selection To Previous Clip Edge

Shift

L

Extend selection to Previous Marker

Shift+Control+Option

L

Extend Selection To Previous Transient

Option+Shift

Tab

Option+Shift

L

Extend Selection To Session End

Option+Shift

Return

Extend Selection To Session Start

Shift

Return

Extend Selection Up

Shift

P

Fade To Clip Start

Control

D

D

Fade To Clip Stop

Control

G

G

Find Track

Option+Command

F

Frame Entire Session (fit session to screen)

Control+Option+Command

↓

Control+Option+Command

↑
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Frame Selection (fit selected tracks to screen)

Generate Sinewave in Selection

E

Control+Option+Shift

3

Control+Option+Shift

#

Heal Separation

Command

H

Hide Window

Shift

W

Import...

Command

I

Increase All Track Heights

Control+Option

↑

Increase Grid

Shift

=

Increase Selected Track Heights

Control

↑

Input Enable Toggle

Shift

T

Loop Playback

Control

L

Numeric Keypad 4

Loop Select

Command+Shift

MIDI Merge

MIDI Keyboard Mode

Move Selection Down

L

Numeric Keypad 9

Option+Command

M

;
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Move Selection to Next Bar

]

Numeric Keypad 2

Move Selection To Next Clip Edge

Move Selection To Next Marker

'

Control+Option

Move Selection To Next Transient

'

Tab

Option

Move Selection to Previous Bar

‘

[

Numeric Keypad 1

Move Selection To Previous Clip Edge

L

Move Selection To Previous Marker

Control+Option

L

Move Selection To Previous Transient

Option

Tab

Option

L

Move Selection Up

P

Mute Selection

Command

M

Mute Toggle

Shift

M

New Instrument

Command+Shift

I
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New Session

Command

N

New Tracks

Command+Shift

N

New Version On All Tracks

Control+Option

\

New Version On Selected Tracks

Control+Option+Shift

|

New Window

Option+Command

N

Next Version (in Versions browser)

Shift

↑

Next Window

Command

`

Nudge MIDI Note Left

,

Nudge MIDI Note Left 2X

M

Nudge MIDI Note Right

.

Nudge MIDI Note Right 2X

/

Open Quantize Browser

Command+Shift

U

Open Session

Command

O

Paste

Command

V

V

Previous Version (in Versions browser)

Shift

↓
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Previous Window

Command+Shift

`

Pitch Selected MIDI Notes up One Semitone

Shift

↑

Pitch Selected MIDI Notes down One Semitone

↓

Pitch Selected MIDI Notes up One Octave

Shift

↑

Pitch Selected MIDI Notes down One Octave

Shift

⇩

Quantize Selection

Command

U

Quit

Command

Q

Record Arm Toggle

Shift

R

Redo

Command+Shift

Z

Redo Selection

Command

→

Reset Audio Waveform Zoom

Control+Option+Command

[

Restart Playback

Control+Option+Command

Spacebar

Return To Zero

Return

Save Session Copy

Command+Shift

E

Scroll To Left Selection

Shift

←

Q
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Scroll To Right Selection

Shift

→

W

Select All

Command

A

Selection Grouping

Command

G

Separate Selection

Command

E

B

Set Selection Start (while stopped or playing back)

↓

Set Selection End (while playing back)

↑

Shift Clear

Shift

Delete

Shift Cut

Shift

X

Shift Duplicate

Shift

D

Shift Insert Time

Shift

I

Shift Paste

Shift

V

Show Mixer

Command

F2

Show Settings

Command

F5

Command

,
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Show Timeline

Command

F1

Show/Hide Floating Windows

Shift

W

Solo Toggle

Shift

S

Toggle All Track Views

Control+Option+Command

←,→

Toggle Full Screen

Command+Shift

F

Toggle Metronome

Numeric Keypad 7

Toggle Playback

Spacebar

Numeric Keypad 0

Toggle Pre/Post Roll

Command

K

Toggle Record

Command

Spacebar

Numeric Keypad 3

Toggle Relative Grid Snap

Command+Shift

\

Toggle Selected Track Views

Control+Command

←,→

Toggle Snap To Grid

Shift

\

Toggle Timeline/Mixer

Command

=

Trim From Clip Start

A
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Trim From Clip End

S

Trim Clip to Selection

Command

T

Update Loop

Command

L

Zoom In

Command

]

T

Zoom In Audio Waveforms

Option+Command

]

Zoom Out

Command

[

R

Zoom Out Audio Waveforms

Option+Command

[

LUNA Menu Reference

LUNA menu
Item

Key Command

Description

About LUNA

Shows the LUNA version information.

Check for Updates...

Checks the server for LUNA updates.
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Update to Version...

Lets you update or downgrade LUNA to a specific version.

Preferences

Command+,

Opens the LUNA settings page.

Hide LUNA

Command+H

Hides LUNA windows.

Hide Others

Option+Command+H

Hides everything except LUNA windows.

Quite LUNA

Command+Q

Quits LUNA.

File menu
Item

Key Command

Description

New

Command+N

Open the LUNA New Session window.

Open...

Command+O

Open a Finder window to open a session.

Open Recent

Open Recent > Browse
All Recent

Allows you to choose from a list of recent sessions to open.

Option+Command
+O

Open Recent > Clear
Recent List

Opens the Recent Session browser.

Clears the Recent Sessions List.

Close

Command+W

Closes the topmost floating window in the session.

Close Session

Shift+Command+
W

Closes the session.
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Save a Copy As...

Saves a session copy with the name and in the location you
specify.

Rename

Opens the Rename popover so you can rename the session.

Revert To

Shows a list of session versions from which you can choose to
revert the session.

Import...

Command+I

Opens a Finder window from which you can select an audio or
MIDI file to import.

Export > Mixdown

Command+Shift+B

Opens the Export Mixdown dialog.

Export > All Tracks as
Files

Opens the Export Mixdown dialog with options selected to export
all tracks as separate files.

Export > Multitrack MIDI
File

Opens a Finder window and allows you to choose a location and
specify a name to save a multitrack MIDI file from the session.

Export > Clips

Shift+Command+K

Opens the Eport Clips dialog. With Export Clips open, you can
select individual audio and MIDI clips in the session to export as
separate files.

Edit menu
Item

Key Command

Description

Undo

Command+Z

Undo anything except a change made during recording.

Redo

Shift+Command+Z

Redo anything except a change made during recording.

Cut

Command+X

Cuts a selection to the clipboard

Keyboard Shortcuts and Menu Reference – 315

LUNA User Documentation v200731

Copy

Command+C

Copies a selection to the clipboard.

Paste

Command+V

Pastes a selection.

Clear

Delete

Deletes a selection.

Duplicate

Command+D

Pastes a selection right after the current selection.

Consolidate

Option+Shift+3

Combines two or more clips into one.

Select All

Command+A

Selects all clips on a timeline track.

Shift > Cut

Shift+C

Cuts a selection and shifts clips to fill the cut space.

Shift > Clear

Shift+Delete

Deletes a selection and shifts clips to fill the deleted space.

Shift > Paste

Shift+V

Pastes a selection and shifts clips to accommodate the pasted data.

Shift >
Duplicate

Shift+D

Duplicates selected data and shifts clips to accommodate the duplicated
data.

Shift > Insert
Time

Shift+I

Inserts a space of the current selection length, and shifts clips to
accommodate the space.

Mute Selection

Command+M

Mutes a clip.

Separate
Selection

Command+E

Separates a clip at the playhead location.

Separate on
Grid

Separates a selection or clip into separate clips on every grid line.
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Heal
Separation

Command+H

Recombines selected separated clips into a single clip.

Create Fades

Command+F

Creates a fade or crossfade, depending on the selection.

Delete Fades

Deletes fades in selected audio.

Fade to Clip
Start

Control+D

Fades from the playhead to the start of the clip (fade in).

Fade to Clip
Stop

Control+G

Fades from the playhead to the end of the clip (fade out).

Trim From Clip
Start

A

Trim From Clip
End

S

Trim Clip to
Selection

Command

T

Increase Grid

Shift+=

Increases the grid setting by one increment (for example, from half notes to
quarter notes).

Decrease Grid

Shift+-

Increases the grid setting by one increment (for example, from quarter
notes to half notes).

Quantize
Notes

Command+U

Quantizes notes based on the current Quantize settings. If there are no
quantize settings defined in the session, quantizes to bars at 100%.

Quantize
Settings

Shift+Command+
U

Opens the Quantize settings browser, where you can configure the quantize
settings for a selection or clip.
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Track menu
Item

Key Command

Description

New Tracks

Shift+Command+N

Open the Create New Tracks dialog.

New Instrument

Shift+Command+I

Creates a new Instrument track with the Shape LUNA
Instrument instantiated.

Duplicate

Option+D

Duplicates selected tracks.

Convert to Stereo

Converts a mono track to stereo.

Convert to Mono

Converts a stereo track to mono.

New Version > On All
Tracks

Control+Option+\

Creates a new Version on all tracks in the session.

New Version > On
Selected Tracks

Control+Option+Shift+
|

Creates a new Version on all selected tracks.

Duplicate Version > On
All Tracks

Control+Option+Com
mand+\

Creates a duplicate of the currently selected Version on each
track in the session.

Duplicate Version > On
Selected Tracks

Control+Option+Shift+
Command+|

Creates a duplicate of the currently selected Version on all
selected tracks.

Delete Selected Tracks

Deletes all selected tracks.

Hide Selected Tracks

Hides all selected tracks.

Find Track

Option+Command+F

Opens the Tracks Focus Browser and places the cursor in the
Search bar.
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Mixing menu
Item

Key
Command

Description

Solo Mode >
Latching

Allows you to solo multiple tracks, and latch them on or off by clicking Solo
buttons.

Solo Mode >
Exclusive

In this mode only one element can be soloed at a time. Each successive Solo
button click disables the previous Solo button.

Create Bus

Shift+Comma
nd+B

Creates a bus. Selected tracks can be routed directly to the bus or routed to
the bus through an Aux send.

Selection
Grouping

Command+G

Enables selection grouping so selected tracks can be adjusted together.

Transport menu
Item

Key
Comm
and

Description

Loop
Playback

Contro
l+L

When enabled, a selection will loop in playback and loop record.

Pre-Roll

Plays the session for a specified period of time before the playhead or selection starts. You
can use pre-roll to hear the context or lead-in to a selection, or to prepare to record at the
playhead or over a selection. Pre-roll plays only the first time you play, when loop playback/
record is enabled.

Post-Roll

Plays the session for a specified period of time after a selection ends. You can use post-roll to
hear the context after a play or record selection. Post-roll plays only when there is a selection,
and does not play when when loop playback/record is enabled.
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Toggle
Pre/
Post-Roll

Comm
and+K

Toggles pre-roll and post-roll on or off.

MIDI
Merge

Numer
ic
Keypa
d9

Toggles MIDI Merge and MIDI Replace mode, to specify whether new MIDI data recorded to a
track is added to the existing MIDI data, or whether the MIDI on the track is replaced.

All Notes
Off

Stops all MIDI Notes and messages.

Accelera
ted
Realtime
Monitori
ng

Toggles Accelerated Realtime Monitoring (ARM) mode to enable or disable the lowest
possible latency on record/input enabled tracks.

Console
Tracking
Mode

Toggles Console Tracking Mode, so Console inputs remain live and are not managed and
automatically muted and unmuted by LUNA.

Toggle
Playback

Space
bar

Starts or stops playback.

Toggle
Record

Comm
and+S
paceb
ar

Toggles recording. Press Command+Spacebar to start recording. If you press
Command+Spacebar while LUNA is recording, the session continues to play, but the transport
drops out of record.
Note that by default, the key command to toggle recording, Command+Spacebar, is mapped
to the macOS Spotlight search feature. You must disable or remap this feature to use this key
command. To disable or remap this command, in System Preferences > Spotlight > Keyboard
Shortcuts uncheck the key commands, or map them to different key commands. Refer to your
macOS documentation for more information.
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Restart
Playback

Contro
l+Opti
on+

Restarts playback from the original playhead position or the start of the selection.

Comm
and+S
paceb
ar

Abort
Recordin
g

Shift+
Comm
and+.

Stops all current recording and discards all in progress recordings (no undo).

Update
Playback
>
Instantly

When the loop is changed, playback immediately restarts from the beginning of the new loop
selection.

Update
Playback
> At Next
Bar

When the loop is changed, playback continues to the end of the next bar, then restarts from
the beginning of the new loop selection.

Update
Playback
> At
Loop
End

When the loop is changed, playback continues to the end of the loop that was previously
defined, then restarts from the beginning of the new loop selection.

Loop
Ruler >
Update
Loop

Comm
and+L

The current Timeline selection is applied to the Loop selection and loop length (Loop ruler
selection matches the current Timeline selection).

Loop
Ruler >
Loop
Select

Shift+
Comm
and+L

The current Loop selection is applied to the Timeline (Timeline selection matches the current
Loop selection).
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Navigation menu
Item

Key
Comman
d

Description

Zoom In

Command
+]

Zoom in on the track horizontally.

Zoom Out

Command
+[

Zoom out on the track horizontally.

Frame
Selection

E

Fill the edit window with the selected clip or clips. If no clip is selected, fills the edit
window with the nearest clip. Press E again to revert to the previous view.

Return to Zero

Return

Moves the playhead to the start of the session.

Go to End

Moves the playhead to the end of the last clip in the session.

Zoom In Audio

Option+C
ommand+
]

Zooms waveforms in horizontally.

Zoom Out
Audio

Option+C
ommand+
[

Zooms waveforms out horizontally.

Reset Audio
Zoom

Control+O
ption+

Resets the horizontal zoom for audio waveforms.

Command
+[

Link Edit/Play
Selections

Links the playhead and selections on the Timeline to the play selection on theBars
and Beats ruler.

Keyboard Shortcuts and Menu Reference – 322

LUNA User Documentation v200731

Record Enable
Follows
Selection

When a track is record enabled, selecting another track record enables that track,
and disables the deselected track. If you select multiple tracks, those tracks are
record-enabled.

Selection >
Move Up

P

Moves the selection area from the current track to the track above.

Selection >
Move Down

;

Moves the selection area from the current track to the track below.

Selection >
Extend Up

Shift+P

Extends the selection from the current track to the track above.

Selection >
Extend Down

Shift+;

Extends the selection from the current track to the track below.

Selection > Set
Selection Start

↓

Starts a selection during playback or with the transport stopped.

Selection > Set
Selection End

↑

Ends a selection during playback.

Selection >
Move to Next
Transient

Tab

Moves the playhead to the next transient in the selected tracks.

Selection >
Move to
Previous
Transient

Option+T
ab

Moves the playhead to the previous transient in the selected tracks.

Selection >
Move to Next
Bar

]

Moves the playhead to the next bar.
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Selection >
Move to
Previous Bar

[

Moves the playhead to the previous bar.

Selection >
Move to Next
Clip Edge

‘

Moves the playhead to the next clip edge on the selected track or tracks.

Selection >
Move to
Previous Clip
Edge

L

Moves the playhead to the previous clip edge on the selected track or tracks.

Selection >
Move to Next
Marker

Control+O
ption+‘

Moves the playhead to the next marker.

Selection >
Move to
Previous
Marker

Control+O
ption+L

Moves the playhead to the previous marker.

Selection >
Extend to Next
Transient

Shift+Tab

Extends the selection to the next transient in the selected tracks.

Selection >
Extend to
Previous
Transient

Shift+Opti
on+Tab

Extends the selection to the previous transient in the selected tracks.

Selection >
Extend to Next
Bar

Shift+]

Extends the selection to the next bar on the selected tracks.

Selection >
Extend to
Previous Bar

Shift+[

Extends the selection to the previous bar on the selected tracks.
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Selection >
Extend to Next
Clip Edge

Shift+‘

Extends the selection to the next clip edge on the selected track or tracks.

Selection >
Extend to
Previous Clip
Edge

Shift+L

Extends the selection to the previous clip edge on the selected track or tracks.

Selection >
Extend to Next
Marker

Shift+Con
trol+Optio
n+‘

Extends the selection to the next marker.

Selection >
Extend to
Previous
Marker

Shift+Con
trol+Optio
n+L

Extends the selection to the previous marker.

Selection >
Extend to
Session Start

Shift+Ret
urn

Extends the selection to the start of the session.

Selection >
Extend to
Session End

Shift+Opti
on+Retur
n

Extends the selection to the end of the session.

Track Heights
> Increase
Selected

Control+↑

Increases the height of selected tracks.
Note: by default, this key command is mapped to the macOS command for Mission
Control. You must disable or remap this feature to use this key command. To disable
or remap this command, in System Preferences > Keyboard, click Shortcuts and
disable this key command, or map it to a different key command. Refer to your
macOS documentation for more information.
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Track Heights
> Decrease
Selected

Control+↓

Decreases the height of selected tracks.

Track Heights
> Increase All

Control+O
ption+↑

Increases the height of all tracks.

Track Heights
> Decrease All

Control+O
ption+↓

Decreases the height of all tracks.

Scroll To > Left
Selection

Shift+←

Scrolls the Timeline and centers the left edge of the current selection.

Scroll To >
Right Selection

Shift+→

Scrolls the Timeline and centers the right edge of the current selection.

Auto-Scroll

Shift+A

Scrolls the timeline automatically one screen at a time during playback and record.

Note: by default, this key command is mapped to the macOS command for
Application Windows. You must disable or remap this feature to use this key
command. To disable or remap this command, in System Preferences > Keyboard,
click Shortcuts and disable this key command, or map it to a different key
command. Refer to your macOS documentation for more information.

View menu
Item

Key
Command

Description

Section >
Browser

Shows or hides the Focus Browser at the left of the screen. Note that when a
Focus Browser is required, this opens, regardless of this setting.

Section > Focus
Channel

Shows the Focus channel in Timeline view.

Section > Track
Versions

Shows the Versions panel in the Timeline track controls.
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Section > Mixer
Navigation

Shows the Mixer Navigation panel in Mixer view.

Section >
Control Room

Shows the Control Room section st the right of the screen.

Section >
Monitor

Shows the Monitor section at the right of the screen.

Section > Info

Shows the Info section at the bottom of the screen.

Timeline
Settings /
Rulers / Clips

Shows the settings for the Timeline, Rulers, and Clips in the Focus Browser.

Notifications

Shows the Notifications pane at the right of the screen.

Compact
Monitor Faders

Makes faders in the Mixer shorter, to allow more visual space for the Mixer rows.
You can also click at the top of a fader to compact or expand mixer faders.

MIDI Keyboard
Mode

Option+Co
mmand+M

Toggles MIDI Keyboard Mode, to allow MIDI note input using the typing keyboard.
Note: MIDI Keyboard Mode overrides many keys that are used as keyboard
shortcuts.

Toggle
Timeline/Mixer

Command
+=

Switches between Timeline and Mixer view.

Show All Tracks

Shows all tracks, including hidden tracks.

Windows menu
Item

Key Command

Description
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New Alternate Window

Shift+Command+=

Opens a second LUNA window.

Previous Window

Shift+Command+’

Cycles to the previous window.

Next Window

Command+’

Cycles to the next window.

Show/Hide Floating Windows

Shift+W

Shows or hides floating windows (for example, plug-in
windows).

Full Screen

Shift+Command+F

Toggles full screen mode for the LUNA app.

Help menu
Item

Key Command

Description

Search

Allows you to search for items in the menus.

LUNA Documentation

Links to LUNA documentation on the Universal Audio Support site.

UAD & Apollo
Documentation

Links to UAD and Apollo documentation on the Universal Audio
support site.

Give Feedback

Opens the Feedback form to report issues.

Keyboard Shortcuts

Opens a list of keyboard shortcuts.
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LUNA Instruments
LUNA supports software-based LUNA Instruments, including the Moog® Minimoog Model D and Ravel™ grand piano,
based on UA’s exclusive physical modeling techniques. LUNA Instruments also include Shape™ Creative Toolkit, a highquality instrument with sounds provided by Universal Audio, Spitfire, Orange Tree Samples, Loops de la Creme, and
many more.
Note: This page provides a brief overview of available LUNA Instruments. Each specific LUNA Instrument and its controls
are documented on their own page. To learn how to insert, play, and record LUNA Instruments, see “Playing a Virtual
Instrument and Recording MIDI” in the LUNA Application section.

Moog® Minimoog
Developed in partnership with Moog Music, the Minimoog LUNA Instrument is an incredibly accurate and inspiring
emulation of Bob Moog's pioneering synthesizer.
By perfectly capturing every nuance of the classic Moog oscillators and ladder filters and harnessing discrete transistor
VCA modeling, the Minimoog LUNA Instrument faithfully captures every detail of this classic instrument used by
everyone from Parliament-Funkadelic, to Kraftwerk, Dr. Dre, and more.

Ravel™ Grand Piano
A breathtaking emulation of a Steinway Model B† grand piano based on UA's exclusive sampling, physical modeling,
and new Ultra-Resonance™ technology, giving you all the sonic nuance of this studio classic. Captured at Ocean Way
Studios, Ravel gives you an immaculately recorded studio piano that’s album-ready, with easy-to-use Tone, Dynamics,
and Microphone controls, as well as an innovative Reverse feature for startlingly creative sounds and textures.
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Shape
A comprehensive creative toolkit included free with LUNA, Shape is a painstakingly curated LUNA Instrument featuring
a collection of the best vintage keys, drums/percussion, guitar/bass, orchestral content, and real-time synthesis,
courtesy of Universal Audio, Spitfire Audio, Loops de la Creme, and more. Quickly create complex, professional textures
developed by leading sound design experts, and take your inspiration further with easy-to-use macro controls and
powerful built-in effects.

Spitfire Audio
Expertly sampled and recorded at London's AIR Studios, Spitfire Audio's industry-leading Chamber Strings, Symphonic
Woodwinds, and Symphonic Brass will give your compositions the same professional gloss used by top producers for
film, TV, and video game scores, plus chart-topping pop and R&B records.
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Shape
A comprehensive, easy-to-use creative toolkit included free with LUNA, Shape is a painstakingly curated LUNA
Instrument featuring a collection of album-ready classic keyboards, drums/percussion, guitar/bass, orchestral content,
and real time synthesis - with content from Universal Audio, Spitfire Audio, Orange Tree Samples, Soniccouture,
Handheld Sound, G-Force, Wavesfactory and Sound Dust.

Working with the best
When creating the instrument collection for Shape, we relied on our in-house team of professional sound designers as
well as many of the industry’s top sample content companies including Spitfire Audio, OrangeTree Samples,
Soniccouture, Handeld Sound, and others. We refined the collection until we felt it contains the best mix of essential
instruments like acoustic pianos, electric guitars and basses, vintage electric pianos and organs, classic synthesizers,
drum kits and percussion, orchestral instruments, and atmospheric/ambient sounds. We’re confident this full-featured
collection will provide excellent coverage for your musical needs.

More than just samples
Shape is more than a basic sample player. Our underlying technology gives sound designers a great deal of flexibility in
how they craft their sounds. For example, each instrument includes four contextual knobs that let you control multiple
instrument parameters with one knob. The functionality of these knobs is hand-picked by the designer of each sound
and can vary dramatically from instrument to instrument. The contextual knobs give you a curated set of meaningful
controls with a simple interface, so you can stay focused on your music.
Shape also includes a full suite of great-sounding effects, including select UA processing not found elsewhere. You can
use these effects to refine and sweeten your sounds.
Finally, Shape lets you layer or split up to four instruments (or “parts”) into a complex sound and it includes several
global controls for fast and easy sculpting of your layered sounds.

Simple but powerful interface
Don’t be fooled by Shape’s straightforward design! The clutter-free user interface has just four “views” and we have
made it very easy to load and play sounds as-is but there is sonic power and flexibility just under the surface. Each view
is covered in detail in its own section.

System Requirements
In addition to overall LUNA Recording System requirements, Shape has the following requirements:
• SSD drive with available storage:
• 4 GB for Shape
• Additional 6 GB for Shape Content Expansion 1
• SSD drive must be formatted as APFS (Apple File System)
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• External SSD must be within USB 3.0, USB 3.1, PCIe, or Thunderbolt enclosure
Note:
• Spinning hard drives and macOS Fusion drives are unsupported
• SSD drives formatted as ExFAT, FAT, and Mac OS Extended are unsupported

Quick Start
We know you may want to start playing right away, so let’s take Shape for a quick test drive before diving into the
details. After the LUNA Instrument is loaded and input-enabled (see LUNA documentation for these details):

1. Click the Presets button at the top of the instrument to reveal Shape’s available presets in LUNA’s contextual
browser (at the left of LUNA’s screen).
2. Click any of the available presets while playing your MIDI controller. You should hear the sound of each preset as
you step through the names.
3. When you have found a preset that you like, try rotating the global control knobs at the top of the screen
(ATTACK, DECAY, RELEASE, CUTOFF, and so on). These knobs affect all four parts of your sound and let you
quickly modify your loaded presets.
4. Now rotate the LEVEL knobs for active parts to re-balance the mix between the parts.
5. Rotate the FX 1 and FX 2 knobs to send more (or less) of a part to the FX engines. The controls at the bottom of
the instrument let you select and further refine the effects.
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6. Try changing one of the loaded parts by clicking the name of the part. This brings up the Part Browser view,
where you can search through all the categories of sounds within Shape and select various instruments within
those categories.
7. When you are happy with your results, click outside the Part Browser to return to Main View.
8. Click the part parameter display to be taken to the part’s Editor view. In Editor view you can change various
parameters relating to the part such as its contextual controls, modulation source, destination, and strength,
pan position, and more.
9. When you are satisfied with the edits you have made to the part, click the left-facing chevron at the top left of the
screen to return to Main view.

Main View

Main view is what you see when Shape is launched. It contains the most commonly used controls and consists of three
distinct sections:
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Global Controls

The top of Main view contains a variety of global controls that affect all four parts within Shape.
About Global Offsets
The Attack, Decay, Release, and Cutoff knobs work by sending offset values to each of the four available instrument
parts. This means that the default “12:00” setting lets all loaded sounds play exactly as they are configured. Rotating
the knob clockwise or counter-clockwise serves to increase or decrease its associated parameter across all loaded
sounds. For example, if you have created a layered sound and generally like what you are hearing but wish it had a
longer release time, simply rotate the Release knob clockwise. Doing so will increase the output of all loaded parts
simultaneously.
Attack
This knob adjusts the overall attack time of all parts simultaneously.
Decay
This knob adjusts the overall decay time of all parts simultaneously.
Release
This knob adjusts the overall release time of all parts simultaneously.
Cutoff
This knob adjusts the overall filter cutoff of all parts simultaneously.
FX1>FX2
This knob sets how much of the FX1 output is routed to the input of FX2. It can be set from 0-100%. The minimum
setting means that the FX1 and FX2 operate independently of each other while turning this knob clockwise sends more
and more of the FX1 output to FX2 input.
Tip: The FX1>FX2 knob can achieve pleasing results, for example, when routing a delay into a reverb effect.
Master
This knob sets the master output level of Shape. The adjacent level meters provide visual feedback of Shape’s output
levels. Note that this knob adjusts the overall output of the plug-in. The relative loudness levels of the parts (set by each
part’s LEVEL knob) are maintained.
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Parts 1–4

Shape features four Part slots with identical controls. Each slot can load a different sound from the sound library and
you can mix, layer and split these parts to suit your musical needs.
Part Name and Browser

If a sound is loaded into one of the four slots, its name will be shown at the top of the display. Clicking on the Part name
or its browse icon will open the Part Browser.
Preset Parameters
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This section appears just below the part name and includes a brief description and amount for each contextual setting.
Hovering over this area will reveal a chevron. Clicking the chevron will take you to the Editor view where you can edit
the Part parameters.
FX1 and FX2 Send knobs
These two send knobs set how much of the current part is routed to Shape’s two FX slots. They range from 100% dry,
0% effect (fully counter-clockwise) to 0% dry, 100% effect (fully clockwise).
Note that Shape’s send knobs operate differently than the typical send knobs found on many mixers. If you rotate these
knobs fully clockwise, you will hear 100% of the effect (wet only) and none of the dry signal. This allows you to use a
send as an insert effect by rotating the knob fully clockwise. Furthermore, rotating the FX1>FX2 knob global knob fully
clockwise lets you have two insert effects in series if desired. Having both send and insert effects available opens up
many sound design possibilities.
Note: The effect must be enabled with its On/Off switch for these knobs to have any effect.
Learn more about effects in the FX Section.
Level knob
This knob sets the output level for the part.
Mute button
This button mutes and unmutes the part.
Solo Button
This button engages and disengages solo mode for the part and silences other parts.
Note: Only one part can be in solo mode.

Main View: FX Section

Shape comes with over 40 built-in effects, including select UA algorithms not found elsewhere. You can use up to two
effects simultaneously using the FX1 and FX2 slots.
FX Selector and Browser
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If an effect is loaded into a slot, its name will appear in the display. Clicking either the name or its browse icon will open
the FX Browser view where you can select other effects.
On/Off Switch
This button switches the effect on and off. The button is lit when the effect is active.
Note: To hear the effect, increase the effect send level knob for one or more parts.
FX Knobs
These three knobs control various parameters of your selected effect. The effect's parameter name is displayed below
each knob, and its current value is displayed above the knob.
Note: The function of these knobs varies depending on which effect is currently loaded.

Part Browser View

Part Browser View is where you can audition sounds from the library and load them into one of the four part slots
available in Shape. To open the Part Browser, click the name or its browse icon at the top of any of the parts in Main
View. To exit, click anywhere outside the browser area, or click the X at upper left.

Part Selector Tabs
The PART 1-4 tabs across the top let you select a part in which you can load a sound. These tabs are a convenient way of
switching between the four parts without having to exit the Part Browser and re-enter the browser for a different part.
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Category Selector
The left column lists various categories of instruments found in Shape’s library. Select any of the categories to view the
individual instruments within that category.
Note: Selecting NONE will unload any selected file and empty the selected Part.

Sound List
Here you will find all of the sounds in the chosen category. You can audition sounds without leaving the browser by
simply choosing them and playing your MIDI controller. The currently loaded sound is indicated with a diamond icon.

Editor View

The Editor View is where you can make more detailed edits to your sounds. Each Part has its own editor. The number of
the current part is displayed in the top left corner of the editor.
To enter Editor View, click on the chevron that appears when hovering over the Preset Parameters display in Main View.
To exit the editor, click the left-facing chevron at the top left of the screen.
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Primary Controls

Preset Name

If a sound is loaded into this part, its name will be shown here. Clicking on the name or its browse icon will open the
Part Browser view.

Level
This knob sets the output level for the part. This is the same control as the one that appears in Main view.

Solo
This button engages and disengages solo mode for the current part. This is the same control as the one that appears in
Main view.
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Pan
This knob sets the part’s panoramic position within the stereo soundfield.

Contextual Controls 1–4
Each of the four contextual knobs can control one or more parameters inside of the part’s sound engine. This lets you
make complex changes to a sound by simply turning one knob. The exact functionality of each contextual knob is set by
the sound designer and can vary greatly from one sound to another.
Tip: One way to think of the contextual knobs is that they show off what the sound designer felt was the most interesting
and tweakable parameter of that sound. Feel free to to experiment as these knobs can take sounds in interesting
directions.
Note: The sound designers may choose not to use all four contextual knobs. In this case, any unassigned controls do not
display a name and their knobs are locked.

Modulation Section

Controls in this section let you add additional modulation to Shape parts using the Modulation control (MIDI CC1) on
your external MIDI controller.
Note: Parts can have MIDI modulation built-in to the preset sound, so Parts may respond to MIDI modulation even if Depth
is set to zero.

Sync
This button switches tempo synchronization on and off in the modulation section. When switched on, the RATE knob
will be synchronized to the tempo of your session.

Rate
This knob sets the speed of modulation. The current value is displayed next to the knob. If SYNC is enabled, the values
are displayed in time divisions (for example, 1/4). If SYNC is disabled, the time value is displayed in milliseconds

Depth
This knob sets the amount or strength of the modulation being applied to your selected target.
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Note that the Depth knob is bi-polar and ranges from ±100% with 0% in the centered “12:00” position. This allows you
to apply positive or negative (inverted) modulation to your destination.

Wave Shape
This drop menu lets you select the shape of the modulation waveform. Options include NONE, SINE, TRIANGLE,
SQUARE, SAW, S&H (Sample and Hold), and RANDOM.

To
This drop menu lets you select the destination of your modulation signal. You can choose from AMP (amplitude), PAN,
PITCH, and other parameters that may be exposed by the designer of each part.

Keyboard Section
Pitch Bend
This parameter sets the pitch bend range of the part, from 0 to 12 semitones.
Tip: Each part can have its own pitch bend value. Setting this parameter to 0 disables the pitch bend control for its
associated part.

Octave
This parameter shifts the octave range of the part up or down by up to four octaves.

Tune Section

Transpose
This parameter transposes the pitch of the part up or down by up to ±12 semitones.
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Fine
This parameter fine- tunes the pitch of the part up or down by up to ±50 cents.

Key Range

Key Range
These four rows display the key ranges for each of Shape’s four parts. The parts are illuminated in different colors when
the part slots are loaded with sounds (a key range is gray and empty when a part’s slot is not loaded). You can drag the
handles at the end of each key range to set the lowest and highest playable note for each part.
When key ranges overlap, the parts play together as a layered sound. If the parts do not overlap, then they create
“splits” over the keyboard, letting you have up to four sounds on separate parts of the keyboard range.
Note: Shape’s key ranges are not individually addressable by different MIDI channels. To have different MIDI channels play
different sounds, you can use separate Shape instances.
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FX Browser View

FX Browser view is where you select the effect that you would like to use in each of Shape’s two effect slots. To open the
FX Browser, click the name or its browse icon from either effect in Main view. To exit, click anywhere outside the
browser area, or click the X at upper left.

FX Slot Selector Tab
The FX1 and FX2 tabs across the top let you select the FX slot that you would like to modify. These tabs are a convenient
way of switching between the two slots without having to exit the FX Browser and re-enter the browser for a different
slot.

FX Category
The left column lists various categories of effects found within Shape. Select any of the categories to view the individual
effects within that category.
Note: Selecting NONE will unload any loaded effect and empty the selected FX slot.

FX Preset
Here you will find all of the effects from a chosen category. You can select and audition various effects without leaving
the browser by clicking on an effect. The currently loaded effect is indicated with a diamond icon.
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Advanced Features (Automation and MIDI CC)
Shape has a simple user interface but we have made sure to include some powerful automation features under the
surface. Having access to automation and MIDI CC control can make life easier during a live performance (for example,
changing parameters “on the fly” from your MIDI controller without looking at your computer). It can also open up
creative sound design possibilities during a mix.
Note: While some parameters have dedicated (“hardcoded”) MIDI CC values for easy automation, most Shape parameters
are actually MIDI “Learnable”. This means you can use the MIDI Learn function of your music software to map a physical
control (knob, slider, etc.) of your MIDI hardware to an on-screen parameter.

Global Controls
Parameter

MIDI CC Number

Attack

73

Decay

75

Release

72

Cutoff

74

Mod Wheel

1

Sustain Pedal

64

All Notes Off

123*

Master Volume

N/A

• Shape performs an “All Notes Off” (sometimes called “MIDI Panic”) procedure any time it receives a non-zero
value on MIDI CC123. This means you can, for example, map any momentary button on your MIDI Controller to
send a “127” MIDI message on CC123 when pressed, and a “0” message when released. Doing so will convert that
button into an All Notes Off control.
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Part Parameters
MIDI CC Number

Parameter

Part 1

Part 2

Part 3

Part 4

Part Volume

85

86

87

88

Part Contextual Edit 1

48

52

56

60

Part Contextual Edit 2

49

53

57

61

Part Contextual Edit 3

50

54

58

62

Part Contextual Edit 4

51

55

59

63
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Moog® Minimoog
Developed in partnership with Moog Music, the Minimoog LUNA Instrument is an incredibly accurate and inspiring
emulation of Bob Moog's pioneering synthesizer.
By perfectly capturing every nuance of the classic Moog oscillators and ladder filters and harnessing discrete transistor
VCA modeling, the Minimoog LUNA Instrument faithfully captures every detail of this classic instrument used by
everyone from Parliament-Funkadelic, to Kraftwerk, Dr. Dre, and more.

About the original hardware
Produced by Moog Music from 1970 through 1981, the Minimoog Model D was the first synthesizer designed specifically
for popular music. Before the introduction of the Minimoog, synthesizers were primarily modular systems that were
very large and extraordinarily expensive. This meant that synthesizers were usually confined to academic environments
like universities or in the studios of record labels and advertising agencies. They were beyond the reach of average
musicians.
The Minimoog was a radically new type of instrument that changed the way the world viewed synthesizers. It was
portable (at “only” 32 lbs. / 14.5 kg it was considered lightweight for its time), it was non-modular and did not include a
patchbay, and it cost only a fraction of existing large modular systems. This made it a viable, exciting option for gigging
musicians with limited budgets.
Beyond these primary factors, the Minimoog also became a commercial success because of its expressiveness in live
performance. It was the first keyboard to feature the now-familiar pitch and modulation wheels, giving players the
ability to play the pitch bends and vibrato commonly heard in guitar and saxophone solos. Furthermore, its sounds
could be changed quickly letting players easily recall different sounds in the age before stored presets.
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Finally, it is impossible to discuss the Minimoog without mentioning its wonderfully “fat” sound. This was the result of
the patented Moog ladder filter with three oscillators, various nonlinearities in the signal and control paths, and a
tuning system that wasn’t perfectly stable. While the nonlinearities and instability were not deliberately designed-in as
features by Moog (it can be argued that these were technical shortcomings), they nevertheless happened to produce
highly desirable sonic qualities including the fat sound and the fantastic self-oscillating filter sweep.
This combination of features gave the Minimoog an unbeatable edge over virtually all competing synthesizers during its
decade-long production run. Even now, vintage Minimoogs continue to fetch incredible prices on the used market — a
testament to the desirability of the instrument.
Fun fact: Although it was called the Minimoog Model D, this was the only instrument that was actually put into
production. Model A, Model B and Model C were prototypes created by Moog Music and were not produced in quantity.

Universal Audio’s approach to Minimoog
No expense was spared in the creation of the Universal Audio Minimoog. Two years of painstaking research and
craftsmanship went into understanding every detail of the signal path, pitch tracking and control sources of the original
hardware.
Vintage analog synthesizers — particularly units that are approaching 50 years old — can sound different from unit to
unit. This is because the circuits will have aged under different environmental conditions. As a result, it is impossible to
select one “golden” unit that definitively represents the entire line of instruments. To ensure that nothing was missed
during development, the Universal Audio team sourced and studied not one but three vintage Minimoog synthesizers.
Each of these units was carefully measured and analyzed to ensure the entire range of the original hardware is present
in the virtual instrument.
Note that we were not content to simply make a perfect replica of the original hardware and consider it done. Once
sonic fidelity was achieved, the Universal Audio team pushed on and added a small number of useful extras such as an
extra LFO/Sample & Hold circuit, switchable note priority and legato, velocity sensitivity, and more. Great care was
taken to do this tastefully and all these features are “period correct” (i.e., original Minimoog units were sometimes
modified to include these modifications). These new features are included for modern music makers that may find
them useful, but can easily be bypassed by players wanting a 100% vintage playing experience.
In the end, we feel our Minimoog delivers on its promise to give you the authentic sound and experience of playing the
glorious original instrument. If you need a classic synth that is found on countless hit records, but is versatile enough to
sound brand new, there is no better choice.

The original hardware and the UA instrument
You may notice small visual differences between the hardware Minimoog and the software instrument. Some of these
changes are purely functional (for example, there is no need for the headphone jack and volume in the plug-in since this
is handled by LUNA and/or your audio interface). Other changes are included because they greatly expand the
functionality of the original hardware. These additions are primarily found in the Modifications panel below the main
set of controls.
The following features, in the Modifications panel at the bottom of the window, are the differences between the original
hardware instrument and our software instrument:
• Extra LFO/Sample & Hold with tempo sync
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•
•
•
•
•
•

Switchable note priority (lowest or last played)
Switchable legato or re-trigger option
Modulation Source Selection
Modulation Amount Knob
Pitch Bend Range
Velocity sensitivity for volume, filter cutoff, and filter envelope amount

Quick Start

Before we dive into the details, let’s take Minimoog for a quick test drive. After the LUNA Instrument is loaded and the
Instrument track is Input-enabled (see LUNA’s application documentation for these instructions):
1. Click the Presets button at the top of the instrument to reveal Minimoog’s available presets in LUNA’s contextual
browser (at the left of LUNA’s screen).
2. Click any of the available presets while playing your MIDI controller. You should hear the sound of each preset as
you step through the names.
3. When you have found a preset that you like, keep playing while rotating the CUTOFF FREQUENCY and EMPHASIS
knobs (in the FILTER section) to hear the effect of the filter on your sound.
4. Next, try rotating the RANGE and WAVEFORM knobs in the OSCILLATOR BANK section to hear the various kinds of
sounds the oscillators are capable of producing.
5. You can re-balance the mix of the oscillators by rotating the VOLUME knobs and flipping the ON/OFF rocker
switches in the MIXER section.
6. Play a repeating pattern of notes while changing the GLIDE knob to hear the portamento between the notes
(make sure the switch below the knob is set to ON).
7. Finally, try adjusting the ATTACK TIME, DECAY TIME and SUSTAIN LEVEL knobs in the LOUDNESS CONTOUR
section while you play. You should hear changes in the volume envelope of the sound.
This barely scratches the surface of what Minimoog can do, but we hope it gives you an idea of the capabilities of this
amazing instrument! Read on to learn about all the sections of this synthesizer and how they work together.
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Overview
Like the original Minimoog Model D hardware, all of the controls of the software are visible at a glance and the software
instrument does not feature any tabs or sub-menus. The flow of audio and control signals is generally (but not always)
from left-to-right. White vertical lines, color-coded switches and clear labeling help break down the controls into logical
groups.
Minimoog is a self-contained monophonic analog synthesizer, and the direct descendant of the Moog modular
synthesizers that preceded it. The main synthesizer components include:
•
•
•
•
•
•
•
•
•
•

Oscillator 1
Oscillator 2
Oscillator 3
Noise Generator
Audio Mixer
Moog Ladder Filter
Loudness Contour (Envelope Generator)
Filter Contour (Envelope Generator)
Glide (Portamento)
Modifications (software only):
• Velocity Sensitivity
• LFO Modulation Oscillator
• Sample & Hold
• Modulation Mixer

The front panel groups these elements and controls together by type: CONTROLLERS, OSCILLATOR BANK, MIXER,
MODIFIERS, OUTPUT, and MODIFICATIONS in an intuitive and efficient design. All of these elements are controlled via
single-function knobs and switches. In place of patch cables, the Minimoog uses color-coded switches to establish
connections between the various circuits contained in the synthesizer.
•
•
•
•

Orange: Connect modulation sources to their destinations.
Blue: Switch audio sources On and Off.
Grey: Switches performance features On and Off.
Small 2 or 3-position silver bat-handle switches for adjusting various settings (Modifications panel)

Main Panel
Like the original Minimoog, all of the controls of the software are visible at a glance and this plug-in does not feature
any tabs or sub-menus. The flow of audio and control signals is generally (but not always) from left-to-right. White
vertical lines and clear labeling help break down the controls into logical groups.
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Oscillator Bank
Oscillators are the primary source of sound in an analog synthesizer. The OSCILLATOR BANK contains three nearly
identical Oscillators. This arrangement means each key can sound up to three oscillators — each with its own
Waveform, Octave, and Pitch setting — creating a deep or complex sound. The Mixer[xref] then controls the balance
between the Oscillators.

Range (Oscillator 1, 2, and 3)
This knob selects the fundamental octave for each oscillator over a five octave range. A sixth LO setting brings the pitch
down even further, allowing the Oscillator to be used for other purposes, such as a modulation source.
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Frequency (Oscillator 2 and 3)
Oscillator 2 and Oscillator 3 are each equipped with a FREQUENCY knob that can be used to detune the Oscillator. Slight
amounts of detuning can create a rich, chorusing effect. Tuning the Oscillators to an interval (Perfect Fifth above,
Perfect Fourth below, etc.) provides a powerful voice for playing lead passages or creating chords.
Waveform (Oscillator 1, 2 and 3)
Each of the three Oscillators provides six distinct Waveform shapes. Each waveform has a unique harmonic content that
is based on the number and strength of harmonic overtones that it contains. These overtones are what impart a
particular timbre to the Oscillator and are described in the next section of this guide.
Osc. 3 Control (Oscillator 3 only)
Oscillator 3 is unique. Normally, all Oscillators are controlled directly from your keyboard and/or its Pitch wheel. Setting
the orange rocker switch to OFF releases OSCILLATOR 3 from MIDI control allowing it to run free as a fixed pitch or
modulation source.
Oscillator Modulation
When this switch is set to ON, the Oscillators can be modulated by Oscillator 3, Filter Contour, Noise source, LFO (Low
Frequency Oscillator), and Sample & Hold module. The source of the modulation signal is defined by the MODULATION
MIX SOURCES[xref] switches, the blend of the modulation sources is set by the MODULATION MIX[xref] knob, and/or the
amount is set by the Modulation Wheel of your MIDI controller.

About the Oscillator Waveforms
One of the reasons why the Minimoog can produce such a rich variety of sounds is its selection of available waveforms:
TRIANGLE
The Triangle wave has an extremely strong fundamental, yet contains only odd-numbered harmonics at very low levels.
This makes the Triangle wave an ideal choice for creating soft, flute-like sounds that have a pure tone with little
overtone activity.
TRIANGLE/SAWTOOTH (OSCILLATOR 1 AND OSCILLATOR 2 ONLY)
This waveform is a hybrid of the Triangle and the Sawtooth waveforms. It contains more harmonic energy than the
Triangle wave and adds in some of the even-numbered harmonics, but it is not nearly as brash as the Sawtooth wave.
This hybrid waveform can add a little more edge than the Triangle wave alone, allowing it to cut through the mix with a
bit more clarity.
REVERSE SAWTOOTH (OSCILLATOR 3 ONLY)
The Reverse Sawtooth has a sound similar to the regular Sawtooth wave; it is included here primarily as a waveform
choice when using Oscillator 3 as a modulation source.
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SAWTOOTH
The Sawtooth waveform is the most harmonically dense of the waveforms, containing all of the natural harmonics in
relatively strong levels. In addition to creating thick, brassy sounds, the Sawtooth waveform lends itself to powerful
lead and bass sounds as well.
PULSE 1 / SQUARE
The harmonic content of a Pulse wave is based on the width of the top half of the wave in relation to the bottom half of
the wave, also known as the duty-cycle. In the Square wave, the width of these two portions of the wave are equal. As
with the Triangle wave, the Pulse 1 / Square waveform contains only odd-numbered harmonics, but with greater
energy. A Square wave provides a rich starting point for string-like sounds, or clarinet-like timbres.
PULSE 2 / WIDE RECTANGLE
As the Pulse wave changes from Square to Rectangular, even numbered harmonics are introduced, but the overall
harmonic mix is changed. The wide rectangle forms the basis for hollow, reedy sounds.
PULSE 3 / NARROW RECTANGLE
As the Pulse wave continues to get narrower, lower numbered harmonics—both odd and even—are emphasized. The
resulting timbre takes on a more nasal tone.
Tip: Mixing a Triangle wave from one Oscillator with the more complex wave of another Oscillator allows you to
emphasize one particular harmonic without adding unwanted overtones. Changing the relative tuning of the Triangle
wave Oscillator can enhance this effect.

Controllers
This section contains controls relating to tuning and how the note and modulation wheel inputs from your MIDI
controller are handled within Minimoog.
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Tune
The overall tuning of all oscillators is determined by the master TUNE knob, located at the top of the CONTROLLERS
panel.
Tip: For greater precision when tuning oscillators, hold the Shift key while dragging the Tune (all Oscillators) or
Frequency (Oscillator 2 and 3) knobs. If you find it difficult to hold the Shift key while playing a note, consider using the
ARP plug-in while with its LATCH mode engaged or playing back existing MIDI notes from within LUNA.
Glide Knob
Minimoog’s Glide function controls portamento and allows the pitch to change in a smooth, continuous manner as you
transition from note to note, rather than instantly stepping to the new pitch. Low settings will transition quickly
whereas high settings will transition more slowly.
Note: Like the original hardware, the glide functionality is proportional and is not time-constant. This means that the knob
sets the rate at which transition takes place but not the length of time. In other words, an octave interval will take 12 times
longer to complete than a smaller interval.
Glide Switch
This switch engages and disengages the Glide effect described above. This can be handy when you want to switch the
glide function on and off without changing a glide knob setting that you have carefully dialed in.
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Modulation Mix
This knob sets the balance between the modulation sources A and B. These sources are set using the MODULATION MIX
SOURCES switches in the Modifications Panel.
• With the MODULATION MIX knob rotated fully counterclockwise, only the modulation source selected by the OSC
3 / ENV. 2 switch is applied.
• With the MODULATION MIX knob rotated fully clockwise, only the modulation source selected by the NOISE/
S&H/LFO switch is applied.
• In the center position, modulation sources A and B are mixed together and applied equally.
Note: The Modulation Mix knob varies from the original hardware in that you can select the source of the incoming control
signals. The original instrument had hardwired sources that could not be changed (OSC 3 to Source A and Noise to Source
B).

Mixer
The MIXER combines the output of the three oscillators, an external input (or Minimoog’s own output), and a noise
source before passing it on to the Filter.
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Volume Knobs and On/Off Switches
These five knobs set the loudness level for each input of the mixer (Oscillators 1-3, the External Input and the Noise
source). Each mixer source has its own dedicated Volume knob and an On/Off switch. These blue rocker switches allow
any source to be quickly removed from the mix while preserving its VOLUME knob position.
Tip: The On/Off switches can be useful when setting the tuning of each Oscillator.
External Input Volume Knob & Switch
When the INPUT switch is set to FEEDBACK (the default setting) and the EXTERNAL INPUT VOLUME switch is set to ON,
you can route the output of the Minimoog back into its mixer using this knob to create a thicker, more overdriven (or
heavily distorted) sound.
Note: The INPUT switch (in Modifications panel) must be set to FEEDBACK (its default Down position), and the External
Input Switch (to the left of its knob) must be ON to hear the effect.
Caution: If the INPUT switch (on the Modifications panel) is set to FEEDBACK and both the EXTERNAL INPUT VOLUME
and MAIN OUTPUT VOLUME knobs are turned all the way up, it is possible to overload the mixer to the point that only
one sound is heard and playing different pitches does not alter the sound at all. This will not damage your audio
interface, but please take steps to protect your hearing and also your speakers from these potentially loud sounds.
Overload Indicator
It is possible to push the mixer into varying levels of overdrive and distortion by turning up the EXTERNAL INPUT
VOLUME knob. When this occurs, the Overload indicator lamp will light.
Note: The External Input is sourced after the Main Output knob in the signal flow. This means that the MAIN OUTPUT
VOLUME knob will affect the amount of overload in addition to the EXTERNAL INPUT VOLUME knob.
White / Pink Switch (Noise Type)
Noise can be a very desirable sound source. It can be used alone, or mixed in with other sources to create anything from
a rocket launch to the subtle breath of a flute sound. This switch works in conjunction with the NOISE VOLUME knob
and selects either WHITE or PINK noise.
About White and Pink Noise
White Noise contains all audible frequencies at equal amplitude levels, much like white light. Pink Noise contains equal
energy in each band of the audio spectrum, and is perceived as having more low-frequency components.

Modifiers
The MODIFIERS Panel contains three separate sections: FILTER, FILTER CONTOUR, and LOUDNESS CONTOUR.
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The Filter selectively modifies the harmonic content of the sound. The Contour controls (also known as Envelope
Generators), provide a control signal that changes over time. The FILTER CONTOUR controls the filter’s Cutoff
Frequency over time. The LOUDNESS CONTOUR controls the output volume level (amplitude) over time.
About Contour Controls
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Contour controls (sometimes known as Envelope Generators) provide a way to add shape and articulation to the sound
of the synthesizer. Minimoog features two sets of Contour controls. One set provides a signal to change the Filter Cutoff
Frequency over time. The second set provides a signal to change the Loudness (amplitude) over time. In both cases, the
Contour contains three main controls: ATTACK TIME, DECAY TIME, and SUSTAIN LEVEL. These controls are detailed
below.

Filter Controls
Cutoff Frequency
Minimoog has the traditional Moog Ladder Filter with 10 Hz – 32 kHz frequency response. This is a critical component of
its thick, punchy, and powerful sound. When a note is played, harmonic content above the filter Cutoff Frequency is
attenuated by the filter at 24 dB/Octave. Harmonic content, or sound, below the filter Cutoff Frequency will freely pass
unaffected. When “closing” the filter by lowering the CUTOFF FREQUENCY, the sound will be perceived as being darker,
while increasing the Filter’s CUTOFF FREQUENCY will create a progressively brighter sound.

While the Cutoff Frequency can be set manually using the CUTOFF FREQUENCY knob, the value is also affected by the
KEYBOARD CONTROL switches, FILTER MODULATION switch, FILTER CONTOUR controls, and the AMOUNT OF
CONTOUR knob, which are discussed below.
Emphasis
Often referred to as resonance, the EMPHASIS knob creates a resonant peak that occurs at the filter’s Cutoff Frequency.
By turning the EMPHASIS control up and lowering the Filter CUTOFF FREQUENCY, the Filter can be coaxed into a selfoscillating state, acting as a sine-wave oscillator whose pitch can be controlled or played via the keyboard by using the
KEYBOARD CONTROL switches defined below.
Amount of Contour
The AMOUNT OF CONTOUR knob determines how much of the control signal created by the FILTER CONTOUR envelope
generator will be applied to change the FILTER CUTOFF over time.
Attack Time
The ATTACK TIME knob sets the time required for the Filter Contour Generator to raise the Filter’s Cutoff Frequency
from its manual setting to its maximum level (determined by the AMOUNT OF CONTOUR knob) once a key is pressed or
after a gate is received.
Decay Time
The DECAY TIME knob sets the time required for the Filter envelope to lower the Filter’s Cutoff Frequency achieved by
the Attack stage to the Sustain Level. This knob can also control the amount of time required for the note to completely
fade out after a key is released (or after an external gate signal ends). This second function of the DECAY TIME knob is
activated by the DECAY switch[xref].
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Sustain Level
After the Attack and Decay stages have been completed, the Filter Contour Generator will hold the Filter’s Cutoff
Frequency at the level determined by the SUSTAIN LEVEL knob for as long as a note is held.
Filter Modulation Switch
When this switch is set to ON, the Filter Cutoff Frequency can be modulated by the mod wheel of your MIDI Controller.
The modulation source is defined by the MODULATION MIX SOURCES[xref] switches in the Modifications panel and the
MODULATION MIX[xref] knob in the Controllers panel.
Keyboard Control Switches (1 & 2)
These two switches allow incoming notes to affect the Filter Cutoff Frequency, a function also known as key tracking.
This allows notes played higher on the keyboard to have a brighter sound; as the keyboard pitch increases, the filter is
opened by the control signal from the keyboard pitch by the fixed proportion allowed by the switch. Note that if you
don’t use keyboard tracking, your timbre will get duller as the pitch frequency played rises, as the filter’s cut-off
frequency won’t alter with the pitch. The upper switch provides 1/3 of the total amount of available key tracking. The
lower switch provides 2/3 of the total amount of available key tracking. By using both switches together, the full
amount of available key tracking (1/3 + 2/3 = 1) is applied, and the timbre of played notes remains consistent
throughout the keyboard range.

Attack Time
The ATTACK TIME knob sets the time required for the Loudness Contour Generator to raise the Volume from zero to its
maximum level once a key is pressed or after a gate is received.
Decay Time
The DECAY TIME knob sets the time required for the Loudness Contour Generator to lower the Volume from its
maximum level achieved by the Attack stage to the Sustain Level. The DECAY TIME knob can also control the amount of
time required for the note to completely fade out after a key is released (or after an external gate signal ends). This
second function of the DECAY TIME knob is activated by the DECAY switch.
Sustain Level
After the Attack and Decay stages have been completed, the Loudness Contour Generator will maintain the Volume
level determined by the SUSTAIN LEVEL knob for as long as a note is held.
Decay Switch
When the DECAY switch is OFF, the release stage is extremely short when a key is released. However, when the DECAY
switch is ON and a key is released, the last note played will continue to sound, and both its filter and loudness contours
decay at the rate set with the DECAY TIME knob.
Note: This switch applies to both contour envelopes (loudness and filter).
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Output Section
Volume
This knob sets the master output volume of Minimoog.
Power
This switch powers Minimoog on and off. The indicator lamp directly above the switch is lit when Minimoog is ON.

Modifications Panel

The Modifications panel contains a number of features that greatly expand the sound design functionality and
expressivity of the Minimoog.

Bend Range
Adjusts the range of the pitch wheel from ±1 to ±12 semitones. The markings indicate each semitone and some of the
popular ranges (1, 2, 7, 12) are indicated numerically for rapid adjustment.
Tip: A setting of 7 provides the authentic pitch bend range of the original Minimoog Model D hardware.

Modulation Amount
This knob provides a convenient way to store mod wheel values in a preset. If a MIDI controller is not connected, you
can use this knob as the mod wheel instead. You can use this knob and your MIDI controller's mod wheel at the same
time as they are both active.
Note: The MODULATION AMOUNT knob cannot exceed the Minimoog's maximum modulation amount.

Modulation Mix Sources
These switches determine the source of Modulation A (left) and Modulation B (right). Modulation A can be sourced from
either OSCILLATOR 3 or ENVELOPE 2. Modulation B can be sourced from NOISE, SAMPLE & HOLD, or LFO. Your selection
here determines what modulation is presented at the MODULATION MIX[xref] knob in the CONTROLLERS section.
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LFO
A highly desired modification on the original Minimoog Model D hardware was the addition of a dedicated LFO. This
allowed players to use OSCILLATOR 3 for sound generation while still having an LFO to aid with sound design or
expression (especially vibrato). The Modifications panel includes this “extra” LFO.
The LFO waveshape switch lets you select from TRIANGLE and SQUARE. The SYNC switch lets you synchronize the LFO
to the tempo of your session. The FREQUENCY knob sets the speed of the LFO. Note that when SYNC is set to OFF, the
range is from 0.05 Hz – 200 Hz. When Tempo Sync is switched ON the FREQ. knob ranges from 1/64 Note (minimum
setting) to Whole Note (maximum setting).

Key Mode
Minimoog is a monophonic instrument and plays one note at a time. There are 2 options for behaviors having to do with
note triggering.
LOWEST/LAST Switch – Determines which note has priority when multiple MIDI notes are received. The LOWEST setting
gives priority to the lowest note being received (this is how the Minimoog Model D hardware operated). The LAST
setting gives priority to the last note played.
LEGATO/RETRIG Switch – Determines whether the filter envelope will be retriggered when playing legato, which in the
case of the Minimoog, refers to holding down one note while playing another. The original hardware default is LEGATO.

Input
This switch selects the input source of the EXTERNAL VOLUME INPUT[xref] in the MIXER module. When set to FEEDBACK,
the master output of Minimoog (after the VOLUME knob) is brought back into the instrument at the mixer. When set to
“EXTERNAL”, Minimoog can process audio received from an Apollo input. The EXTERNAL input feature is not fully
functional.
About the feedback loop
Users of the original Minimoog Model D hardware discovered that connecting one of the outputs (the hardware had two
outputs) to the external input with a short audio cable would often result in very interesting tones due to the feedback
loop that was created. This became a popular “hack” to the original hardware and many users had switches installed to
let them create the feedback loop whenever desired without requiring a cable.

Velocity
The Minimoog LUNA Instrument features something that the original Minimoog Model D hardware was never able to do:
allow MIDI velocity to be used as a control signal. Note velocity data can be mapped to FREQUENCY CUTOFF, FILTER
CONTOUR, or LOUDNESS parameters using the corresponding knobs in the MODIFICATIONS panel. Setting these knobs
to 0 means that velocity sensitivity is ignored (like the original hardware). Rotating the knobs clockwise increases the
effect of velocity on each knob’s associated destination.
Tip: Keep in mind that these controls are also interactive with whatever they’re controlling, and that the settings of
other control signals can affect the result. A good example is filter cut-off. When using velocity to control filter cut-off
when you may have the filter envelope in play, you may want to adjust the filter to be more closed when starting (or
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temporarily lower your filter envelope level), find the appropriate level of velocity control for the filter, and then move
the filter cut-off or other controls to their final desired positions.

Performance Tips & Techniques
Even with its simple control panel, Minimoog remains a deep and versatile instrument for audio synthesis. Here are just
a few examples of how the Minimoog can be used in interesting and perhaps unexpected ways.

Creating FM effects
When we think of Modulation, we are often thinking about slow cyclic change in pitch, filter brightness, etc. but these
changes do not need to happen slowly. Minimoog allows one audio oscillator to modulate another at audio rates,
creating interesting Frequency Modulation effects.
1.
2.
3.
4.
5.
6.

Set OSCILLATOR 1 to the 16’ or 8’ Range.
Set OSCILLATOR 3 to the 16’ or 8’ Range.
Isolate OSCILLATOR 3 from keyboard control by setting the orange OSC.3 CONTROL switch to OFF.
In the Modifications panel, set the OSC. 3/ENV. 2. switch to OSC.3
In the Controls panel, rotate the MODULATION MIX section fully counterclockwise.
In the Mixer panel, switch all audio inputs OFF except for OSCILLATOR 1. Ensure that the VOLUME knob for the
first oscillator is turned up.
7. Hold any note on your MIDI controller and use the MODULATION wheel to apply Frequency Modulation! The FM
effect can be controlled by the position of the Modulation Wheel, as well as the Range, Frequency, and
Waveform settings of OSCILLATOR 3.

Creative Switching
With a little forethought, the blue and orange rocker switches on the Minimoog can be used to quickly introduce new
elements to your performance. For example, by tuning OSCILLATOR 2 and OSCILLATOR 3 to specific intervals in regards
to OSCILLATOR 1, extra harmonies or chords can be added to your performance as you play.
1. Tune OSCILLATOR 2 to a Fifth (5) above OSCILLATOR 1.
2. Tune OSCILLATOR 3 to a Fourth (-4) below OSCILLATOR 1 (be sure that the orange OSC. CONTROL rocker switch
is ON).
3. In the MIXER panel, use the blue rocker switches to switch OSCILLATOR 1 ON, and OSCILLATOR 2 and
OSCILLATOR 3 OFF.
4. Now, as you play a lead, you can use the blue OSCILLATOR 2 and OSCILLATOR 3 rocker switches to instantly add
a parallel harmony voice.
Tip: Many of the Minimoog controls can be automated through LUNA and/or MIDI CC messages.

Automation
Minimoog has powerful automation features that can be used with LUNA. Having access to automation, MIDI CC control
can make life easier when composing or performing (for example, changing parameters “on the fly” from your MIDI
controller without having to use a mouse). It can also open up creative sound design possibilities during a mix.
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Controllers Section
Parameter

MIDI CC Number

Tune

N/A

Glide

5

Glide On/Off

65

Modulation Mix

N/A

Oscillator Bank Section
Parameter

MIDI CC Number

OSC 1 Range

33

OSC 1 Waveform

26

OSC 2 Range

34

OSC 2 Tune

39

OSC 2 Waveform

27

OSC 3 Range

35

OSC 3 Tune

40

OSC 3 Waveform

28
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OSC 3 Control On

N/A

Mixer Section
Parameter

MIDI CC Number

OSC 1 Volume

85

OSC 1 On/Off

N/A

OSC 2 Volume

86

OSC 2 On/Off

N/A

OSC 3 Volume

87

OSC 3 On/Off

N/A

External Input Volume

70

External Input On/Off

N/A

Noise Volume

89

Noise On/Off

N/A

Noise Pink/White

29
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Modifiers Section
Parameter

MIDI CC Number

Filter Modulation On/Off

N/A

Filter Cutoff Frequency

74

Filter Emphasis

71

Filter Contour

25

Filter Keyboard 1/3 Switch

N/A

Filter Keyboard 2/3 Switch

N/A

Filter Attack Time

22

Filter Decay Time

23

Filter Sustain Level

N/A

Loudness Contour Attack Time

73

Loudness Contour Decay Time

75

Loudness Contour Sustain Level

N/A

Decay On/Off

72
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Output Section
Parameter

MIDI CC Number

Volume

N/A

Modifications Panel
Parameter

MIDI CC Number

Modulation Amount

N/A

Tempo Sync

N/A

LFO Rate

76

LFO Waveform (Square / Triangle)

N/A
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Ravel™ Grand Piano
Universal Audio's first acoustic instrument model, Ravel, is a breathtaking emulation of a Steinway Model B grand
piano.* Building upon UA's industry-leading physical modeling techniques, Ravel goes far beyond other piano plug-ins
and sample libraries with its unprecedented realism and resonant dynamics.
Exclusively for LUNA Recording System, Ravel gives you an immaculately captured, iconic studio grand piano recorded
at United Recording Studios (formerly Ocean Way Studios) by famed engineer Allen Sides with his vast collection of
vintage mics. Purpose-built for modern music productions from pop to rock, R&B to hip-hop, and more, Ravel gives you
album-ready sonics and inspiring playability.

Now you can:
•
•
•
•

Play and record the most organic, responsive, and expressive software piano ever made
Harness UltraResonance™ technology for unparalleled realism, dynamic sensitivity, and timbral characters
Easily mix between close and room mics, expertly placed by Allen Sides at United Recording
Animate your tracks with unique reversed-piano sounds that can add thrilling textures
and haunting atmospheres

The Ultimate Model of a Model B
The 6' 11" Steinway Model B is the most recorded studio piano for a reason, delivering the ideal, mixable studio grand
sound as heard on countless modern hits, across every genre. Its rich tones blend perfectly with drums, bass, electric
guitar, and other surrounding instruments — never muddying up mixes and instead giving you a balanced, mix-ready
piano track every time.

Introducing UltraResonance™ Technology
Sympathetic string resonance — or the phenomenon of undamped strings and the soundboard vibrating in response to
other strings being played — is often the Achilles’ heel of virtual pianos. Using proprietary modeling and sampling
techniques, UA's exclusive UltraResonance technology exactingly recreates these complex interactions, giving you the
airy, evolving palette of harmonics that allows notes to melt into each other. From soft muted notes to languid, pillowy
nuances, UltraResonance™ sets a new benchmark in resonance and realism.

Simple Control of Perfectly Placed Mics
Designed to give you a professional, record-ready sound right out of the gate, Ravel's easy-to-use interface lets you
sculpt your piano sounds with three pairs of hand-chosen vintage mics from famed engineer Allen Sides' mic locker.
Featuring only the controls you need, Ravel ensures you'll never get lost in confusing menus. Easily tweak Ravel's
Volume, Tone, and a microphone Close/Room slider, letting you go from intimate tones to a lush room sound, and
everywhere in between.
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More Modern Textures
Looking to add drama, suspense, or other left-of-center timbres? Ravel's Reverse feature lets you easily add unique
atmospheric piano sounds. Use the Mix control to add in subtle reverse textures to your normal piano playing, or go
completely "backwards" for all kinds of fun. You can even “play the control” for surprising real-time
performance changes.

System Requirements
In addition to overall LUNA Recording System requirements, Ravel has the following requirements:
• SSD drive with 10 GB available storage
• SSD drive must be formatted as APFS (Apple File System)
• External SSD must be connected via USB 3.0, USB 3.1, PCIe, or Thunderbolt connection
Note:
• Spinning hard drives and macOS Fusion drives are unsupported
• SSD drives formatted as ExFAT, FAT, and Mac OS Extended are unsupported

Quick Start
We know you might be excited to start playing, so let’s take Ravel for a quick test drive before diving into the details.
After the instrument is loaded:
1. Play the piano to get a feeling for what Ravel can do in your music.
2. The basic user interface view has a single volume level slider. Click the UA icon near the top right, or the chevron
(down arrow head) at the bottom of the Main View to reveal various option sliders. This section is called Controls
view.
3. Here you can fine tune your sound by adjusting any of the sliders. For example, if you would like the piano to
have a brighter (or darker) tone, drag the TONE slider and play a few notes to hear the result. If you would like to
hear more or less of the room microphones, drag the MICS slider. Feel free to keep experimenting with various
sliders.
4. When you are happy with your results, click the UA icon or chevron (up arrow head) again to close the Controls
view and enjoy playing the piano!

The Ravel User Interface
Ravel features an elegant, distraction-free interface so you can keep your focus on the music. The interface has four
views,
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Main View

Main View is what you see when Ravel is launched. It has only one slider:
Volume
This slider sets the output level of the instrument.
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Controls View

Controls View is revealed by clicking the UA logo or the chevron (down arrow head) in Main View. Doing so reveals
additional options beyond the volume control available in Main View. Click the chevron again to close this section and
return to Main View.
Tone
Ravel includes a single-control EQ whose underlying parameters “morph” behind the scenes to alter the overall tonal
character of the master output. It ranges from a “dark” setting (fully left) through a flat setting (middle) to a “bright”
setting (fully right) and can be used to help fit the piano into your mix.
Dynamics
This slider adjusts the response of Ravel to emphasize softer or louder sounds. The default setting at the midpoint
provides an optimized response that should work well for most musicians. Moving the slider to the left increases the
emphasis on softer samples; moving the slider to the right increases the emphasis on louder samples. If you’re not a
pianist, this can effectively make it easier to play consistently softer or louder.
Tip: Adjust this slider to suit your individual preference. Some players prefer a light action that makes it easy to reach
high velocities with minimal effort (set the slider closer to the right). Others prefer heavier action in which higher
velocities require more forceful playing (set the slider closer to the left). There is no “correct” setting; how you set this is
entirely a matter of personal taste.
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Reverse Mix
This slider lets you crossfade between the regular piano samples and the reversed piano samples.
Tip: The reverse sounds are available to play in real time or automate within LUNA. Used sparingly on tracks, they can
add some unique “flavors” with musical phrases. Ravel’s reverse sounds are not tempo synced, but you’ll find that
many tempos work well with the various lengths. When reverse sounds are used, more sample data is being used, and
more CPU resources on your host computer, so if you are not using reverse sounds, it is recommended to keep the
slider fully off.
Reverse Length
This slider sets the length of the reversed piano samples and has 12 separate sample length positions ranging from 300
to 3500 milliseconds.
Note: Changing the Reverse Length slider loads a new set of seed samples into Ravel. While samples are loading, the
“reverse” sounds will be briefly muted.
Mics
This slider crossfades between the “Close” (close mic’d) and “Room” microphones. Dragging this control reveals the
Mics View to help you visualize the blend of microphones. This is described in detail in the “Mics View” section.

Mics View
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When dragging the Mics slider, a new background is revealed to visualize Ravel’s microphone mix balance. As you adjust
the slider, the brightness of lighting over the mic pairs changes to provide a visual reference of the mix balance between
the CLOSE microphones (near the piano) and the ROOM microphones (positioned further away).
Note: When the Mics slider is set to 100% CLOSE or 100% ROOM, the unused microphone channels are switched off and
you may notice a reduction in CPU load as those samples are no longer played. It’s best to keep the ROOM mics fully off
if you’re not using them so that CPU load is minimized.

Settings View

Clicking the Gear icon opens Settings View, where you can adjust six additional settings for Ravel. To exit Settings View,
click anywhere outside the central area.
Note: These parameters are global, meaning that they are not stored within a preset.
Tuning
Sets Ravel’s tuning reference in Hertz. Adjust this parameter by dragging up or down or by double-clicking the field and
entering a number directly. You can also use your computer’s up and down arrow keys to set this value in increments of
0.1 Hz.
Polyphony
Sets Ravel’s total polyphony. This parameter has a meaningful impact on CPU usage; you can choose a lower load
setting if CPU power is constrained. The default MEDIUM setting works well in most cases. If you have a sufficiently
powerful computer or are recording a solo piano project, you may consider setting polyphony to LARGE, which allows
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the most natural pianistic response at the expense of greater CPU usage. If you have an older computer, or you are
running complex sessions, you may need to consider using the ECO setting.
Tip: When performing a non-realtime mixdown of your performance, set Polyphony to LARGE as the computer can
handle the load when it is not playing back in real time. This can give you the best possible pianistic result during a
bounce, and you can set Polyphony back to MEDIUM or ECO after LUNA completes the bounce if CPU resources are
limited.
Silent Note Velocity
On acoustic pianos, pressing a key very softly results in a "silent note" since the hammer does not have enough inertia
to actually strike its associated string. While silent notes do not produce a tone, the mechanical sound of key and
hammer movement can still be heard very softly. The Silent Note Velocity parameter sets MIDI velocity values below
which silent notes occur in Ravel. The Silent Note Velocity range is 0–15. Ravel defaults to a Silent Note Velocity of 10.
Note: This setting applies globally to all instances of Ravel and is not saved individually with each instance of the
instrument.
Release Velocity to Mechanical Sounds
When this box is checked, Ravel’s mechanical release sounds respond to your keyboard’s Release Velocity. Release
Velocity is a MIDI parameter that provides data that represents the speed that a note is released. When this parameter is
mapped to mechanical sounds, if you release a note quickly, it triggers sounds that are more appropriate to the
dynamics and timing of that playing, and the same for slower release velocities and their mechanical sounds.
Mechanical sounds add to Ravel’s realism, so we encourage you to leave this parameter enabled if your controller
supports it. Release Velocity is disabled by default because some controller keyboards do not support it. Enabling this
parameter when the controller doesn’t output Release Velocity might make Ravel’s mechanical sounds seem unnatural.
Tip: Check your MIDI controller’s documentation to see if it can generate release velocity messages. Alternatively, you
can use MIDI monitoring software to see what happens when you release a held note. Controllers that do not support
release velocity messages will typically have a MIDI Note Off message with a value of 0. Keyboards that support release
velocities will have Note Off messages with non-zero values that change depending on how quickly the note is
released.
Note: This setting applies globally to all instances of Ravel and is not saved individually with each instance of the plugin.
Highest Dynamic
When creating Ravel, the source acoustic piano was sampled with an extremely wide dynamic range to ensure that the
original instrument’s entire range was fully and faithfully captured. As a result, the loudest samples at the highest
possible velocity layer are louder and brighter than what is possible in typical chordal playing. On an acoustic piano,
this layer would be the equivalent of a player bracing fingers together and striking one note with as much power as
possible. It makes a powerful sound, but playing at this dynamic would sound very unnatural and overly “hard” if used
throughout a song.
The HIGHEST DYNAMIC feature adjusts Ravel’s loudest-possible layer of samples. The choices for this setting are
included because many lower cost MIDI controllers tend to output maximum velocity MIDI notes easily and this can
sound unmusical with Ravel’s high dynamic range sampling.
We recommend using the default LIMIT option when working with standard spring action MIDI controllers.
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• The LIMIT setting allows access to the highest possible velocities but only when individual notes or parallel
intervals are being played (the system prevents the highest layer being triggered by chords).
• The FULL option allows access to the loudest sample layer just like any other layer. Use the FULL setting with a
weighted MIDI piano controller keyboard that supports wide, realistic response velocity curves.
• The OFF setting switches Ravel’s very highest dynamic levels off entirely. OFF can be the best choice for budget
MIDI controllers; with a less responsive controller, experiment with LIMIT and OFF to find your preference.
Resonance to Reverse Sounds
When switched on, the reverse samples are fed at lower level into Ravel’s Ultra-Resonance model to add some
soundboard and string ambience and reverberation. When switched off, only the regular (forward) piano samples are
processed with Ultra-Resonance.

Advanced Features (MIDI CC and Automation)
Ravel responds to all three standard piano pedals: Sustain (or “Damper”), Soft Pedal (Una Corda), and Sostenuto. The
sustain pedal responds to continuous control if supported by your hardware.
On an acoustic piano, the sustain pedal acts to lift all of the felt “dampers” that keep strings from ringing. When the
pedal is depressed, the dampers are not in contact with the strings, notes sustain naturally, and notes don’t stop
ringing when your finger leaves the key on the note struck. When the pedal is released, the dampers return to the
strings, so strings don’t ring any longer unless keys are held.
Experienced pianists know how to “ride the pedal,” carefully controlling when notes are sustaining and ringing. Careful
control of pedaling can produce what is called “half pedaling” where the dampers begin to touch the piano strings, but
do not entirely cut off notes that are ringing. By using a continuous sustain/damper pedal—an option that many
keyboards support—you can take advantage of Ravel’s sophisticated behavior and sounds for pedaling, and get a
natural pedaling effect, combining the response of Ultra-Resonance and the mechanical sounds of pedaling, which
greatly adds to musicality and realism.
For the most realistic piano experience, you will want to use a continuous sustain pedal. For this, you will need a pedal
that’s capable of sending continuous messages, and a keyboard that is capable of receiving them. Most spring action
(non-weighted or semi-weighted) keyboards don’t recognize continuous messages from the sustain pedal jack. Often
continuous control is only available from an input meant for an expression pedal (similar to a volume pedal or wah).
Here’s what you need to know:
• Most hammer-action keyboard controllers do accept continuous control for at least sustain pedal (CC64). Check
your controller’s manual to be sure.
• If using a spring-action keyboard (or if your hammer-action keyboard does not accept continuous messages via
sustain pedal input)
• You will need to change the input CC to 64 (it is usually set to 11)
• Note: check the back panel or user manual to determine if it has an expression pedal input
• You will need a piano-style continuous pedal (such as the Roland DP10 or Yamaha FC3A)
Ravel will auto-detect whether your pedal is switched or continuous.
While Ravel has a simple user interface, we’ve made sure to include MIDI and LUNA parameter automation control.
Having access to automation and MIDI CC control can make life easier during a live performance (for example, changing
parameters “on the fly” from your MIDI controller without looking at your computer). It can also open up creative sound
design possibilities during a mix.
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Parameter

MIDI CC Number

Volume

N/A

Mics

091

Reverse Mix

70

Tone

74

Sustain

64

Sostenuto

66

Una Corda (soft pedal)

67

All Notes Off

123+

+

Ravel performs an “All Notes Off” (sometimes called “MIDI Panic”) procedure any time it receives a non-zero value on
MIDI CC123. This means you can, for example, map any momentary button on your MIDI Controller to send a “127” MIDI
message on CC123 when pressed, and a “0” message when released. Doing so will convert that button into an All Notes
Off control.
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Spitfire Audio
Spitfire Audio makes inspiring sounds and film scoring tools in collaboration with the world’s best composers,
musicians and engineers. Recorded in stunning spaces including AIR Studios, the home of blockbuster scores, Spitfire
Audio captures and develops the sounds of Hans Zimmer, BBC Symphony Orchestra, Olafur Arnalds and many more,
showcased within beautifully crafted interfaces for maximum detail, control and expression.
There are a number of different LUNA Instruments available from Spitfire Audio. This manual applies to all Spitfire
Audio LUNA instruments.

System Requirements
In addition to overall LUNA Recording System requirements, Spitfire Audio LUNA Instruments have the following
requirements:
• SSD drive with available storage (varies per instrument):
• 16 GB for Spitfire Chamber Strings Collection
• 11 GB for Spitfire Symphonic Brass Collection
• 11 GB Spitfire Symphonic Woodwinds Collection
• SSD drive must be formatted as APFS (Apple File System)
• External SSD must be within USB 3.0, USB 3.1, PCIe, or Thunderbolt enclosure
Note:
• Spinning hard drives and macOS Fusion drives are unsupported
• SSD drives formatted as ExFAT, FAT, and Mac OS Extended are unsupported
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The Interface

1. Top Menu
Patch name:
This shows the name of the loaded instrument.
Master Tune:
This allows you to tune everything (all articulations) ±12 semitones. Cmd+Click resets to default of 0 semitones.
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Master Pan:
This allows you to pan everything (all articulations). Cmd+Click resets to default (centre).
Master Volume:
This adjusts the overall volume of the instrument. Range -inf - +12dB. Cmd+Click resets to default of 0dB.

2. Controllers
Greyed-out controllers:
Depending on the articulation selected, some controllers do not have any effect. When a controller doesn’t have any
effect it becomes greyed out.
Expression:
Instrument trim that adjusts the volume within the dynamics.
Expression is mapped to MIDI CC11.
Dynamics:
Moving this crossfades the different dynamics between loud and soft.
Dynamics is mapped to the modwheel, MIDI CC1.
Vibrato:
Where appropriate this crossfades from no (or senza) to lots (molto) vibrato.
Vibrato is mapped to MIDI CC21.
Attack:
For some articulations this can be used to vary the start of the note. For example, with shorts it can be used to increase
the tightness of the performance; with the Rips articulation it will change the length of the run up to the note.
Attack is mapped to MIDI CC22.
Release:
For some articulations this can be used to vary the end of a note. This is
mainly used on Longs articulations to allow control over the tail: at low release values the note will stop more abruptly
and at high values the note will stop more gradually (useful for creating smooth transitions between notes/chords).
Release is mapped to MIDI CC23.
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3. Technique Selector
Articulation icons:
These icons can be clicked to allow you to change the articulation currently being played by the instrument. When
selected, the icon becomes highlighted.
Purge:
The small “memory” icon below the technique allows you to remove an articulation from memory. This can be useful
when using a lot of instances of an instrument. By default all techniques are preloaded into memory. When the
technique is purged, the technique will not sound if it is purged and the icon becomes grey, as shown below:
Not purged – The articulation is preloaded into memory.

Purged – The articulation is removed from memory and the “memory” icon is greyed out.
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4. Keyboard
This ranges from C0 to E8 and reflects the keys currently being received via MIDI/ pressed by the user.
Key switches:
On the bar above the keyboard the key switches are shown by the left section of white. All keys under this white section
are key switches and can be used to change articulation without clicking the UI. The order of the key switches are
reflected by the order of the articulation icons (from left to right, top to bottom).
Playable range:
The right hand section of white shows the playable range. This will vary depending on the articulation and instrument
selected.

Glossary of Articulations
The following is an explanation of all of the terms used when naming our ‘articulations’ in the library. The available
articulations will be displayed when an instrument is loaded.

Long
The most vanilla of the long notes that we record, a standard sustained note. This is the basic playing style, often
recorded with and without vibrato.

Spiccato
This articulation can vary! For us, our Spiccato aims to capture a very nice ‘tight’ sound, with the bow bouncing off the
string. This creates a sound that can be used either as a nice short staccatissimo, but also as a sequence of fast short
notes or an ostinato.

Staccato
Staccato in notation refers to a ‘shortened and detached’ style of playing. In the case of samples, this usually refers to a
single but defined short note.

Pizzicato
Plucking the strings with the finger.

Short Marcato
Marcato in our samples refers to the longest of our short notes, and has a slightly harder attack whilst maintaining a
round shape to the note start. Think of this as the longest note in a fanfare passage.
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Short Tenuto
The intermediate short length - literally it means ‘hold the note for its full duration or even slightly longer’ and implies
some form of accent. We think of this as a nice rounded attack.

Short Col Legno
Col Legno means ‘with wood’. This style of playing is to turn the bow over and hit the string with the wood of the bow.
Usually players will bring a practice of less expensive bow for this, as their main bows can cost thousands!

Short 0'5
This is a staccato played to the length of approximately half a second.

Long Sul Pont
Short for ‘sul ponticello’, meaning to play on the bridge. Here the players bow very close to the bridge, which produces
a brittle and edgy sound. Always reminds us of nails on a chalkboard!

Long Harmonics
If a player holds down lightly on the string a perfect fourth interval up from the note they are fingering, you hear what is
called an ‘artificial harmonic’ sound - two octaves up from the note being fingered. This is called ‘artificial’ to
distinguish it from the natural harmonic series of the open string. These ‘natural’ harmonics can be heard by moving the
finger up and down the string while lightly bowing. Note that the playable range is different to the Long articulation.

Tremolo
A tremolo is where a player rapidly moves the bow whilst keeping the left hand on the same notes. The effect is a
shimmering one when played soft, and a very aggressive and tense sound when played loud.

Trills
A trill is where a player alternates between two notes. These work great as accented performance embellishments, or
you can play them very softly to create unique and interesting textures.

Rips & Falls
Either a sweep ‘up’ to the target note, or a fall down to the target note. Sometimes there are different speeds for this,
varied with the Attack knob.
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Runs, Disco Falls & FX
A collection of various FX, from slides through to unusual ‘chattering’ and ‘cluster’ sounds, to runs slides and ‘disco
falls’. Have an explore through these patches!

Spitfire Audio Luna Instruments
Spitfire Chamber Strings – LUNA Collection
We handpicked 16 of the finest string players to perform an encyclopaedia of articulations and techniques, expertly
recorded in the world famous Hall at AIR Studios, London. This smaller section gives you more detail and focus than our
Symphonic range, while still capturing the beautiful resonance of the hall. This is our definitive chamber range – a
hugely versatile classic that will enhance your film, TV and game scores and pop records.
Instruments
Your purchase of the Spitfire Chamber Strings LUNA Collection includes the individual LUNA Instruments below:
•
•
•
•
•
•

Chamber Strings - Violins 1
Chamber Strings - Violins 2
Chamber Strings - Violas
Chamber Strings - Celli
Chamber Strings - Basses
Chamber Strings - Ensembles

Articulations
Spitfire Chamber Strings for LUNA includes the following articulations.
Chamber Strings

Violins 1

Violins 2

Violas

Celli

Basses

Ensembles

Long

✔

✔

✔

✔

✔

✔

Long Harmonics

✔

✔

✔

✔

✔

✔

Long Sul Pont

✔

✔

✔

✔

✔

✔

Short Pizzicato

✔

✔

✔

✔

✔

✔

Articulations
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Short Spiccato

✔

✔

✔

✔

✔

✔

Short Staccato

✔

✔

✔

✔

✔

✔

Tremolo

✔

✔

✔

✔

✔

✔

Trill (Major 2nd)

✔

✔

✔

✔

✔

✔

Trill (Minor 2nd)

✔

✔

✔

✔

✔

✔

Runs

✔

✔

✔

✔

✔

NO

Disco Falls

✔

✔

✔

✔

NO

NO

Spitfire Symphonic Brass – LUNA Collection
Half a decade in the making, this encyclopaedic compendium is our definitive collection of orchestral brass. The UK's
finest brass players have been expertly recorded at the world-famous Hall at AIR Studios, London — the same inimitable
acoustic as Symphonic Strings and Symphonic Woodwinds, for that highly sought-after blockbuster sound. Symphonic
Brass LUNA Collection offers you 46 articulations, adding power and punch to your orchestral scores.
Instruments
Your purchase of the Spitfire Symphonic Brass LUNA Collection includes the individual LUNA Instruments below:
•
•
•
•
•
•
•
•

Symphonic Brass - Horn Solo
Symphonic Brass - Horns a2
Symphonic Brass - Tenor Trombone Solo
Symphonic Brass - Tenor Trombones a2
Symphonic Brass - Bass Trombones a2
Symphonic Brass - Trumpet Solo
Symphonic Brass - Trumpets a2
Symphonic Brass - Tuba Solo

Articulations
Spitfire Symphonic Brass for LUNA includes the following articulations.
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Symphoni
c Brass

Horn
Solo

Horns
a2

Tenor
Trombone
Solo

Tenor
Trombones
a2

Bass
Trombones
a2

Trumpet
Solo

Trumpe
ts a2

Tuba
Solo

Long

✔

✔

✔

✔

✔

✔

✔

✔

Short
Marcato

✔

✔

✔

✔

✔

✔

✔

✔

Short
Staccato

✔

✔

✔

✔

✔

✔

✔

✔

Short
Tenuto

✔

✔

✔

✔

✔

✔

✔

✔

Falls

✔

✔

✔

✔

✔

NO

✔

✔

Rips

✔

✔

✔

✔

✔

NO

✔

✔

Spitfire Symphonic Woodwinds – LUNA Collection
Spitfire Audio has taken its decade of experience recording woodwind instruments, expertly sampling the UK's finest
players at one of the most sought-after locations in the world: The Hall at AIR Studios, London. This library offers you a
wide range of instruments and articulations, from guttural depths of the bass clarinet to the gleaming sound of the
piccolo. An essential part of your orchestral palette, the woods are your secret weapon to adding real power to your
scores.
Instruments
Your purchase of the Spitfire Symphonic Woodwinds LUNA Collection includes the individual LUNA Instruments below:
•
•
•
•
•
•
•
•

Symphonic Woodwinds - Piccolo Flute
Symphonic Woodwinds - Flute Solo
Symphonic Woodwinds - Flutes a2
Symphonic Woodwinds - Clarinet Solo
Symphonic Woodwinds - Clarinets a2
Symphonic Woodwinds - Bass Clarinet
Symphonic Woodwinds - Oboes a2
Symphonic Woodwinds - Bassoon a2
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Articulations
Spitfire Symphonic Woodwinds for LUNA includes the following articulations.
Symphoni
c

Piccolo
Flute

Flute
Solo

Flutes
a2

Clarinet
Solo

Clarinets
a2

Bass
Clarinet

Oboes
a2

Bassoons
a2

Long

✔

✔

✔

✔

✔

✔

✔

✔

Short
Staccato

✔

✔

✔

✔

✔

✔

✔

✔

Trill (Major
2nd)

✔

✔

✔

✔

✔

✔

✔

NO

Trill (Minor
2nd)

✔

✔

✔

✔

✔

✔

✔

NO

Short
Tenuto

✔

✔

✔

NO

✔

✔

NO

✔

Short
Marcato

✔

✔

✔

NO

✔

NO

✔

✔

Woodwind
s
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LUNA Extensions
Unlock Analog Sounds and Workflows
Easily shape your mixes with genuine analog summing and tape.

Neve® Summing
Create with precisely emulated analog summing from the famed Neve 80-Series consoles. Far beyond a simple
“summing plug-in,” this optional LUNA Extension will transform a clean, sterile mix to sound as if it was mixed on a
classic Neve desk.

Studer® A800 Tape
Get the rich warmth, punch, and texture of magnetic tape on any audio or instrument track with the optional Studer
A800 Tape Extension. Simply adjust the per-track Saturation control for the desired amount of harmonics and tape
character, and tweak further with master controls like Tape Formula, Tape Speed (IPS), and calibration settings.

Oxide Tape
The Oxide Tape LUNA Extension provides UA’s revolutionary tape emulation technology in a simple package — with all
of the essential tape sound — for free. By harnessing the musical, mixable sound of tape, Oxide Tape LUNA Extension
imparts essential “sounds like a record” clarity, punch, and warmth to input tracks.

ARP MIDI Arpeggiator
LUNA’s feature rich arpeggiator is a powerful tool that can help you discover new and interesting musical note patterns
while composing and performing.
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Neve® Summing
A major ingredient behind thousands of influential, chart-topping records, Neve 80 series consoles are without equal.
These classic analog desks — made famous in the Sound City documentary — deliver three-dimensional nonlinearities
and analog heft that infuses your mixes with vibrancy and color.
Developed in partnership with AMS Neve exclusively for LUNA Recording System, Neve Summing Extension emulates
the entire summing circuit of an iconic Neve 80 series console — including its coveted 1272 bus amplifiers — giving your
LUNA mixes all the color of Neve's most cherished analog desk.

Now You Can:
•
•
•
•

Easily add width, depth, and character to your mixes with the first authentic emulation of Neve analog summing
Sum individual channels or your entire mix through Neve's iconic 1272 line amplifiers
Harness the complex nonlinearities and musical clipping of Neve's classic 80 series console
Use per-bus Headroom, Trim, and Impedance controls for subtle tone sculpting over your entire mix

Genuine Neve Summing for your Mixes
Far beyond a “summing plug-in,” Neve Summing is an Extension built into LUNA's mixer that emulates every
characteristic of both the source and bus channels — including original Neve 80 series’ console fader taper and pan law.
This workflow eliminates the need to manage multiple plug-in windows. Simply use the per-bus Headroom control to
add color and dynamic enhancement, then season even more with the selectable Impedance switch.

Why Neve Summing?
When audio sources flow through the transformers and custom-built op-amps of a classic Neve 80 series desk — in
particular its coveted 1272 line amplifiers — random analog nonlinearities combine to produce harmonic magic. These
summed signals add character, depth, and dimension, for a more cohesive and vibrant mix.

Authentic Down to the Last Detail
For more than two years, UA dissected and studied multiple vintage Neve 80 series consoles and their components —
pouring over original service manuals and gaining crucial insight into its Class A transformer/transistor circuitry. UA's
team of engineers impeccably emulated all of the original hardware's nonlinearities and clipping characteristics,
yielding results that are virtually indistinguishable from the original console.
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Get Neve Summing
You can purchase the optional Neve Summing LUNA Extension from within LUNA’s Manage panel. After purchasing,
there is nothing to download, as the extension is built into the fabric of LUNA.

Using Neve Summing
Neve Summing imparts the sound and headroom characteristics of a Neve console bus channel directly into the LUNA
summing buses. You can add Neve Summing to Bus and Main tracks.
When you change the Neve Summing setting for a bus, the faders for the bus and for all tracks that feed the bus will
change position because of the difference in fader taper between LUNA native summing bus and Main channels and
Neve Summing bus and Main channels.

To add Neve Summing:
• In the Input row of a bus or the Main track, click the Console button, and choose Neve Summing.
• Set the controls for Headroom (HR), Trim, and Impedance.
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To adjust controls on multiple tracks, select multiple tracks, then change the controls on one track. Selection Grouping
(Mixing > Selection Grouping, or Command+G) must be enabled to adjust Neve Summing settings on multiple tracks at
one time.

Neve Summing provides these controls and characteristics:
• Channel characteristics: The fader and panning characteristics of the bus change to accurately emulate the Neve
console bus characteristics.
• Headroom (HR): The headroom setting increases or decreases the amount of headroom in the channel, and the
amount of saturation. The available range is +4 dB to +28 dB, and the lowest setting (fully counter-clockwise) has
the least saturation and the most available headroom. As you turn this up to the top of the range, you can get
saturation and even distortion characteristics. You can rotate the knob or double-click it to choose a value from
the drop menu. The headroom control is gain-compensated, so the volume changes are minimal when changing
the headroom control. The Low impedance setting is louder than unity gain, even with gain compensation.
• Trim: The trim setting allows you to compensate for gain changes introduced by the summing headroom and
impedance controls, and allows you to increase or decrease the overall level of the summing bus. The available
range is -6 dB to +6 dB. You can rotate the knob or double-click it to type a value.
• Impedance: This setting changes the impedance character of the bus or Main channel from low to high
impedance. The default is high impedance. The Low and High bus impedance settings provide different audio
character and gain levels, and one or the other might be more appropriate for your audio material and bus.
Generally, the Low impedance setting is louder than the unprocessed audio.
• In/Out: The In/Out button allows you to toggle Neve summing on and off to audition the audio effects.

Neve Summing Controls
Headroom (HR)
Headroom enables adjustment of the internal operating reference level for Neve Summing so that the signal is not
“pushed” into processing as much. Headroom enables best practice operating level matching, or it can be used
creatively to expand the sonic range of the summing processor.
By fine-tuning Headroom, the nonlinear I/O distortion and compression response characteristics can be tailored
independently of signal input levels. Increasing Headroom (by rotating the control counter-clockwise) allows signals at
the input to be pushed higher before they are processed.
Headroom can be set in 2 dB steps from 4 dB to 28 dB by rotating the HR knob. When the HR knob is in the straight up 12
o’clock noon position (the default position), the HR value is 16 dB.
At higher dB values (clockwise rotation), signals will push into processing more easily. Set the control to a lower value
(counter-clockwise rotation) when less processing and less color is desired.
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Tip: Headroom is increased as the dB value decreases.

Trim
This continuous knob lets you adjust the level at the input of the 1272 line amplifier. The available range is from -6 dB to
+6 dB.

Impedance
Impedance offers different tonal options by switching the input impedance of the 1272 line amplifier. 300 Ohm (LO) and
1200 Ohm (HI) values are available. Click the Impedance switch to toggle the value.

Bypass
Bypass is useful for comparing the processed signal to the original, unprocessed signal. Click the OUT/IN switch to
toggle the bypass state. When bypassed, the VU meter is unlit and native CPU resources are conserved.
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Studer® A800 Tape
The rich analog sound of the world’s most popular
multichannel tape machine.
For more than 30 years, artists and engineers alike have been drawn to the warm analog sound, solid low-end, and
overall presence of the Studer® A800 Multichannel Tape Recorder. The sheer number of albums recorded on this
legendary 2” analog tape machine — including classics from Metallica, Stevie Wonder, Tom Petty, A Tribe Called Quest,
and Jeff Buckley — serve as shining examples of the musicality of analog tape.
Fully authenticated by Studer, and modeled by UA’s world-renowned team of DSP engineers and magnetic recording
expert Jay McKnight, the Studer A800 Multichannel Tape Recorder for UAD hardware, Apollo interfaces, and LUNA
Recording System is the first product of its kind. By faithfully modeling the entire circuit path of the famous A800
machine from Allen Sides' collection at Ocean Way Studios, this is the most accurate representation of multitrack
analog tape recording available.

Now You Can:
•
•
•
•

Track and mix with the complete Studer A800 electronic signal paths, including Input, Sync and Repro paths
Add warmth, presence, cohesion, and low-end punch that only genuine tape can provide
Create complex analog textures with the distinct sounds of multiple tape formulas
Use the Studer A800 LUNA Extension to easily add warmth to your entire mix on a per channel basis

WIth LUNA Recording System, you can use the Studer A800 as a LUNA Extension, and easily get magnetic tape character
on every audio and instrument track. The Studer A800 Multichannel Tape Recorder Extension lets you intuitively tweak
settings across all channels. As you build up your mix, you'll hear the cumulative "cohesive" effect of mixing from
magnetic tape. Far beyond a simple tape plug-in, the Studer LUNA Extension is woven into the fabric of LUNA Recording
System's mixer, giving Apollo interface users an analog inspired workflow with bona fide analog sonics to match.

A Groundbreaking Tape Machine
Introduced in 1978, the Studer A800 was the first microprocessor-controlled tape machine. Years ahead of its time, the
A800 remains a sonic benchmark, and can still be found in studios worldwide. However, with their massive steel frame
and meter bridge, twin half-horsepower motors and cast alloy deck plates, original A800 units tip the scales at a
backbreaking 900 pounds. The Studer A800 Multichannel Tape Recorder poses none of the hardware hassles, yet
retains all the beautiful sonics that make tape a beloved recording medium.

Capturing the Magic of Tape
Just like magnetic tape, you can dial in a clean sound, or just the right amount of harmonic saturation using the Studer
A800's Input and Output controls. The IPS control steps through tape speed choices (7.5, 15, or 30 IPS), each with
distinct frequency shift, head bump and distortion characteristics. The tape Type control lets users choose from four of
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the most popular magnetic tape formulas — each with their own subtle sonic variation. There is also a secondary set of
controls like Noise, EQ, and Bias for an even more jaw-dropping palette of tape textures.
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Studer A800 Tape machine with controls view closed (left) and controls view open
(right)

Studer A800 Tape as it appears on an input track

Get Studer A800 Tape
You can purchase the optional Studer A800 Tape LUNA Extension from within LUNA’s Manage panel. Your purchase of
the Studer A800 Multichannel Tape Recorder includes both the UAD plug-in (Mac/Windows) and the LUNA Extension
(Mac only).
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Using Studer A800 Tape
Studer A800 Tape LUNA Extension can be enabled on any instrument or audio track. Studer A800 Tape LUNA Extension
is applied only during playback on audio tracks. Studer A800 Tape LUNA Extension is applied on Instrument tracks that
are playing back, record-enabled, and input-enabled, with or without ARM enabled.
Studer A800 Tape includes global settings for the tape machine, and per-track settings for saturation. In this way, the
tape machine emulation is similar to a true recording and mixing tape signal path.
LUNA is designed with the capability to use up to four “machines” for tape emulation. You can configure each machine
slot with different global tape characteristics, and apply any one of the four machines to a track or group of tracks in
your session. Overall tape characteristics are determined by each machine. You can then set the saturation individually
for each track to which tape is applied, and other settings for each Studer A800 channel. In this way, you can configure
separate machines within your session, and still set individual “tape channel” characteristics for each track.
For example, a typical scenario could include two machines, with one machine more aggressively driven than the other.
You can assign drums, bass, and guitars to the more aggressively driven machine, and vocals and backgrounds to the
cleaner machine. You can add a third and a fourth machine with even more diverse characteristics. The ability to
configure up to four machines provides wide flexibility in the range of tape sounds you can apply in a session.

Studer A800 Configuration
The Studer A800 LUNA Extension allows you to load presets and adjust manual controls. Settings like bias, tape speed,
and tape type are configured on the tape machine globally for the session, and in addition, each track has its own level
(saturation) control, as well as control over the individual track’s HF Driver and Repro EQ settings. You can use presets
that you save in the UAD Studer A800 plug-in with the Studer A800 LUNA Extension.
To configure a Tape Machine in a tape deck slot:
1. On an audio or Instrument track in Mixer view, or on a Focus track in Timeline view, click the Tape slot. The Tape
browser opens.
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1. Double-click a tape slot (A-D) in which you want to configure the tape machine.
1. From the Machine list, select a tape machine type (Oxide or Studer A800). Studer A800 is only available if you
have the Studer A800 LUNA Extension licensed and installed. The tape machine configuration is displayed in the
browser.
1. Configure the tape machine through presets (Oxide, Studer A800) or configure the tape machine settings (Studer
A800).
Once you have configured a tape machine in a slot, you can assign that tape machine to any number of audio or
Instrument tracks. You can configure a total of four tape machines, each with unique settings, for each LUNA session.
To assign Studer A800 to a track:
1. Click the Tape insert on a track. The Tape Machine selector opens on the left of the screen.
2. Choose the tape machine from the list in the Tape Machine browser. A tape machine Saturation knob appears on
the track, along with a VU meter and a Power button. In the Mixer, with Large View enabled for the tape row,
additional settings for the Studer A800 LUNA Extension appear.
3. Use the Saturation knob to increase or decrease the amount of tape saturation applied to the track.
4. You can configure the HF Driver HF setting, Bias, Repro LF, and Repro HF settings, and enable noise on a pertrack basis, in addition to the overall machine controls.
5. Click the power button to enable or disable tape emulation on the track.
Tip: If you have the UAD Studer A800 Tape plug-in, you can use presets you have created in the plug-in with LUNA tape
tracks, and vice-versa.
To configure the global sound of a Studer A800 tape machine:
1. Click the Tape insert on a track. The Tape Machine selector opens on the left of the screen.
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2. Double-click the A800 tape machine that you want to configure.
3. Choose a Preset to configure the global sound of the Studer A800, or adjust the controls manually. Click Open to
open the additional machine controls.
To adjust a tape control, you can click and drag on the control to rotate it to the desired position, or you can doubleclick the control to choose from a list of values.
To adjust controls on multiple tracks, select multiple tracks, then change the controls on one track. Selection Grouping
(Mixing > Selection Grouping, or Command+G) must be enabled to adjust tape settings on multiple tracks at one time.

Studer A800 Tape Controls
Control

Description

Input

Input acts like a gain control, and adjusts the signal level going to the tape
emulation. The available range is -12 dB to +24 dB. As with magnetic tape, lower
Input levels have a cleaner sound, while higher levels result in more harmonic
saturation and coloration. Higher Input levels also increase the output level from
the plug-in. The Output control can be lowered to compensate, or you can
achieve this result automatically with the Link control.

Output

Output acts like a gain control and adjusts the gain at the output of the plug-in.
The available range is -24 dB to +12 dB. You can turn this down to compensate for
higher Input levels. Click Link to automatically adjust the Input and Output
controls together.

Auto Cal

The Studer A800 has individual parameters for Bias, HF Record EQ, and Sync and
Repro EQ. On the hardware tape machine, these calibration controls are usually
adjusted whenever Tape Type or Tape Speed is changed. When Auto Cal is on in
the plug-in, these controls are automatically adjusted to the calibrated values
whenever the Tape Type or Tape Speed are changed. After you click Auto Cal, or
any parameter that causes auto calibration to occur, you can then adjust any
individual parameters that change. When Auto Cal is off, the calibration
parameters do not change values when Tape Type or Tape Speed are modified.

Link

Link decreases the Input or Output inversely to one another to prevent large
volume changes when adjusting Input or Output gain.

Noise

The Noise button is a global enable/disable control for hum and hiss in the A800
model. The amount of hum and hiss varies depending on the configured tape
type and speed settings.

Studer® A800 Tape – 396

LUNA User Documentation v200731

HF Driver: HF

HF (High Frequency) Driver EQ is provided to make up for common residual high
frequency loss due to Bias optimization and system filtering. It is used to tune HF
content into the incoming signal prior to the tape non-linearity. The control
boosts high frequency content before it hits the virtual tape, and affects tape
saturation characteristics. Note that this filter is prior to the tape record circuit,
while the other EQs are post-tape.

HF Driver: Bias

Bias uses an inaudible oscillator beyond the audible range applied to the audio at
the record head, to allow for adjustment of the record behavior. Ideal bias voltage
settings provide maximum record sensitivity and low distortion. Intentionally
overbiasing is a common technique to achieve “tape compression” on
instruments like drums, giving a warmer, more saturated sound. Underbiasing
can also be used to add distortion and other nonlinear responses, similar to gate
chatter and audio dropouts, or cause audio to drop out entirely. Bias voltage, HF
Record EQ, and fixed Emphasis EQ (CCIR, NAB, AES) work together to provide a
linear response to the recorded signal.

Repro EQ: HF

With the hardware machine, Repro EQ controls enable compensation for any tape
frequency loss or head wear. You can use the HF (High Frequency) Repro EQ filters
to shape the frequency response of the system to be more accurate, or to add or
remove high end.

Repro EQ: LF

With the hardware machine, Repro EQ controls enable compensation for any tape
frequency loss or head wear. You can use the LF (Low Frequency) Repro EQ filters
to shape the frequency response of the system to be more accurate, or to add or
remove low end.

Tape

Selects the active tape stock formulation. Four of the most popular 2” magnetic
tape formulas are modeled in the A800 plug-in: 250, 456, 900, and GP9. Each type
has its own subtle sonic variation, distortion onset, and compression
characteristics.

IPS

The IPS (Inches Per Second) control determines the speed of the tape transport
and the associated “head bump.” Head bump is bass frequency build-up that
occurs with magnetic tape where the dominant frequencies shift according to
transport speed. 15 IPS is considered the favorite for rock and acoustic music due
to its low frequency “head bump” (low frequency rise) and warmer sound, while
30 IPS is the norm for classical and jazz due to its lower noise floor, greater fidelity
and flatter response. 7.5 IPS is also available for even more tape color, with
greater frequency shift.
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Cal

Cal Level automatically sets tape calibration/fluxivity. The Cal Level setting takes
care of the setup one would need to make under equivalent hardware operation,
and sets the reference tape/flux level without disturbing the (unity) gain of the
plug-in. The record, repro, and sync gain trims found on the A800 channel cards
are not present on the plug-in. When Auto Cal is enabled, the record, repro, and
sync gain trims are amalgamated into this single Cal Level gain control.
As tape formulas advanced, their output level increased, thus lowering relative
noise floor. +3, +6 and +9 dB output formulas were available in the 2” format.
Under normal use, the machine would be calibrated to the tape’s output level.
However, users would sometimes under-calibrate to leave more headroom for a
broader sweet spot or to prevent electronics from clipping. With this tape plug-in,
the user can go traditional and calibrate to the recommended levels, or select a
non-corresponding calibration setting with Cal Level. For example, if 456 is the
selected Tape Type and when Cal Level is set at +6 (6 dB higher than the NAB tape
standard), the reference fluxivity level is 355 nW/m (nanoweber per meter) and is
10 dB below the point where THD reaches 3% (referred to as the maximum
operating level). Therefore, with a 1 kHz test tone at -12 dBFS sent to the plug-in,
with Tape Type set to 456, Cal Level set to +6, and Auto Cal enabled, output levels
of the plug-in will match the input level and fluxivity on the tape will be 355 nW/
m.
The manufacturer’s recommended calibration settings for each Tape Type are as
follows:
• 250: +3 Calibration (251 nWb/m)
• 456: +6 Calibration (355 nWb/m)
• 900: +9 Calibration (502 nWb/m)
• GP9: +9 Calibration (502 nWb/m)
Note: The noise floor is affected by the Cal Level when Noise is enabled.
Tip: The UAD Studer A800 default bank offers a variety of preset Tape Type, Tape
Speed, CAL level, and EQ configurations that are commonly used for the
recording of specific genres.
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Oxide Tape
The Oxide Tape LUNA Extension provides UA’s revolutionary tape emulation technology in a simple package — with all
of the essential tape sound — for free. By harnessing the musical, mixable sound of tape, Oxide Tape LUNA Extension
imparts essential “sounds like a record” clarity, punch, and warmth to input tracks.

Groundbreaking Tape Emulation Technology
The Oxide Tape LUNA Extension was designed by the same team behind the industry-leading UAD Ampex ATR-102
Mastering Tape Machine and Studer A800 Multichannel Tape Machine plug-ins. Designed in conjunction with AES
magnetic recording expert Jay McKnight, Oxide gives your tracks and mixes the warmth, presence, and vibe of
professional analog tape.

Easy to Use
Oxide’s intuitive control deliver musical results for beginners and pros alike. By emulating fat tape compression and
colorful circuit behaviors, Oxide gives your LUNA tracks a cohesive glue that only analog tape can.
Oxide provides all of a magnetic tape recorder’s desirable analog sweetness. As with magnetic tape, a clean sound, or
just the right amount of harmonic saturation, with the simple Saturation control. Oxide operates at a tape/fluxivity
calibration level of +6 dB.
The main point to understand about Oxide operation is that the Saturation control adjusts the signal level recorded to
tape, and is therefore a color parameter. As with hardware tape recorders, lower VU levels result in a cleaner, warmer
sound with more headroom, while increasing VU levels results in more tape saturation, compression, and bite.
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Oxide Tape machine
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Oxide Tape as it appears on an input track

Using Oxide Tape
Oxide Tape can be enabled on any instrument or audio track. Oxide Tape is applied only during playback on audio
tracks. Oxide Tape is applied on Instrument tracks that are playing back, record-enabled, and input-enabled, with or
without ARM enabled. Oxide Tape has simple one-knob tape emulation.
Oxide Tape includes a global bypass control for the tape machine that applies for all instances in the LUNA session, and
per-track settings for on/off and saturation. In this way, the tape machine emulation is similar to a true recording and
mixing tape signal path.

To configure Oxide Tape machine in a tape deck slot:
1. On an audio or Instrument track in Mixer view, or on a Focus track in Timeline view, click the Tape slot. The Tape
browser opens.
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1. Double-click a tape slot (A-D) in which you want to configure the tape machine.
1. From the Machine list, select Oxide Tape. Studer A800 is only available if you have the Studer A800 LUNA
Extension licensed and installed.
Once you have configured the Oxide Tape machine in a machines slot, you can assign that tape machine to any number
of audio or Instrument tracks.

To assign Oxide Tape machine to a track:
1. Click the Tape insert on a track. The Tape Machine selector opens on the left of the screen.
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2. Choose the Oxide Tape machine from the list in the Tape Machine browser. A tape machine Saturation knob
appears on the track, along with a VU meter and a Power button.
3. Use the Saturation knob to increase or decrease the amount of tape saturation applied to the track.
4. Click the power button to enable or disable tape emulation on the track.

To configure the global sound of an Oxide tape machine:
1. Click the Tape insert on a track. The Tape Machine selector opens on the left of the screen.
2. Choose an Oxide tape machine from the list.
3. Choose a preset to configure the global sound of the Oxide tape machine in the session.
Tip: If you have the UAD Oxide Tape plug-in, you can use presets you have created in the plug-in with LUNA tape tracks.
To adjust a tape control, you can click and drag on the control to rotate it to the desired position, or you can doubleclick the control to choose from a list of values.
To adjust controls on multiple tracks, select multiple tracks, then change the controls on one track. Selection Grouping
(Mixing > Selection Grouping, or Command+G) must be enabled to adjust tape settings on multiple tracks at one time.
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ARP MIDI Arpeggiator
Welcome
Thanks for checking out ARP. This feature rich arpeggiator is a powerful tool that can help you discover new and
interesting musical note patterns while composing and performing. It can bring excitement and life to your synthesizers
and we hope it will help your musical creativity.

Quick Start
Tip: If a MIDI controller is not available, you can program notes into the LUNA track containing Shape and play the
track, or use LUNA’s onscreen keyboard when MIDI workflow mode is active.
Let’s take ARP for a quick test drive before diving into the details. We can use it with LUNA’s included Shape instrument.
After Shape is loaded and input-enabled (see LUNA application documentation for these details):
1. Click the MIDI FX on the Instrument track that contains Shape.
1. Choose ARP from LUNA’s focus browser.
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1. Hold one or more notes on your MIDI controller and you will hear those notes being played in an arpeggiated
pattern.
Note: ARP always plays notes monophonically (one at a time), even if a chord is played.
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1. Change the ARPEGGIATION TYPE by clicking one of the 12 available options.
1. Adjust the RATE controls (drop menu and radio buttons) to select the time division at which the arpeggiator
advances to the next note in the pattern.
1. Change the GATE TIME parameter to shorten or lengthen each note in the pattern.
1. The SWING parameter injects some metronomic swing into the arpeggiated pattern.
1. Finally, the four RATE PRESETS provide quick access to stored rate settings. You can learn how to set the four
presets in the Arpeggiation Controls section of this guide.
The Quick Start only scratches the surface of what ARP can do. Read on to learn about all its various features and how
they work together.
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ARP Controls

ARP has a simple user interface and all of its controls are located on one screen. The on-screen controls can be
subdivided into three logical groups: Synchronization and Tempo, Arpeggiation, and Keyboard.
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Synchronization and Tempo Controls

Sync
This button synchronizes ARP to the master tempo of your session. The button is illuminated when synchronization is
enabled.

ARP MIDI Arpeggiator – 408

LUNA User Documentation v200731

Note: When this feature is activated, the TEMPO and TAP buttons are deactivated since ARP receives tempo information
from LUNA. When SYNC is disabled, the TEMPO and TAP controls become active and can be used.
Start Grid
When the LUNA transport is running and SYNC is enabled, this drop menu determines when an arpeggiation will start
playing back relative to the master transport of LUNA. For example, setting the start grid to 1/1 causes an arpeggiation
to only begin playback when LUNA’s transport control reaches the beginning of the next bar, even if you play notes
ahead of the start point. Setting this to 1/4 causes an arpeggiation to play back at the start of the next quarter note.
Note: This control is only active when SYNC is enabled and LUNA’s transport is running. If the transport is stopped,
notes trigger the arpeggiator immediately.
Tempo
When SYNC is disabled, the tempo of the arpeggiator is displayed here and it can be modified by dragging the number
up or down or by double clicking it and entering a value directly. When SYNC is enabled, the tempo of the arpeggiator is
locked to the master tempo track of the session and cannot be changed.
Tip: Tempo can be automated for interesting rhythmic effects.
Tap
This button lets you enter a tempo by tapping the button. Note that this button is only active when SYNC is disabled.
When SYNC is enabled, this button does not change ARP’s tempo.
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Arpeggiation Controls

Arpeggiation Type
ARP allows for 12 different methods of arpeggiation:
• UP: Notes are played from the lowest note to the highest note and repeated.
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• DOWN: This setting provides the reverse of the UP option.
• UP DOWN: Notes are played from the lowest note to the highest note and back down to the lowest note before
repeating.
• DOWN UP: This setting provides the reverse of the UP DOWN option.
• UP HOLD DOWN: Notes are played from the lowest note to the highest note and back down to the lowest note
before repeating. The highest and lowest notes are played two times.
• DOWN HOLD UP: This setting provides the reverse of the UP HOLD DOWN option.
• IN OUT: Notes are arpeggiated “inside out” starting with the note nearest to the center of the notes played and
progressing to the outer notes before repeating.
• OUT IN: This setting provides the reverse of the IN OUT option.
• ALT LOW: This setting alternates between the lowest note played and progressively higher notes in the pattern
before repeating.
• ALT HIGH: This setting provides the reverse of the ALT LOW option.
• AS PLAYED: Notes are arpeggiated in the order they were played.
• RANDOM: Notes are arpeggiated in random order.
Gate Time
This knob sets the length of the arpeggiated notes in the sequence, from 1–200%. A 100% setting means that each
arpeggiated note is the length set in the RATE drop menu. For example: Notes at 1/4 rate and 100% gate time play as
original 1/4 notes, but notes at 1/4 rate and 50% gate time play as 1/8 notes (one-half as long).
Note: GATE TIME settings greater than 100% result in an overlap of subsequent notes. This can have interesting (and
sometimes unexpected) results when working with monophonic synthesizers.
Rate
This drop menu determines the rate at which the arpeggiator advances to the next note in a pattern. Note that the
values displayed in this menu will vary depending on whether whole note, dotted or triplet is selected from the Note
Division buttons.
Note Division
These three radio buttons let you choose from whole note, dotted or triplet beat divisions in your arpeggiation pattern.
Swing
This knob sets the amount of metronomic swing, from 0–100%. Swing changes the rhythmic feel of the pattern.
Rate Presets
ARP has four presets that let you quickly change between various RATE settings. The currently selected preset is
highlighted and you can select a different preset by clicking on it. Making any change to the RATE settings (the drop
menu or the radio buttons) automatically save that new value to the currently selected preset.
Note: Rate presets are only for storing the RATE and NOTE parameters.
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Keyboard Controls

Octaves
This drop menu lets you automatically repeat notes or chords in octave bands above what you have played. At the
default setting (1), played notes are arpeggiated exactly as played. At higher values (2-5), your played notes are
repeated 1 to 4 octaves above where you have played before the pattern repeats.
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Note: Certain instruments (such as Minimoog) have limited note ranges by design. With these instruments, selecting
high or low octave ranges may result in occasional silences as ARP plays the extended notes. These silences are normal
and expected. They can be eliminated by reducing the Octave value.
Latch
When latching is engaged, the arpeggiator continues to run when keys are released. The exact behavior of the latching
is set by the LATCH MODE menu.
Latch Mode
This drop menu determines the behavior of the latching function.
• RESET: Notes are latched and continue repeating until latching is disabled or different notes are played.
• TRANSPOSE: Notes are latched and continue repeating until latching is disabled or different notes played. If
notes are being arpeggiated, playing a single note will cause the pattern to be transposed and the lowest note of
the arpeggiated pattern becomes the note played.
• NOTE ADD: Notes are latched and continue repeating until latching is disabled. While the arpeggiator is running,
playing more notes will add those new notes to the arpeggiated pattern.
• LIVE ADD: Notes are latched and continue repeating until latching is disabled. While the arpeggiator is running,
playing more notes will temporarily add those new notes to the arpeggiation pattern as long as those notes are
held. Releasing the held notes will cause the arpeggiator to revert back to its original pattern.
• THRU: Notes are latched and continue repeating until latching is disabled. While an arpeggiated pattern is
playing back, any new notes played are not arpeggiated, letting you play along with the arpeggiated pattern.
Key Range
This parameter sets the key range in which ARP is active. Notes that fall inside the low and high limits are arpeggiated
whereas notes that fall outside of this range bypass the arpeggiator and playback as normal (non-arpeggiated) notes.
You can adjust the ranges by dragging the vertical handles or double-clicking the low and high note values and entering
new values directly. Held notes are shown in the display area for visual reference.
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